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Course Objectives:
This course will enable the students to learn the fundamental concepts of text, image, video and
audio concepts and analyze the scripting concepts in object oriented programming frameworks and
apply the compression techniques.

MODULE I: Fundamental concepts in Text and Image [09 Periods]
Multimedia and hypermedia, World Wide Web, overview of multimedia software tools. Graphics
and image data representation graphics/image data types, file formats, Color in image and video:
color science, color models in images, color models in video.

MODULE II: Fundamental concepts in Video and Digital audio [09 Periods]
Types of video signals, analog video, digital video, digitization of sound, MIDI, quantization and
transmission of audio.

MODULE III: Action Script I and II [09 Periods]
A: Action Script I
Action Script Features, Object-Oriented Action Script, Data types and Type Checking, Classes,
Authoring an Action Script Class.
B: Action Script II
Inheritance, Authoring an Action Script 2.0 Subclass, Interfaces, Packages, Exceptions.

MODULE IV: Application Development and Multimedia data compression      [10 Periods]
Application Development- An OOP Application Frame work, Using Components with Action
Script, Movie Clip Sub classes.
Multimedia data compression- Lossless compression algorithm: Run-Length Coding, Variable
Length Coding, Dictionary Based Coding, Arithmetic Coding, Lossless Image Compression, Lossy
compression algorithm: Quantization, Transform Coding, Wavelet-Based Coding, Embedded
Zerotree of Wavelet Coefficients Set Partitioning in Hierarchical Trees (SPIHT).

MODULE V: Video Compression Techniques and Multimedia Networks [11 Periods]
Basic Video Compression Techniques- Introduction to video compression, video compression
based on motion compensation, search for motion vectors, MPEG, Basic Audio Compression
Techniques.
Multimedia Networks- Basics of Multimedia Networks, Multimedia Network Communications and
Applications: Quality of Multimedia Data Transmission, Multimedia over IP, Multimedia over ATM
Networks, Transport of MPEG-4, Media-on-Demand(MOD).
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Course Outcomes:
At the end of the course, students will be able to
1. Develop Fundamental concepts in Text and Image
2. Analyze the Fundamental concepts in video and digital audio
3. Apply the scripting concepts in multimedia environments.
4. Understand the Application Development and Multimedia data compression
5. Outline Video Compression Techniques and Multimedia Networks



UNIT IUNIT I
Introduction to Multimedia

 



What is Multimedia?
• When different people mention the term multimedia, they oftenWhen different people mention the term multimedia, they often 

have quite different, or even opposing, viewpoints.

• A PC vendor: a PC that has sound capability, a DVD‐ROM drive, and 
h th i it f lti di bl d iperhaps the superiority of multimedia‐enabled microprocessors 

that understand additional multimedia instructions.

• A consumer entertainment vendor: interactive cable TV with 
hundreds of digital channels available, or a cable TV‐like service 
delivered over a high‐speed connection high Internet connection.

• A Computer Science (CS) student: applications that use multiple• A Computer Science (CS) student: applications that use multiple 
modalities, including text, images, drawings (graphics), animation, 
video sound including speech and interactivity video, speech, 
i i iinteractivity.

• Multimedia and Computer Science: Graphics HCI visualizationMultimedia and Computer Science: Graphics, HCI, visualization, 
computer vision, data compression, graph theory, networking, 
database systems. 2



Components of Multimedia
• Multimedia involves multiple modalities of text• Multimedia involves multiple modalities of text,  
audio, images, drawings, animation, and video.

• Examples of how these modalities are put to use:Examples of how these modalities are put to use:

• Video teleconferencing.

• Distributed lectures for higher education• Distributed lectures for higher education.

• Tele‐medicine.

• Co operative work environments• Co‐operative work environments.

• Searching in (very) large video and image databases for 
target visual objectstarget visual objects.

• "Augmented"reality:  placing real‐appearing computer 
video scenes graphics and objects into scenesvideo scenes graphics and objects into scenes.
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• Including audio cues for where video‐conference 
ti i t l t dparticipants are located.

• Building searchable features into new video, and 
enabling er high to er lo bit rate ne se of neenabling very high‐to very low‐bit‐rate new use of new, 
scalable multimedia products.

• Making components editable multimedia editable• Making components editable multimedia editable.

• Building "inverse‐Hollywood” applications that can 
recreate the process by which a video was maderecreate the process by which a video was made. 

• Video understanding has also been called an inverse 
Hollywood problemHollywood problem.

• Using voice‐recognition to build an interactive 
environment, say a kitchen‐wall web browser.environment, say a kitchen wall web browser.

4



Multimedia Research Topics & Projects 
h h l d f• To the computer science researcher, multimedia consists of 

a wide variety of topics:
• Multimedia processing and coding: multimedia content 

analysis, content‐based multimedia retrieval, multimedia 
security, audio/image/video processing, compression, etc.

• Multimedia system support and networking: network 
protocols, Internet, operating systems, servers and clients, 
quality of service (QoS), and databases.

• Multimedia tools end‐systems applications:  Hypermedia 
systems, user interfaces, authoring systems.

• Multi‐modal interaction and integration: "ubiquity"—
web‐everywhere devices, multimedia education including y g
Computer Supported Collaborative Learning, and design 
and applications of virtual environments.
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Current Multimedia Projects
h l• Many exciting research projects are currently 

underway. Here area few of them:
1. Camera‐based object tracking technology: tracking ofj g gy g
the control objects provides user control of the process.
2. 3D motion capture: used for multiple actor capture so 
that m ltiple a tors in a irt al st dio an be sed realthat multiple actors in a virtual studio can be used real 
to automatically produce realistic animated models 
with natural movement.

3. Multiple views: allowing photo‐realistic (video‐quality) 
synthesis of virtual actors from several cameras or from 
a single camera under differing lighting.

4. 3D capture technology: allow synthesis of highly 
realistic speech facial animation from speech.
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5. Specific multimedia applications: aimed at 
handicapped persons with low vision capabilityhandicapped persons with low vision capability 
and the elderly —a rich field of endeavor.

6. Digital fashion: aims to develop smart clothing 
th t i t ith th h h dthat can communicate with other such enhanced 
clothing using wireless communication, so as to 
artificially enhance human interaction in a social y
setting.

7 Electronic Housecall system: an initiative for 
idi i t ti h lth it i iproviding interactive health monitoring services 

to patients in their homes
8. Augmented Interaction applications: used to8. Augmented Interaction applications: used to 
develop interfaces between real and virtual 
humans for tasks such as augmented storytelling .

7



Multimedia and Hypermedia
Hi t f M lti di• History of Multimedia:

1. Newspaper: perhaps the first mass communication 
medium uses text graphics and imagesmedium, uses text, graphics, and images.

2. Motion pictures: conceived of in 1830's in order to 
observe motion too rapid for perception by theobserve motion too rapid for perception by the 
human eye.

3. Wireless radio transmission: Guglielmo Marconi, at3. Wireless radio transmission: Guglielmo Marconi, at 
Pontecchio, Italy, in 1895.

4. Television: the new medium for the 20th century, y,
established video as a commonly available medium 
and has since changed the world of mass 

i ticommunications .
8



5. The connection between computers and ideas about 
multimedia covers what is actually only a short period:

1945 – Vannevar Bush wrote a landmark article describing 
what amounts to a hypermedia system called Memex.

1960 Ted Nelson coined the term hypertext1960 – Ted Nelson coined the term hypertext.
1967 – Nicholas Negroponte formed the Architecture 
Machine Group. p

1968 – Douglas Engelbart demonstrated the On‐Line System 
(NLS), another very early hypertext program.

1969 – Nelson hypertext and van Dam at Brown University 
created an early editor called FRESS.

1976 The MIT Architecture Machine Group proposed a1976 – The MIT Architecture Machine Group proposed a 
project entitled Multiple Media — resulted in the Aspen 
Movie Map, hypermedia videodisk, in 1978.
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1985 – Negroponte and Wiesner co‐founded the MIT Media Lab.
1989 – Tim Berners‐Lee proposed the World Wide Web
1990 K i ti H W l h d d th A l M lti di1990 – Kristina Hooper Woolsey headed the Apple Multimedia 

Lab.
1991 MPEG 1– MPEG [M(oving) P(ictures) E(xperts) G(roup)]was 

d i i l d d f di i l id l dapproved as an international standard for digital video — led 
to the newer standards, MPEG‐2, MPEG‐4, and further MPEGs 
in the 1990s.

1991 h i d i f i 1991 b i d i1991 – The introduction of PDAs in 1991 began a new period in 
the use of computers in multimedia.

1992 – JPEG was accepted as the international standard for  
d l l d hdigital image compression — led to the new JPEG2000 
standard.

1992 – The first MBone audio multicast on the Net was made.
1993 The of Illinois National Center for Supercomputing–

University Applications produced NCSA Mosaic — the first  
full‐fledged browser.

10



• 1994 – Jim Clark and Marc Andreessen created the 
Netscape program .Netscape program .

• 1995 – The JAVA language was created for platform 
independent application development.

• 1996 – DVD video was introduced; high quality 
full‐length movies were distributed on a single disk.

• 1998 XML 1 0 as anno nced as a W3C• 1998 – XML 1.0 was announced as a W3C 
Recommendation.

• 1998 – Hand‐held MP3 devices first made inroads into1998  Hand held MP3 devices first made inroads into 
consumerist tastes in the fall of 1998, with the 
introduction holding of flash of devices 32MB memory.
2000 i i d billi• 2000 – WWW size was estimated at over 1 billion 
pages.
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Hypermedia and Multimedia
• A hypertext system meant to be read nonlinearly by• A hypertext system: meant to be read nonlinearly, by 
following links that point to other parts of the 
document, or to other documents.document, or to other documents.

• HyperMedia: not constrained to be text‐based, can 
include other media, e.g., graphics, images, and , g , g p , g ,
especially the continuous media sound and video.
– The World Wide Web (WWW) — the best example of a 
hypermedia application.

• Multimedia means that computer information can be 
t d th h di hi i direpresented through audio graphics images audio, 

graphics, images,

• ideo and animation in addition to traditional media• video, and animation in addition to traditional media.
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Examples of typical present multimedia applications 
include:

• Digital video editing and production systems.

• Electronic newspapers/magazines.p p g

• World Wide Web.

• On‐line reference works: e.g. encyclopedias, games.g y p , g

• Home shopping.

• Interactive TV.Interactive TV.

• Multimedia courseware.

• Video conferencing• Video conferencing.

• Video‐on‐demand.

• Interactive movies• Interactive movies.

14



World Wide Web

• The W3C has listed the following goals for the 
WWWWWW 

1. Universal access of web resources (by 
e er one e er here)everyone everywhere).

2. Effectiveness of navigating available 
information.

3. Responsible use of posted material.

15



HTTP ( HyperText Transfer Protocol)
• HTTP: a protocol that was originally designed for 
transmitting hypermedia but can also support 
t i i f fil ttransmission of any file type.

• HTTP a stateless request/response protocol: is no 
information carried over for the next requestinformation carried over for the next request.

• The basic request format:

M th d URI V iMethod URI Version

Additional‐Headers:

b dMessage‐body

• The URI (Uniform Resource Identifier): an identifier for 
th d th h t lthe resource accessed, e.g. the host name, always 
preceded by the token http://.

16



• Two popular methods: GET and POST.

• The basic response format:

– Version Status‐Code Status‐Phrase

– Additional‐Headers

• Additional Message body• Additional – Message‐body

• Two commonly seen status codes:

• 200 OK — the request was processed 
successfully.

• 404 Not Found — the URI does not exist.

17



HTML ( HyperText Markup Language)
• HTML: a language for publishing Hypermedia on the 
World Wide Web — defined using SGML:

1. HTML uses ASCII, it is portable to all different 
(possibly binary incompatible) computer hardware.

h f2. The current version of HTML is version 4.01.

3. The next generation of HTML is XHTML —a 
f l ti f HTML i XMLreformulation of HTML using XML.

• HTML uses tags to describe document elements:
t k d fi i t ti i t<token params> —defining a starting point,

</token> — the ending point of the element.

Some elements have no ending tagsSome elements have no ending tags.

18
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XML ( Extensible Markup Language)
k l f h h h h• XML: a markup language for the WWW in which there 

is modularity of data, structure and view so that user 
or application can be able to define the tagsor application can be able to define the tags 
(structure).

• Example of using XML to retrieve stock informationExample of using XML to retrieve stock  information 
from a database a query according to user 

1. First use a global Document Type Definition (DTD)1. First use a global Document Type Definition (DTD) 
that is already defined.

2. The server side script will abide by the DTD rules to p y
generate document an XML according to the query 
using data from your database.

3. Finally send user the XML Style Sheet ( XSL) depending 
on the type of device used to display the information. 20



• The current XML version is XML 1.0, approved 
by the W3C in Feb 1998by the W3C in Feb. 1998.

• XML syntax looks like HTML syntax, although it 
is much more strict:is much more strict:

–All tags are in lower case and a tag has only 
l d h lfinline data has to terminate itself, i.e., 

<token params />.

–Uses name spaces so that multiple DTDs 
declaring different elements but with 
similar tag names can have their elements 
distinguished.

–DTDs can be imported from URIs as well.
21
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• The following XML related specifications are also 
standardized:standardized:

– XML Protocol: used to exchange XML information 
between processes .between processes .

– XML Schema: a more structured and powerful 
language defining XML data types (tags).g g g yp ( g )

– XSL: basically CSS for XML.

– SMIL : synchronized Integration MultimediaSMIL : synchronized Integration Multimedia 
Language, pronounced "smile"— a particular 
application of XML (globally predefined DTD) that 
allows for specification of interaction among any 
media types and user input, in a temporally scripted 
manner.

23



SMIL (Synchronized Multimedia Integration Language)

• Purpose of SMIL: it is also desirable to be able• Purpose of SMIL: it is also desirable to be able 
to publish presentations using multimedia a 
markup languagemarkup language.

• A multimedia language needs to scheduling 
and s nchroni ation of different m ltimediaand synchronization of different multimedia 
elements, and define their interactivity with 
the userthe user.

• The W3C established a Working Group in 
1997 to come up with specifications for a 
multimedia synchronization language

• SMIL 2 0 was accepted August 2001 2.0 in 
2001. 24



• SMIL 2.0 is specified in XML using a  
modularization approach similar to the one usedmodularization approach similar to the one used 
in xhtml:

1 All S IL l di id d i d l1. All SMIL elements are divided into modules —
sets of elements, attributes and values that 
d fi l f i lidefine one conceptual functionality.

2. In the interest of modularization, not all 
available modules need to be included for all 
applications.

3. Language Profiles: specifies a particular 
grouping of modules, and particular modules g p g , p
may have integration profile must requirements 
that a follow. 25
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Overview of Multimedia Software Tools
1 Music Sequencing and Notation1. Music Sequencing and Notation

• Cakewalk: now called Pro Audio.

The term sequencer comes from older devices that storedThe term sequencer comes from older devices that stored 
sequences of notes ("events", in MIDI).

It is also possible to insert WAV files and Windows MCI p
commands (for animation and video) into music tracks 
(MCI is a ubiquitous component of the Windows API.)

• Cubase: another sequencing/editing program, with 
capabilities similar to those of Cakewalk. It includes some 
tools digital audio editing toolstools digital audio editing tools.

• Macromedia Soundedit: mature program for creating 
audio for multimedia projects and the web that integrates p j g
well with other Macromedia products such as Flash and 
Director. 27



2. Digital Audio
• Cool Edit: a very powerful and popular digital 
audio toolkit; emulates a professional audio 
studio —multitrack productions and sound file 
editing including digital signal processing effects.

• Sound Forge: a sophisticated PC‐based program 
for WAV audio files.

• Pro Tools: a high‐end integrated audio 
production and editing environment MIDIproduction and editing environment MIDI 
creation and manipulation; powerful audio 
mixing recording and editing softwaremixing, recording,and editing software.

28



3.Graphics and Image Editing
• Adobe Illustrator: a powerful publishing tool from• Adobe Illustrator: a powerful publishing tool from 
Adobe. Uses vector graphics; can be exported to Web 
graphics Web.g p

• Adobe Photoshop: the standard in a graphics, image 
processing and manipulation tool. 
– Allows layers of images, graphics, and text that can be 
separately manipulated for maximum flexibility.

il f i i f hi i d li h i ff– Filter factory permits creation of sophisticated lighting‐effects 
filters.

• Macromedia Fireworks: software for making graphics• Macromedia Fireworks: software for making graphics 
specifically for the web.

• Macromedia Freehand: a text and web graphics editingMacromedia Freehand: a text and web graphics editing 
tool that supports many bitmap formats such as GIF, 
PNG, and JPEG. 29



4.Video Editing
• Adobe Premiere: an intuitive, simple video editing toolAdobe Premiere: an intuitive, simple video editing tool 
editing i e clips for nonlinear editing, i.e., putting video 
into any order:
Video and audio are arranged in "tracks" tracks .

Provides a large number of video and audio tracks,

superimpositions and virtual clips. => effective 

multimedia productions with little effort.

Ad b Aft Eff t f l id diti t l• Adobe After Effects: a powerful video editing tool 
that enables users to add and change existing movies. 
Can add many effects: lighting shadows motionCan add many effects: lighting, shadows, motion 
blurring; layers.

• Final Cut Pro: a video editing tool by Apple;Final Cut Pro: a video editing tool by Apple; 
Macintosh only.

30
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5. Animation
Multimedia APIs:Multimedia APIs:

• Java3D: API used by Java to construct and render 3D 
graphics similar to the way in which the Java Mediagraphics, similar to the way in which the Java Media 
Framework is used for handling media files.

1 Provides a basic set of object primitives (cube, splines,1 Provides a basic set of object primitives (cube, splines, 
etc.) for building scenes.

2. It is an abstraction layer built on top of OpenGL or y p p
DirectX (the user can select which).

• DirectX : Windows API that supports video, images, 
audio and 3‐D animation

• OpenGL: the highly portable most popular 3 D API

31
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Rendering Tools:

• 3D Studio Max: rendering tool that includes a number3D Studio Max: rendering tool that includes a number 
of very high‐end professional tools for character 
animation, game development, and visual effects g p
production. 

• Softimage XSI: a powerful modeling, animation, and 
rendering package used for animation and special 
effects in films and games.

• Maya: competing product to Softimage; as well, it is a 
complete modeling package.

• RenderMan: rendering package created by Pixar.

• GIF Animation Packages: a simpler approach to 
i ti ll i k d l t f ff tianimation, allows very quick development of effective 

small animations for the web. 32
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6.Multimedia Authoring
d l h ll• Macromedia Flash: allows users to create interactive 

movies using the score metaphor i.e. a timeline 
arranged in parallel event sequencesarranged in parallel event sequences.

• Macromedia Director: uses a movie metaphor to create 
interactive presentations — very powerful and includesinteractive presentations  very powerful and includes 
a built‐in scripting language, Lingo, that allows creation 
of complex interactive movies.p

• Authorware: a mature, well‐supported authoring 
product based on the Iconic/Flow‐control metaphor.

• Quest: similar to Authorware in many ways, uses a type 
of flowcharting metaphor. However, flowchart nodes 
can encapsulate information in a more abstract way 
(called frames) than simply subroutine levels. 33
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Graphics and Image Data Representations
Graphics/Image Data TypesGraphics/Image Data Types

• The number of file formats used in multimedia 
i idlcontinues to rapidly.

34
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1‐bit Images
• Pixels, or pels: picture elements 

• Each pixel is stored as a single bit (0 or 1), so p g ( ),
also referred to as binary image.

• Such an image is also called a 1‐bitSuch an image is also called a 1 bit 
monochrome image since it contains no color.

35
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8‐bit Gray‐level Images
h l h l b d• Each pixel has a gray‐value between 0 and 255.

• Each pixel is represented by a single byte; e.g., a dark 
i l i ht h l f 10 d b i ht i ht bpixel might have a value of 10 and bright one might be 

230.

• Bitmap: The two dimensional array of pixel values that• Bitmap: The two‐dimensional array of pixel values that 
represents the graphics/image  data.

• Image resolution refers to the number of pixels in a• Image resolution refers to the number of pixels in a 
digital image (higher resolution always yields better 
quality).q y)

• Fairly high resolution for such an image might be 1, 
600 × 1, 200, whereas lower resolution might be 640 ×, , g
480.
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• Frame buffer: Hardware used to store bitmap.

Video card (actually a graphics card) is used for– Video card (actually a graphics card) is used for 
this purpose.

• The resolution of the video card does not have to• The resolution of the video card does not have to 
match the desired resolution of the image, but if 
not enough video card memory is available then thenot enough video card memory is available then the 
data has to be shifted around in RAM for display.

• 8 bit image can be thought of as a set of 1 bit• 8‐bit image can be thought of as a set of 1‐bit 
bitplanes, where each plane consists of a 1‐bit 
representation of the image at higher and higherrepresentation of the image at higher and higher 
levels of "elevation": a bit is turned on if the image 
pixel has a nonzero value that is at or above that bit p
level.

37

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



38

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



• Each pixel is usually stored as a byte (a value 
b 0 255) 640 480 lbetween 0 to 255), so a 640 × 480 grayscale 
image requires 300 kB of storage (640 × 480 = 
307 200)307, 200).

• If we want to print such image, things become 
more complex.

• When an image is printed, the basic strategy g p gy
of dithering is used, which trades intensity 
resolution for spatial resolution to provide p p
ability to print multi‐level images on 2‐level ( 
1‐bit) printers.
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Dithering
F ll l h t h t i l t• Full‐color photographs may contain an almost 
infinite range of color values. Dithering is the 

t f d i th lmost common means of reducing the color 
range of images down to the 256 (or fewer) 
l i 8 bit GIF icolors seen in 8‐bit GIF images.

• For printing, Dithering is used to calculate larger 
patterns of dots such that values from 0 to 255 
correspond to pleasing patterns that correctly 
represent darker and brighter pixel values.
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• The main strategy is to replace a pixel value by 
a larger pattern say 2 × 2 or 4 × 4 such that thea larger pattern say 2 × 2 or 4 × 4 such that the  
number of printed dots approximates the 
varying sized disks of ink used in analog invarying sized disks of ink used in analog, in 
halftone sized printing (e.g., for newspaper 
photos)photos).

• Half‐tone printing is an analog process that uses 
ll l fill d i l f bl k i ksmaller or larger filled circles of black ink to 

represent shading, for newspaper printing.
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Fig. (a) shows a grayscale image of "Lena". 
The ordered-dither version is shown as Fig. (b),The ordered dither version is shown as Fig. (b), 
with a detail of Lena’s right eye in Fig. (c).

43

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Image Data Types
• The most common data types for graphics and 
image file formats — 24‐bit color and 8‐bit 
color.

• Most image formats incorporate some g p
variation of a compression technique due to 
the large storage size of image files. g g g

• Compression techniques can be classified into 
either lossless or lossyeither lossless or lossy.
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24‐bit Color Images
• In a color 24‐bit image each pixel is represented by• In a color 24‐bit image, each pixel is represented by 
three bytes, usually representing RGB.

• This format supports 256 × 256 × 256 possibleThis format supports 256 × 256 × 256 possible 
combined colors, or a total of 16,777,216 possible 
colors.

• However such flexibility does result in a storage 
penalty: A 640 × 480 24‐bit color image would require 
921.6 kB of storage without any compression. 

• An important point: many 24‐bit color images are 
actually stored as 32‐bit images, with the extra byte of 
data for each pixel used to store an alpha value 
representing special effect information (e grepresenting special effect information (e.g., 
transparency).
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8‐bit Color Images
• Many systems can make use of 8 bits of color 
information (the so‐called "256 colors") in 
producing a screen image.

• Such image files use the concept of a lookup 
table to store color information.

• Basically, the image stores not color, but y, g ,
instead just a set of bytes, each of which is 
actually an index into a table with 3‐byte y y
values that specify the color for a pixel with 
that lookup table index.p
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• An image histogram is a type of histogram 
which acts as a graphical representation of thewhich acts as a graphical representation of the 
tonal distribution in a digital image. It plots 
the number of pixels for each tonal valuethe number of pixels for each tonal value.
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Color Look Look‐up Table (LUT)p ( )

Also called as Palette

50
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How to Devise a Color Lookup Table
• The most straightforward way to make 8 bit look up color out• The most straightforward way to make 8‐bit look‐up color out 

of 24‐bit color would be to divide the RGB cube into equal slices 
in each dimension.

• The centers of each of the resulting cubes would serve as the 
entries in the color LUT, while simply scaling the RGB ranges 
0 255 into the appropriate ranges would generate the 8‐bit0..255 into the appropriate ranges would generate the 8 bit 
codes.

• Since humans are more sensitive to R and G than to B, we 
could shrink the R range and G range 0..255 into the 3 bit range 
0..7 and shrink the B range down to the 2‐bit range 0..3, thus 
making up a total of 8 bits.making up a total of 8 bits.

• To shrink R and G, we could simply divide the R or G value by 
(256/8)=32 and then truncate. Then each pixel in the image gets 

l d b i 8 bi i d d h l LUTreplaced by its 8‐bit index and the color LUT serves to generate 
24‐bit color.

53
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Median ‐cut algorithm for Color
Reduction Problem

• A simple alternate solution that does a better job for this 
color reduction problem.

) Th id i t t th R b t l d fi d th i dia) The idea is to sort the R byte values and find their median; 
then values smaller than the median are labeled with a "0" 
bit and values larger than the median are labeled with a "1" g
bit.

b) This type of scheme will indeed concentrate bits where they 
most need to differentiate between high populations of 
close colors.

) O t il i li fi di th di b ic) One can most easily visualize finding the median by using a 
histogram showing counts at position 0..255.

d) Fig shows a histogram of the R byte values for thed) Fig. shows a histogram of the R byte values for the 
forestfire.bmp image along with the median of these values, 
shown as a vertical line. 54
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Median‐Cut Algorithm
1. Find the smallest box that contains all the colors in the 

image.

2 Sort the enclosed colors along the longest dimension of the2. Sort the enclosed colors along the longest dimension of the 
box.

3. Split the box into two regions at the median of the sorted list.p g

4. Repeat that the above process in steps ( 2) and ( 3) until the 
original color space has been divided into, say, 256 regions.

5 For every box call the mean of R G and B in that box the 
representative (the center) color for the box.

6 B d th E lid di t b t i l RGB l6. Based on the Euclidean distance between a pixel RGB value 
and the box centers, assign every pixel to one of the 
representative colors. Replace the pixel by the code in a p p p y
lookup table that indexes representative colors.
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Popular File Formats 3

• GIF (Graphics Interchange Format)

JPEG (J i t Ph t hi E t G )• JPEG (Joint Photographic Experts Group)

• PNG (Portable Network Graphics)p

• TIFF(Tagged Image File Format)

EXIF (E h I Fil )• EXIF (Exchange Image File)

57
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GIF (Graphics Interchange Format)
• GIF standard uses Lempel‐Ziv‐Welch algorithm• GIF standard uses Lempel‐Ziv‐Welch algorithm.

• Limited to 8‐bit ( 256) color images only, which, while 
producing acceptable color images is best suited forproducing acceptable color images, is best suited for 
images with few distinctive colors (e.g., graphics or 
Drawing).

• GIF standard supports interlacing — successive display 
of pixels in widely‐spaced rows by a 4‐pass display 
process.

• GIF images are of two types
– GIF87a: The original specification .

– GIF89a: The later version. Supports simple animation via 
hi l i bl k i h d ida Graphics Control Extension block in the data, provides 

simple control over delay time a transparency index etc.
58
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GIF87

GIF File Format

59
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GIF 
ScreenScreen 
Descriptor
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GIF Color Map
61
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GIF Image Descriptor
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JPEG (Joint Photographic Expert Group)
• The most important current standard for 
image compression.

• The human vision system has some specific 
limitations and JPEG takes advantage of these 
to achieve high rates of compression.

• The eye‐brain system cannot see extremely y y y
fine detail.

• JPEG allows the user to set a desired level ofJPEG allows the user to set a desired level of 
quality, or compression ratio (input divided by 
output)output).
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JPEG image withJPEG image with 
low quality 
specified by user.

A l Fi h f tfi i ith• As an example, Fig. shows forestfire image, with a 
quality factor Q=10%.

• This image is a mere 1 5% of the original size In• This image is a mere 1.5% of the original size. In 
comparison, a JPEG image with Q=75% yields an image 
size 5.6% of the original, whereas a GIF version of thissize 5.6% of the original, whereas a GIF version of this 
image compresses down to 23.0% of uncompressed 
image size. 64
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PNG (Portable Network  Graphics)
• PNG meant to supersede the GIF standard and extends it• PNG meant to supersede the GIF standard, and extends it 
in important ways.

• Special features of PNG files include support for 48 bits ofSpecial features of PNG files include support for 48 bits of 
color information.

• Files may contain gamma‐correction information forFiles may contain gamma correction information for 
correct display images alpha channel of color images, as 
well as alpha‐information for such uses as control of 
transparency.

• The display progressively displays pixels in a 2‐
dimensional fashion by showing a few pixels at a time 
over seven passes through each 8 × 8 block of an image.
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TIFF(Tagged Image File Format)
h l f l f d l d b• TIFF is another popular image file format, developed by 

the Aldus Corporation in the 1980’s and was later 
supported by Microsoftsupported by Microsoft .

• Its support for attachment of additional information 
(referred to as "tags") provides a great deal of flexibility(referred to as  tags ) provides a great deal of flexibility.

• The most important tag is a format signifier: what type 
of compression etc is in use in the stored image etc.of compression etc is in use in the stored image etc. 
image.

• TIFF can store many different types of image: 1‐bit, y yp g ,
grayscale , 8‐bit color, 24‐bit RGB, etc.

• TIFF was originally a lossless format but now a new JPEG g y
tag allows one to opt for JPEG compression.
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EXIF (Exchange Image File)
• EXIF is an image format for digital cameras:• EXIF is an image format for digital cameras:

1. Compressed EXIF files use the baseline JPEG format.

2 A variety of tags (many more than in TIFF) are available2. A variety of tags (many more than in TIFF) are available 
to facilitate higher quality printing, since information 
about the camera and picture‐taking picture conditionsabout the camera and picture taking picture conditions 
(flash, exposure, light source, white balance, type of 
scene, etc.) can be stored and used by printers for 
possible color correction algorithms.

3. The EXIF standard also includes specification of file 
format for audio that accompanies digital images. As 
well, it also supports tags for information needed for 
conversion to FlashPix (initially developed by Kodak)conversion to FlashPix (initially developed by Kodak).
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Graphics Animation Files
• A few format are aimed at storing graphics 
animation(series of drawings/graphics illustrations) 

d t id ( i f i )as opposed to video(series of images).

• FLC is an animation or moving picture file format; it 
i i ll d b A i i P A hwas originally created by Animation Pro. Another 

format, FLI, is similar to FLC.

d h b l• GL produces somewhat better quality moving 
pictures. GL animations can also usually handle 
l fil i ilarger file sizes sizes.

• Many older formats: such as DL or Amiga IFF files, 
A l Q i kti fil ll i t d GIF89Apple Quicktime files, as well as animated GIF89 
files. 68
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PS (PostScript) & PDF (Portable Document Format)

P t i t i i t t l f t tti• Postscript is an important language for typesetting, 
and many high‐end printers have a Postscript 
interpreter built into theminterpreter built into them.

• PS is a vector‐based picture language, rather than 
i l b d l t d fi itipixel‐based: page element definitions are 

essentially in terms of vectors.

• PS includes text as well as vector/structured 
graphics, bit‐mapped images can be included in 

filoutput files.

• Encapsulated PS files add some additional 
information for inclusion of Postscript files in 
another document. 69
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• Postscript page description language itself does not 
provide compression; in fact, Postscript files are just p p ; , p j
stored as ASCII.

• Another text + figures language has begun to g g g g
supersede or at least parallel Postscript: Adobe 
Systems Inc. includes LZW compression in its Portable 
Document Format (PDF) file format.

• PDF files that do not include images have about the g
same compression ratio, 2:1 or 3:1, as do files 
compressed with other LZW‐based compression 
tools.

• For files containing images PDF may achieve higher 
compression ratio by using JPEG compression for the 
image content. 70
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Other Formats
• Windows WMF :‐Windows MetaFile (WMF) is the nativeWindows WMF : Windows MetaFile (WMF) is the native 
vector file format fir MS Windows operating environment.

• Windows BMP :‐ BitMap (BMP) is the major system p ( ) j y
standard graphics file format for MS Windows used in 
Paint & other programs.

• Macintosh PAINT & PICT  :‐ PAINT was originally used in 
the MacPaint program, initially only for 1‐bit monochrome 
i f i d i ( b dimages. PICT format is used in MacDraw (a vector‐based 
drawing program) for storing structured graphics.

X Wi d PPM (P t bl Pi M ) th hi f t• X Windows PPM (Portable PixMap) :‐ the graphics format 
for the X Window system. PPM supports 24‐bit color

• bitmaps and can be manipulated using many public• bitmaps, and can be manipulated using many public 
domain graphic editors.
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Color in Image and Video
• Color images and videos are everywhere on the 
web and in multimedia production.

• Also we know that there is discrepancies 
between the color as seen by the people and y p p
displayed on the screens.

• Here we will study following topicsHere we will study following topics.
– Color Science.

Color Models in Images– Color Models in Images.

– Color models in Videos.

72
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Color Science
• Light and Spectra :‐ Light is an electromagneticLight and Spectra : Light is an electromagnetic 
wave. Its color is characterized by the wavelength 
content of the lightcontent of the light.

• Laser light consists of a single wavelength: e.g., a 
ruby laser produces a bright scarlet red beamruby laser produces a bright, scarlet‐red beam.

• Most light sources produce contributions over 
l hmany wavelengths.

• However, humans cannot detect all light, just 
contributions that fall in the "visible 
wavelengths". 

• Short wavelengths produce a blue sensation, long 
wavelengths produce a red one. 73
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• Spectrophotometer: device used to measure 
visible light by reflecting light from avisible light, by reflecting light from a 
diffraction grating (a ruled surface) that 
spreads out the different wavelengthsspreads out the different wavelengths.

• Visible light is an electromagnetic wave in the 
400 700400 nm to 700 nm.
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• Fig shows the relative power in each wavelength g p g
interval for typical outdoor light on a sunny day.

• This type of curve is called a Spectral PowerThis type of curve is called a Spectral Power 
Distribution (SPD) or a spectrum.

• The symbol for wavelength is λ This curve is• The symbol for wavelength is λ. This curve is 
called E(λ).
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Human Vision
E k lik C• Eye works like Camera.

• Retina consists of array of rods (for low light 
levels and three kinds of cones (for higher 
light levels).

• The brain makes use of differences R‐G, G‐B, 
and B‐R, as well as combining all of R, G and B 
into a high‐light‐level achromatic channel.

77

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Spectral Sensitivity of the Eye
• The eye is most sensitive to light in the middle of 
the visible spectrum.p

• Fig. shows the overall sensitivity as a dashed line 
this important curve is called the luminous‐this important curve is called the luminous
efficiency function.

• It is usually denoted V (λ) and is formed as the• It is usually denoted V (λ) and is formed as the 
sum of the response curves for Red, Green, and 
BlueBlue.
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• The eye has about 6 million cones, but the 
proportions of R G and B cones are differentproportions of R, G and B cones are different 

• They likely are present in the ratios 40:20:1

• So the achromatic(without color) channel 
produced by the cones is approximately 
proportional to 

2R + G + B/20.

• These spectral sensitivity functions are usually 
denoted by letters other than "R, G, B“.y , ,

• We use a vector function q( λ), with components 
q (λ)=[q (λ) q (λ) q (λ)]Tq (λ)=[qR(λ),qG(λ),qB(λ)]

80
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• The response in each color channel in the eye is 
proportional to the number of neurons firingproportional to the number of neurons firing.

• A laser light at wavelength λ would result in a certain 
number of neurons firing. An SPD (spectral powernumber of neurons firing. An SPD (spectral power 
distribution) is a combination of single‐frequency 
lights (like lasers), so we add up the cone responses 
for all wavelengths, weighted by the eye's relative 
response at that wavelength.
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Image Formation
• The above equations applies only when we view 
a self‐luminous object.

• In many situations, we image light reflected from 
a surface.

• Surfaces reflect different amounts of light at 
different wavelengths, and dark surfaces reflect g ,
less energy than light surfaces.
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The surface spectral reflectance from (1) orange 
k d (2) f d d bl jsneakers and (2) faded bluejeans .

The reflectance function is denoted S(λ). 83
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Image formation is thus:

i h f h ill i i h (λ) i i• Light from the illuminant with SPD E(λ) impinges 
on a surface, with surface spectral reflectance 
f i S(λ) i fl d d h i fil d bfunction S(λ), is reflected, and then is filtered by 
the eye's cone functions q (λ).

• Reflection is shown in Fig. below.

• The function C(λ) is called the color signal and ( ) g
consists of the product of E(λ), the p (), 
illuminant, times S(λ), the reflectance:, ( ),
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Camera SystemsCamera Systems

87
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Gamma Correction
h l h d f hl l h• The light emitted is in fact roughly proportional to the 
voltage raised to a power; this power is called gamma, 
with symbol γwith symbol γ.

a) Thus, if the file value in the red channel is R, the screen 
emits light proportional to Rγ with SPD equal to that ofemits light proportional to Rγ, with SPD equal to that of 
the red phosphor paint on the screen that is the target 
of the red channel electron gun. The value of gamma is g g
around 2.2.

b) It is customary to append a prime to signals that are 
gamma corrected by raising to the gamma‐power (1/γ) 
before transmission. Thus we arrive at linear signals:
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• Fig 4 6(a) shows light output with gamma‐
correction applied. We see that darker values 
are displayed too dark. This is also shown in Fig. 

( )4.7(a), which displays a linear ramp from left to 
right.

• Fig 4 6(b) the effect of pre‐correcting signals by 
applying the power law R1/γ; it is customary to 
normalize voltage to the range [0,1].
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Color‐Matching Functions
• Even without knowing the eye sensitivity curves a• Even without knowing the eye‐sensitivity curves, a 
technique evolved in psychology for matching a 
combination of basic R, G, and B lights to given shade.combination of basic R, G, and B lights to given shade.

• The particular set of three basic lights used in an 
experiment are called the set of color primaries.p p

• To match a given color, a subject is asked to separately 
adjust the brightness of the three primaries using a set j g p g
of controls until the resulting spot of light most closely 
matches the desired color.

• The basic situation is shown in Fig.

A device for carrying out such an experiment is called a

colorimeter.
92
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Color Monitor Specifications
• Color monitors are specified in part by the 
white point chromaticity that is desired if the 
RGB electron guns are all activated at their 
highest value (1.0, if we normalize to [0,1]).

• We want the monitor to display a specified 
white when R’=G’=B’=1.

• There are several monitor specifications in 
current use ( Table 4.1).( )

94

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



95

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



• RGB Color Model for CRT Displays
Color Models in Images

1.We expect to be able to use bits per color channel for color 
that is accurate enough.

2.However, in fact we have to use about 12 bits per channel to 
avoid an aliasing effect in dark image areas —contour bands 
th t lt f tithat result from gamma correction.

3.For images produced from computer graphics, we store 
integers proportional to intensity in the frame buffer Sointegers proportional to intensity in the frame buffer. So 
should have a gamma correction LUT between the frame 
buffer and the CRT. 

4.If gamma correction is applied to floats before quantizing to 
integers, before storage in the  frame buffer, then in fact we 
can use only 8 bits per channel and still avoid contouring 
artifacts. 96
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Subtractive Color: CMY Color Model
• So far we have effectively been dealing only with• So far we have effectively been dealing, only with 
additive color. Namely, when two light beams impinge 
on a target, their colors add; when two phosphors on aon a target, their colors add; when two phosphors on a 
CRT screen are turned on, their colors add.

• But for ink deposited on paper, the opposite situation p p p , pp
holds: yellow ink subtracts blue from white 
illumination, but reflects red and green; it appears 
yellow.

• Instead of red, green, and blue primaries, we need 
primaries that amount to ‐red, ‐green, ‐blue. I.e., we 
need to subtract R, or G, or B.

Th b i l i i C (C)• These subtractive color primaries are Cyan (C), 
Magenta (M) and Yellow (Y )inks. 97
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Transformation from RGB to CMY
Si l t d l i t t if h t i k• Simplest model we can invent to specify what ink 
density to lay down on paper, to make a certain 
d i d RGB ldesired RGB color.

• Then the inverse transform is:

99
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color combinations that result from combining 
primary colors available in the two situationsprimary colors available in the two situations, 
additive color and subtractive color.
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Printer Gamuts
• Actual transmission curves overlap for the C M Y• Actual transmission curves overlap for the C, M, Y 
inks. This leads to "crosstalk“ between the color 
channels and difficulties in predicting colorschannels and difficulties in predicting colors 
achievable in printing.

Fi ( ) h t i l t i i f l "bl k• Fig (a) shows typical transmission for real "block 
dyes", and Fig.(b) shows the resulting color 

t f l i tgamut for a color printer.
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Color Models in Video
Video Color TransformsVideo Color Transforms
• Methods of dealing with color in digital video derive 
largely from older analog methods of coding color for TV. 
Luminance is separated from color information.

• For example, a matrix transform method called YIQ is used 
t t it TV i l i N th A i d Jto transmit TV signals in North America and Japan.

• This coding also makes its way into VHS video tape coding 
in these countries since video tape technologies also usein these countries since video tape technologies also use 
YIQ. 

• In Europe, video tape uses the PAL or SECAM codings, 
which are based on TV that uses a matrix transform called 
YUV.
Di i l id l i f ll d YCbC• Digital video mostly uses a matrix transform called YCbCr 
that is closely related to YUV.
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YUV Color Model
• YUV codes a luminance signal (for gamma corrected• YUV codes a luminance signal (for gamma‐corrected 
signals)  equal to Y’ in Eq. (4.20). the "luma".

• Chrominance refers to the difference between a color• Chrominance refers to the difference between a color 
and a reference white at the same luminance → use 
color differences U, V :,

• U = B’−Y’ V = R’−Y’  (4.27)

• From Eq (4 20) [Y’ =0 299∙R’+0 587∙G’+0 114∙B’] & eqFrom Eq. (4.20) [Y   0.299 R +0.587 G +0.114 B ] & eq 
(4.27)
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• For gray, R’ = G’ = B’ , the luminance Y’ equals to that 
gray since 0 299 + 0 587 + 0 114 = 1 0 And for a graygray, since 0.299 + 0.587 + 0.114 = 1.0. And for a gray 
("black & white") image the chrominance (U, V )is zero.

• In the actual implementation U and V are rescaled toIn the actual implementation U and V are rescaled to 
have a more convenient maximum and minimum.

• For dealing with composite video, it turns out to be g p ,
convenient to contain U, V within the range − 1/3to 
+4/3. So U and V are rescaled:

• U =0.492111 (B’− Y’)

• V =0.877283 ( R’− Y’)  ( 4.29) 

• The chrominance signal = the composite signal C:

• C = U∙cos(ωt)+V ∙sin(ωt)  (4.30)
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• Zero is not the minimum value for U, V. 

i i l f bl ( ) ll• U is approximately from blue (U> 0) to yellow 
(U< 0) in the RGB cube; V is approximately 
f d (V 0) (V 0)from red (V> 0) to cyan (V< 0).

• Fig. shows the decomposition of a color image 
into its Y’, U, V components. Since both U and 
V go negative, in fact the images displayed are 
shifted and rescaled.
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UNIT IUNIT I
Introduction to Multimedia

By :-
Vijaykumar MantriVijaykumar Mantri,

Asso. Prof. in IT Dept.,
BVRIT, Narsapur
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What is Multimedia?
• When different people mention the term multimedia, they oftenWhen different people mention the term multimedia, they often 

have quite different, or even opposing, viewpoints.

• A PC vendor: a PC that has sound capability, a DVD‐ROM drive, and 
h th i it f lti di bl d iperhaps the superiority of multimedia‐enabled microprocessors 

that understand additional multimedia instructions.

• A consumer entertainment vendor: interactive cable TV with 
hundreds of digital channels available, or a cable TV‐like service 
delivered over a high‐speed connection high Internet connection.

• A Computer Science (CS) student: applications that use multiple• A Computer Science (CS) student: applications that use multiple 
modalities, including text, images, drawings (graphics), animation, 
video sound including speech and interactivity video, speech, 
i i iinteractivity.

• Multimedia and Computer Science: Graphics HCI visualizationMultimedia and Computer Science: Graphics, HCI, visualization, 
computer vision, data compression, graph theory, networking, 
database systems. 2
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Components of Multimedia
• Multimedia involves multiple modalities of text• Multimedia involves multiple modalities of text,  
audio, images, drawings, animation, and video.

• Examples of how these modalities are put to use:Examples of how these modalities are put to use:

• Video teleconferencing.

• Distributed lectures for higher education• Distributed lectures for higher education.

• Tele‐medicine.

• Co operative work environments• Co‐operative work environments.

• Searching in (very) large video and image databases for 
target visual objectstarget visual objects.

• "Augmented"reality:  placing real‐appearing computer 
video scenes graphics and objects into scenesvideo scenes graphics and objects into scenes.

3
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• Including audio cues for where video‐conference 
ti i t l t dparticipants are located.

• Building searchable features into new video, and 
enabling er high to er lo bit rate ne se of neenabling very high‐to very low‐bit‐rate new use of new, 
scalable multimedia products.

• Making components editable multimedia editable• Making components editable multimedia editable.

• Building "inverse‐Hollywood” applications that can 
recreate the process by which a video was maderecreate the process by which a video was made. 

• Video understanding has also been called an inverse 
Hollywood problemHollywood problem.

• Using voice‐recognition to build an interactive 
environment, say a kitchen‐wall web browser.environment, say a kitchen wall web browser.

4
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Multimedia Research Topics & Projects 
h h l d f• To the computer science researcher, multimedia consists of 

a wide variety of topics:
• Multimedia processing and coding: multimedia content 

analysis, content‐based multimedia retrieval, multimedia 
security, audio/image/video processing, compression, etc.

• Multimedia system support and networking: network 
protocols, Internet, operating systems, servers and clients, 
quality of service (QoS), and databases.

• Multimedia tools end‐systems applications:  Hypermedia 
systems, user interfaces, authoring systems.

• Multi‐modal interaction and integration: "ubiquity"—
web‐everywhere devices, multimedia education including y g
Computer Supported Collaborative Learning, and design 
and applications of virtual environments.

5
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Current Multimedia Projects
h l• Many exciting research projects are currently 

underway. Here area few of them:
1. Camera‐based object tracking technology: tracking ofj g gy g
the control objects provides user control of the process.
2. 3D motion capture: used for multiple actor capture so 
that m ltiple a tors in a irt al st dio an be sed realthat multiple actors in a virtual studio can be used real 
to automatically produce realistic animated models 
with natural movement.

3. Multiple views: allowing photo‐realistic (video‐quality) 
synthesis of virtual actors from several cameras or from 
a single camera under differing lighting.

4. 3D capture technology: allow synthesis of highly 
realistic speech facial animation from speech.

6
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5. Specific multimedia applications: aimed at 
handicapped persons with low vision capabilityhandicapped persons with low vision capability 
and the elderly —a rich field of endeavor.

6. Digital fashion: aims to develop smart clothing 
th t i t ith th h h dthat can communicate with other such enhanced 
clothing using wireless communication, so as to 
artificially enhance human interaction in a social y
setting.

7 Electronic Housecall system: an initiative for 
idi i t ti h lth it i iproviding interactive health monitoring services 

to patients in their homes
8. Augmented Interaction applications: used to8. Augmented Interaction applications: used to 
develop interfaces between real and virtual 
humans for tasks such as augmented storytelling .

7
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Multimedia and Hypermedia
Hi t f M lti di• History of Multimedia:

1. Newspaper: perhaps the first mass communication 
medium uses text graphics and imagesmedium, uses text, graphics, and images.

2. Motion pictures: conceived of in 1830's in order to 
observe motion too rapid for perception by theobserve motion too rapid for perception by the 
human eye.

3. Wireless radio transmission: Guglielmo Marconi, at3. Wireless radio transmission: Guglielmo Marconi, at 
Pontecchio, Italy, in 1895.

4. Television: the new medium for the 20th century, y,
established video as a commonly available medium 
and has since changed the world of mass 

i ticommunications .
8
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5. The connection between computers and ideas about 
multimedia covers what is actually only a short period:

1945 – Vannevar Bush wrote a landmark article describing 
what amounts to a hypermedia system called Memex.

1960 Ted Nelson coined the term hypertext1960 – Ted Nelson coined the term hypertext.
1967 – Nicholas Negroponte formed the Architecture 
Machine Group. p

1968 – Douglas Engelbart demonstrated the On‐Line System 
(NLS), another very early hypertext program.

1969 – Nelson hypertext and van Dam at Brown University 
created an early editor called FRESS.

1976 The MIT Architecture Machine Group proposed a1976 – The MIT Architecture Machine Group proposed a 
project entitled Multiple Media — resulted in the Aspen 
Movie Map, hypermedia videodisk, in 1978.

9
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1985 – Negroponte and Wiesner co‐founded the MIT Media Lab.
1989 – Tim Berners‐Lee proposed the World Wide Web
1990 K i ti H W l h d d th A l M lti di1990 – Kristina Hooper Woolsey headed the Apple Multimedia 

Lab.
1991 MPEG 1– MPEG [M(oving) P(ictures) E(xperts) G(roup)]was 

d i i l d d f di i l id l dapproved as an international standard for digital video — led 
to the newer standards, MPEG‐2, MPEG‐4, and further MPEGs 
in the 1990s.

1991 h i d i f i 1991 b i d i1991 – The introduction of PDAs in 1991 began a new period in 
the use of computers in multimedia.

1992 – JPEG was accepted as the international standard for  
d l l d hdigital image compression — led to the new JPEG2000 
standard.

1992 – The first MBone audio multicast on the Net was made.
1993 The of Illinois National Center for Supercomputing–

University Applications produced NCSA Mosaic — the first  
full‐fledged browser.

10
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• 1994 – Jim Clark and Marc Andreessen created the 
Netscape program .Netscape program .

• 1995 – The JAVA language was created for platform 
independent application development.

• 1996 – DVD video was introduced; high quality 
full‐length movies were distributed on a single disk.

• 1998 XML 1 0 as anno nced as a W3C• 1998 – XML 1.0 was announced as a W3C 
Recommendation.

• 1998 – Hand‐held MP3 devices first made inroads into1998  Hand held MP3 devices first made inroads into 
consumerist tastes in the fall of 1998, with the 
introduction holding of flash of devices 32MB memory.
2000 i i d billi• 2000 – WWW size was estimated at over 1 billion 
pages.

11
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Hypermedia and Multimedia
• A hypertext system meant to be read nonlinearly by• A hypertext system: meant to be read nonlinearly, by 
following links that point to other parts of the 
document, or to other documents.document, or to other documents.

• HyperMedia: not constrained to be text‐based, can 
include other media, e.g., graphics, images, and , g , g p , g ,
especially the continuous media sound and video.
– The World Wide Web (WWW) — the best example of a 
hypermedia application.

• Multimedia means that computer information can be 
t d th h di hi i direpresented through audio graphics images audio, 

graphics, images,

• ideo and animation in addition to traditional media• video, and animation in addition to traditional media.
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Examples of typical present multimedia applications 
include:

• Digital video editing and production systems.

• Electronic newspapers/magazines.p p g

• World Wide Web.

• On‐line reference works: e.g. encyclopedias, games.g y p , g

• Home shopping.

• Interactive TV.Interactive TV.

• Multimedia courseware.

• Video conferencing• Video conferencing.

• Video‐on‐demand.

• Interactive movies• Interactive movies.

14
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World Wide Web

• The W3C has listed the following goals for the 
WWWWWW 

1. Universal access of web resources (by 
e er one e er here)everyone everywhere).

2. Effectiveness of navigating available 
information.

3. Responsible use of posted material.

15
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HTTP ( HyperText Transfer Protocol)
• HTTP: a protocol that was originally designed for 
transmitting hypermedia but can also support 
t i i f fil ttransmission of any file type.

• HTTP a stateless request/response protocol: is no 
information carried over for the next requestinformation carried over for the next request.

• The basic request format:

M th d URI V iMethod URI Version

Additional‐Headers:

b dMessage‐body

• The URI (Uniform Resource Identifier): an identifier for 
th d th h t lthe resource accessed, e.g. the host name, always 
preceded by the token http://.

16
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• Two popular methods: GET and POST.

• The basic response format:

– Version Status‐Code Status‐Phrase

– Additional‐Headers

• Additional Message body• Additional – Message‐body

• Two commonly seen status codes:

• 200 OK — the request was processed 
successfully.

• 404 Not Found — the URI does not exist.

17
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HTML ( HyperText Markup Language)
• HTML: a language for publishing Hypermedia on the 
World Wide Web — defined using SGML:

1. HTML uses ASCII, it is portable to all different 
(possibly binary incompatible) computer hardware.

h f2. The current version of HTML is version 4.01.

3. The next generation of HTML is XHTML —a 
f l ti f HTML i XMLreformulation of HTML using XML.

• HTML uses tags to describe document elements:
t k d fi i t ti i t<token params> —defining a starting point,

</token> — the ending point of the element.

Some elements have no ending tagsSome elements have no ending tags.

18
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XML ( Extensible Markup Language)
k l f h h h h• XML: a markup language for the WWW in which there 

is modularity of data, structure and view so that user 
or application can be able to define the tagsor application can be able to define the tags 
(structure).

• Example of using XML to retrieve stock informationExample of using XML to retrieve stock  information 
from a database a query according to user 

1. First use a global Document Type Definition (DTD)1. First use a global Document Type Definition (DTD) 
that is already defined.

2. The server side script will abide by the DTD rules to p y
generate document an XML according to the query 
using data from your database.

3. Finally send user the XML Style Sheet ( XSL) depending 
on the type of device used to display the information. 20
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• The current XML version is XML 1.0, approved 
by the W3C in Feb 1998by the W3C in Feb. 1998.

• XML syntax looks like HTML syntax, although it 
is much more strict:is much more strict:

–All tags are in lower case and a tag has only 
l d h lfinline data has to terminate itself, i.e., 

<token params />.

–Uses name spaces so that multiple DTDs 
declaring different elements but with 
similar tag names can have their elements 
distinguished.

–DTDs can be imported from URIs as well.
21
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• The following XML related specifications are also 
standardized:standardized:

– XML Protocol: used to exchange XML information 
between processes .between processes .

– XML Schema: a more structured and powerful 
language defining XML data types (tags).g g g yp ( g )

– XSL: basically CSS for XML.

– SMIL : synchronized Integration MultimediaSMIL : synchronized Integration Multimedia 
Language, pronounced "smile"— a particular 
application of XML (globally predefined DTD) that 
allows for specification of interaction among any 
media types and user input, in a temporally scripted 
manner.

23
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SMIL (Synchronized Multimedia Integration Language)

• Purpose of SMIL: it is also desirable to be able• Purpose of SMIL: it is also desirable to be able 
to publish presentations using multimedia a 
markup languagemarkup language.

• A multimedia language needs to scheduling 
and s nchroni ation of different m ltimediaand synchronization of different multimedia 
elements, and define their interactivity with 
the userthe user.

• The W3C established a Working Group in 
1997 to come up with specifications for a 
multimedia synchronization language

• SMIL 2 0 was accepted August 2001 2.0 in 
2001. 24
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• SMIL 2.0 is specified in XML using a  
modularization approach similar to the one usedmodularization approach similar to the one used 
in xhtml:

1 All S IL l di id d i d l1. All SMIL elements are divided into modules —
sets of elements, attributes and values that 
d fi l f i lidefine one conceptual functionality.

2. In the interest of modularization, not all 
available modules need to be included for all 
applications.

3. Language Profiles: specifies a particular 
grouping of modules, and particular modules g p g , p
may have integration profile must requirements 
that a follow. 25
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Overview of Multimedia Software Tools
1 Music Sequencing and Notation1. Music Sequencing and Notation

• Cakewalk: now called Pro Audio.

The term sequencer comes from older devices that storedThe term sequencer comes from older devices that stored 
sequences of notes ("events", in MIDI).

It is also possible to insert WAV files and Windows MCI p
commands (for animation and video) into music tracks 
(MCI is a ubiquitous component of the Windows API.)

• Cubase: another sequencing/editing program, with 
capabilities similar to those of Cakewalk. It includes some 
tools digital audio editing toolstools digital audio editing tools.

• Macromedia Soundedit: mature program for creating 
audio for multimedia projects and the web that integrates p j g
well with other Macromedia products such as Flash and 
Director. 27
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2. Digital Audio
• Cool Edit: a very powerful and popular digital 
audio toolkit; emulates a professional audio 
studio —multitrack productions and sound file 
editing including digital signal processing effects.

• Sound Forge: a sophisticated PC‐based program 
for WAV audio files.

• Pro Tools: a high‐end integrated audio 
production and editing environment MIDIproduction and editing environment MIDI 
creation and manipulation; powerful audio 
mixing recording and editing softwaremixing, recording,and editing software.

28
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3.Graphics and Image Editing
• Adobe Illustrator: a powerful publishing tool from• Adobe Illustrator: a powerful publishing tool from 
Adobe. Uses vector graphics; can be exported to Web 
graphics Web.g p

• Adobe Photoshop: the standard in a graphics, image 
processing and manipulation tool. 
– Allows layers of images, graphics, and text that can be 
separately manipulated for maximum flexibility.

il f i i f hi i d li h i ff– Filter factory permits creation of sophisticated lighting‐effects 
filters.

• Macromedia Fireworks: software for making graphics• Macromedia Fireworks: software for making graphics 
specifically for the web.

• Macromedia Freehand: a text and web graphics editingMacromedia Freehand: a text and web graphics editing 
tool that supports many bitmap formats such as GIF, 
PNG, and JPEG. 29
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4.Video Editing
• Adobe Premiere: an intuitive, simple video editing toolAdobe Premiere: an intuitive, simple video editing tool 
editing i e clips for nonlinear editing, i.e., putting video 
into any order:
Video and audio are arranged in "tracks" tracks .

Provides a large number of video and audio tracks,

superimpositions and virtual clips. => effective 

multimedia productions with little effort.

Ad b Aft Eff t f l id diti t l• Adobe After Effects: a powerful video editing tool 
that enables users to add and change existing movies. 
Can add many effects: lighting shadows motionCan add many effects: lighting, shadows, motion 
blurring; layers.

• Final Cut Pro: a video editing tool by Apple;Final Cut Pro: a video editing tool by Apple; 
Macintosh only.

30
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5. Animation
Multimedia APIs:Multimedia APIs:

• Java3D: API used by Java to construct and render 3D 
graphics similar to the way in which the Java Mediagraphics, similar to the way in which the Java Media 
Framework is used for handling media files.

1 Provides a basic set of object primitives (cube, splines,1 Provides a basic set of object primitives (cube, splines, 
etc.) for building scenes.

2. It is an abstraction layer built on top of OpenGL or y p p
DirectX (the user can select which).

• DirectX : Windows API that supports video, images, 
audio and 3‐D animation

• OpenGL: the highly portable most popular 3 D API

31
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Rendering Tools:

• 3D Studio Max: rendering tool that includes a number3D Studio Max: rendering tool that includes a number 
of very high‐end professional tools for character 
animation, game development, and visual effects g p
production. 

• Softimage XSI: a powerful modeling, animation, and 
rendering package used for animation and special 
effects in films and games.

• Maya: competing product to Softimage; as well, it is a 
complete modeling package.

• RenderMan: rendering package created by Pixar.

• GIF Animation Packages: a simpler approach to 
i ti ll i k d l t f ff tianimation, allows very quick development of effective 

small animations for the web. 32

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



6.Multimedia Authoring
d l h ll• Macromedia Flash: allows users to create interactive 

movies using the score metaphor i.e. a timeline 
arranged in parallel event sequencesarranged in parallel event sequences.

• Macromedia Director: uses a movie metaphor to create 
interactive presentations — very powerful and includesinteractive presentations  very powerful and includes 
a built‐in scripting language, Lingo, that allows creation 
of complex interactive movies.p

• Authorware: a mature, well‐supported authoring 
product based on the Iconic/Flow‐control metaphor.

• Quest: similar to Authorware in many ways, uses a type 
of flowcharting metaphor. However, flowchart nodes 
can encapsulate information in a more abstract way 
(called frames) than simply subroutine levels. 33
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Graphics and Image Data Representations
Graphics/Image Data TypesGraphics/Image Data Types

• The number of file formats used in multimedia 
i idlcontinues to rapidly.

34
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1‐bit Images
• Pixels, or pels: picture elements 

• Each pixel is stored as a single bit (0 or 1), so p g ( ),
also referred to as binary image.

• Such an image is also called a 1‐bitSuch an image is also called a 1 bit 
monochrome image since it contains no color.

35
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8‐bit Gray‐level Images
h l h l b d• Each pixel has a gray‐value between 0 and 255.

• Each pixel is represented by a single byte; e.g., a dark 
i l i ht h l f 10 d b i ht i ht bpixel might have a value of 10 and bright one might be 

230.

• Bitmap: The two dimensional array of pixel values that• Bitmap: The two‐dimensional array of pixel values that 
represents the graphics/image  data.

• Image resolution refers to the number of pixels in a• Image resolution refers to the number of pixels in a 
digital image (higher resolution always yields better 
quality).q y)

• Fairly high resolution for such an image might be 1, 
600 × 1, 200, whereas lower resolution might be 640 ×, , g
480.
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• Frame buffer: Hardware used to store bitmap.

Video card (actually a graphics card) is used for– Video card (actually a graphics card) is used for 
this purpose.

• The resolution of the video card does not have to• The resolution of the video card does not have to 
match the desired resolution of the image, but if 
not enough video card memory is available then thenot enough video card memory is available then the 
data has to be shifted around in RAM for display.

• 8 bit image can be thought of as a set of 1 bit• 8‐bit image can be thought of as a set of 1‐bit 
bitplanes, where each plane consists of a 1‐bit 
representation of the image at higher and higherrepresentation of the image at higher and higher 
levels of "elevation": a bit is turned on if the image 
pixel has a nonzero value that is at or above that bit p
level.
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• Each pixel is usually stored as a byte (a value 
b 0 255) 640 480 lbetween 0 to 255), so a 640 × 480 grayscale 
image requires 300 kB of storage (640 × 480 = 
307 200)307, 200).

• If we want to print such image, things become 
more complex.

• When an image is printed, the basic strategy g p gy
of dithering is used, which trades intensity 
resolution for spatial resolution to provide p p
ability to print multi‐level images on 2‐level ( 
1‐bit) printers.
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Dithering
F ll l h t h t i l t• Full‐color photographs may contain an almost 
infinite range of color values. Dithering is the 

t f d i th lmost common means of reducing the color 
range of images down to the 256 (or fewer) 
l i 8 bit GIF icolors seen in 8‐bit GIF images.

• For printing, Dithering is used to calculate larger 
patterns of dots such that values from 0 to 255 
correspond to pleasing patterns that correctly 
represent darker and brighter pixel values.
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• The main strategy is to replace a pixel value by 
a larger pattern say 2 × 2 or 4 × 4 such that thea larger pattern say 2 × 2 or 4 × 4 such that the  
number of printed dots approximates the 
varying sized disks of ink used in analog invarying sized disks of ink used in analog, in 
halftone sized printing (e.g., for newspaper 
photos)photos).

• Half‐tone printing is an analog process that uses 
ll l fill d i l f bl k i ksmaller or larger filled circles of black ink to 

represent shading, for newspaper printing.
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Fig. (a) shows a grayscale image of "Lena". 
The ordered-dither version is shown as Fig. (b),The ordered dither version is shown as Fig. (b), 
with a detail of Lena’s right eye in Fig. (c).
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Image Data Types
• The most common data types for graphics and 
image file formats — 24‐bit color and 8‐bit 
color.

• Most image formats incorporate some g p
variation of a compression technique due to 
the large storage size of image files. g g g

• Compression techniques can be classified into 
either lossless or lossyeither lossless or lossy.
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24‐bit Color Images
• In a color 24‐bit image each pixel is represented by• In a color 24‐bit image, each pixel is represented by 
three bytes, usually representing RGB.

• This format supports 256 × 256 × 256 possibleThis format supports 256 × 256 × 256 possible 
combined colors, or a total of 16,777,216 possible 
colors.

• However such flexibility does result in a storage 
penalty: A 640 × 480 24‐bit color image would require 
921.6 kB of storage without any compression. 

• An important point: many 24‐bit color images are 
actually stored as 32‐bit images, with the extra byte of 
data for each pixel used to store an alpha value 
representing special effect information (e grepresenting special effect information (e.g., 
transparency).
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8‐bit Color Images
• Many systems can make use of 8 bits of color 
information (the so‐called "256 colors") in 
producing a screen image.

• Such image files use the concept of a lookup 
table to store color information.

• Basically, the image stores not color, but y, g ,
instead just a set of bytes, each of which is 
actually an index into a table with 3‐byte y y
values that specify the color for a pixel with 
that lookup table index.p
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• An image histogram is a type of histogram 
which acts as a graphical representation of thewhich acts as a graphical representation of the 
tonal distribution in a digital image. It plots 
the number of pixels for each tonal valuethe number of pixels for each tonal value.
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Color Look Look‐up Table (LUT)p ( )

Also called as Palette

50
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How to Devise a Color Lookup Table
• The most straightforward way to make 8 bit look up color out• The most straightforward way to make 8‐bit look‐up color out 

of 24‐bit color would be to divide the RGB cube into equal slices 
in each dimension.

• The centers of each of the resulting cubes would serve as the 
entries in the color LUT, while simply scaling the RGB ranges 
0 255 into the appropriate ranges would generate the 8‐bit0..255 into the appropriate ranges would generate the 8 bit 
codes.

• Since humans are more sensitive to R and G than to B, we 
could shrink the R range and G range 0..255 into the 3 bit range 
0..7 and shrink the B range down to the 2‐bit range 0..3, thus 
making up a total of 8 bits.making up a total of 8 bits.

• To shrink R and G, we could simply divide the R or G value by 
(256/8)=32 and then truncate. Then each pixel in the image gets 

l d b i 8 bi i d d h l LUTreplaced by its 8‐bit index and the color LUT serves to generate 
24‐bit color.

53
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Median ‐cut algorithm for Color
Reduction Problem

• A simple alternate solution that does a better job for this 
color reduction problem.

) Th id i t t th R b t l d fi d th i dia) The idea is to sort the R byte values and find their median; 
then values smaller than the median are labeled with a "0" 
bit and values larger than the median are labeled with a "1" g
bit.

b) This type of scheme will indeed concentrate bits where they 
most need to differentiate between high populations of 
close colors.

) O t il i li fi di th di b ic) One can most easily visualize finding the median by using a 
histogram showing counts at position 0..255.

d) Fig shows a histogram of the R byte values for thed) Fig. shows a histogram of the R byte values for the 
forestfire.bmp image along with the median of these values, 
shown as a vertical line. 54
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Median‐Cut Algorithm
1. Find the smallest box that contains all the colors in the 

image.

2 Sort the enclosed colors along the longest dimension of the2. Sort the enclosed colors along the longest dimension of the 
box.

3. Split the box into two regions at the median of the sorted list.p g

4. Repeat that the above process in steps ( 2) and ( 3) until the 
original color space has been divided into, say, 256 regions.

5 For every box call the mean of R G and B in that box the 
representative (the center) color for the box.

6 B d th E lid di t b t i l RGB l6. Based on the Euclidean distance between a pixel RGB value 
and the box centers, assign every pixel to one of the 
representative colors. Replace the pixel by the code in a p p p y
lookup table that indexes representative colors.
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Popular File Formats 3

• GIF (Graphics Interchange Format)

JPEG (J i t Ph t hi E t G )• JPEG (Joint Photographic Experts Group)

• PNG (Portable Network Graphics)p

• TIFF(Tagged Image File Format)

EXIF (E h I Fil )• EXIF (Exchange Image File)

57
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GIF (Graphics Interchange Format)
• GIF standard uses Lempel‐Ziv‐Welch algorithm• GIF standard uses Lempel‐Ziv‐Welch algorithm.

• Limited to 8‐bit ( 256) color images only, which, while 
producing acceptable color images is best suited forproducing acceptable color images, is best suited for 
images with few distinctive colors (e.g., graphics or 
Drawing).

• GIF standard supports interlacing — successive display 
of pixels in widely‐spaced rows by a 4‐pass display 
process.

• GIF images are of two types
– GIF87a: The original specification .

– GIF89a: The later version. Supports simple animation via 
hi l i bl k i h d ida Graphics Control Extension block in the data, provides 

simple control over delay time a transparency index etc.
58
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GIF87

GIF File Format

59
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GIF 
ScreenScreen 
Descriptor

60
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GIF Color Map
61
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GIF Image Descriptor
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JPEG (Joint Photographic Expert Group)
• The most important current standard for 
image compression.

• The human vision system has some specific 
limitations and JPEG takes advantage of these 
to achieve high rates of compression.

• The eye‐brain system cannot see extremely y y y
fine detail.

• JPEG allows the user to set a desired level ofJPEG allows the user to set a desired level of 
quality, or compression ratio (input divided by 
output)output).

63

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



JPEG image withJPEG image with 
low quality 
specified by user.

A l Fi h f tfi i ith• As an example, Fig. shows forestfire image, with a 
quality factor Q=10%.

• This image is a mere 1 5% of the original size In• This image is a mere 1.5% of the original size. In 
comparison, a JPEG image with Q=75% yields an image 
size 5.6% of the original, whereas a GIF version of thissize 5.6% of the original, whereas a GIF version of this 
image compresses down to 23.0% of uncompressed 
image size. 64
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PNG (Portable Network  Graphics)
• PNG meant to supersede the GIF standard and extends it• PNG meant to supersede the GIF standard, and extends it 
in important ways.

• Special features of PNG files include support for 48 bits ofSpecial features of PNG files include support for 48 bits of 
color information.

• Files may contain gamma‐correction information forFiles may contain gamma correction information for 
correct display images alpha channel of color images, as 
well as alpha‐information for such uses as control of 
transparency.

• The display progressively displays pixels in a 2‐
dimensional fashion by showing a few pixels at a time 
over seven passes through each 8 × 8 block of an image.
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TIFF(Tagged Image File Format)
h l f l f d l d b• TIFF is another popular image file format, developed by 

the Aldus Corporation in the 1980’s and was later 
supported by Microsoftsupported by Microsoft .

• Its support for attachment of additional information 
(referred to as "tags") provides a great deal of flexibility(referred to as  tags ) provides a great deal of flexibility.

• The most important tag is a format signifier: what type 
of compression etc is in use in the stored image etc.of compression etc is in use in the stored image etc. 
image.

• TIFF can store many different types of image: 1‐bit, y yp g ,
grayscale , 8‐bit color, 24‐bit RGB, etc.

• TIFF was originally a lossless format but now a new JPEG g y
tag allows one to opt for JPEG compression.
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EXIF (Exchange Image File)
• EXIF is an image format for digital cameras:• EXIF is an image format for digital cameras:

1. Compressed EXIF files use the baseline JPEG format.

2 A variety of tags (many more than in TIFF) are available2. A variety of tags (many more than in TIFF) are available 
to facilitate higher quality printing, since information 
about the camera and picture‐taking picture conditionsabout the camera and picture taking picture conditions 
(flash, exposure, light source, white balance, type of 
scene, etc.) can be stored and used by printers for 
possible color correction algorithms.

3. The EXIF standard also includes specification of file 
format for audio that accompanies digital images. As 
well, it also supports tags for information needed for 
conversion to FlashPix (initially developed by Kodak)conversion to FlashPix (initially developed by Kodak).
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Graphics Animation Files
• A few format are aimed at storing graphics 
animation(series of drawings/graphics illustrations) 

d t id ( i f i )as opposed to video(series of images).

• FLC is an animation or moving picture file format; it 
i i ll d b A i i P A hwas originally created by Animation Pro. Another 

format, FLI, is similar to FLC.

d h b l• GL produces somewhat better quality moving 
pictures. GL animations can also usually handle 
l fil i ilarger file sizes sizes.

• Many older formats: such as DL or Amiga IFF files, 
A l Q i kti fil ll i t d GIF89Apple Quicktime files, as well as animated GIF89 
files. 68
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PS (PostScript) & PDF (Portable Document Format)

P t i t i i t t l f t tti• Postscript is an important language for typesetting, 
and many high‐end printers have a Postscript 
interpreter built into theminterpreter built into them.

• PS is a vector‐based picture language, rather than 
i l b d l t d fi itipixel‐based: page element definitions are 

essentially in terms of vectors.

• PS includes text as well as vector/structured 
graphics, bit‐mapped images can be included in 

filoutput files.

• Encapsulated PS files add some additional 
information for inclusion of Postscript files in 
another document. 69
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• Postscript page description language itself does not 
provide compression; in fact, Postscript files are just p p ; , p j
stored as ASCII.

• Another text + figures language has begun to g g g g
supersede or at least parallel Postscript: Adobe 
Systems Inc. includes LZW compression in its Portable 
Document Format (PDF) file format.

• PDF files that do not include images have about the g
same compression ratio, 2:1 or 3:1, as do files 
compressed with other LZW‐based compression 
tools.

• For files containing images PDF may achieve higher 
compression ratio by using JPEG compression for the 
image content. 70
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Other Formats
• Windows WMF :‐Windows MetaFile (WMF) is the nativeWindows WMF : Windows MetaFile (WMF) is the native 
vector file format fir MS Windows operating environment.

• Windows BMP :‐ BitMap (BMP) is the major system p ( ) j y
standard graphics file format for MS Windows used in 
Paint & other programs.

• Macintosh PAINT & PICT  :‐ PAINT was originally used in 
the MacPaint program, initially only for 1‐bit monochrome 
i f i d i ( b dimages. PICT format is used in MacDraw (a vector‐based 
drawing program) for storing structured graphics.

X Wi d PPM (P t bl Pi M ) th hi f t• X Windows PPM (Portable PixMap) :‐ the graphics format 
for the X Window system. PPM supports 24‐bit color

• bitmaps and can be manipulated using many public• bitmaps, and can be manipulated using many public 
domain graphic editors.
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Color in Image and Video
• Color images and videos are everywhere on the 
web and in multimedia production.

• Also we know that there is discrepancies 
between the color as seen by the people and y p p
displayed on the screens.

• Here we will study following topicsHere we will study following topics.
– Color Science.

Color Models in Images– Color Models in Images.

– Color models in Videos.
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Color Science
• Light and Spectra :‐ Light is an electromagneticLight and Spectra : Light is an electromagnetic 
wave. Its color is characterized by the wavelength 
content of the lightcontent of the light.

• Laser light consists of a single wavelength: e.g., a 
ruby laser produces a bright scarlet red beamruby laser produces a bright, scarlet‐red beam.

• Most light sources produce contributions over 
l hmany wavelengths.

• However, humans cannot detect all light, just 
contributions that fall in the "visible 
wavelengths". 

• Short wavelengths produce a blue sensation, long 
wavelengths produce a red one. 73
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• Spectrophotometer: device used to measure 
visible light by reflecting light from avisible light, by reflecting light from a 
diffraction grating (a ruled surface) that 
spreads out the different wavelengthsspreads out the different wavelengths.

• Visible light is an electromagnetic wave in the 
400 700400 nm to 700 nm.
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• Fig shows the relative power in each wavelength g p g
interval for typical outdoor light on a sunny day.

• This type of curve is called a Spectral PowerThis type of curve is called a Spectral Power 
Distribution (SPD) or a spectrum.

• The symbol for wavelength is λ This curve is• The symbol for wavelength is λ. This curve is 
called E(λ).
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Human Vision
E k lik C• Eye works like Camera.

• Retina consists of array of rods (for low light 
levels and three kinds of cones (for higher 
light levels).

• The brain makes use of differences R‐G, G‐B, 
and B‐R, as well as combining all of R, G and B 
into a high‐light‐level achromatic channel.
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Spectral Sensitivity of the Eye
• The eye is most sensitive to light in the middle of 
the visible spectrum.p

• Fig. shows the overall sensitivity as a dashed line 
this important curve is called the luminous‐this important curve is called the luminous
efficiency function.

• It is usually denoted V (λ) and is formed as the• It is usually denoted V (λ) and is formed as the 
sum of the response curves for Red, Green, and 
BlueBlue.
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• The eye has about 6 million cones, but the 
proportions of R G and B cones are differentproportions of R, G and B cones are different 

• They likely are present in the ratios 40:20:1

• So the achromatic(without color) channel 
produced by the cones is approximately 
proportional to 

2R + G + B/20.

• These spectral sensitivity functions are usually 
denoted by letters other than "R, G, B“.y , ,

• We use a vector function q( λ), with components 
q (λ)=[q (λ) q (λ) q (λ)]Tq (λ)=[qR(λ),qG(λ),qB(λ)]
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• The response in each color channel in the eye is 
proportional to the number of neurons firingproportional to the number of neurons firing.

• A laser light at wavelength λ would result in a certain 
number of neurons firing. An SPD (spectral powernumber of neurons firing. An SPD (spectral power 
distribution) is a combination of single‐frequency 
lights (like lasers), so we add up the cone responses 
for all wavelengths, weighted by the eye's relative 
response at that wavelength.
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Image Formation
• The above equations applies only when we view 
a self‐luminous object.

• In many situations, we image light reflected from 
a surface.

• Surfaces reflect different amounts of light at 
different wavelengths, and dark surfaces reflect g ,
less energy than light surfaces.
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The surface spectral reflectance from (1) orange 
k d (2) f d d bl jsneakers and (2) faded bluejeans .

The reflectance function is denoted S(λ). 83
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Image formation is thus:

i h f h ill i i h (λ) i i• Light from the illuminant with SPD E(λ) impinges 
on a surface, with surface spectral reflectance 
f i S(λ) i fl d d h i fil d bfunction S(λ), is reflected, and then is filtered by 
the eye's cone functions q (λ).

• Reflection is shown in Fig. below.

• The function C(λ) is called the color signal and ( ) g
consists of the product of E(λ), the p (), 
illuminant, times S(λ), the reflectance:, ( ),

84

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



85

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



86

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Camera SystemsCamera Systems
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Gamma Correction
h l h d f hl l h• The light emitted is in fact roughly proportional to the 
voltage raised to a power; this power is called gamma, 
with symbol γwith symbol γ.

a) Thus, if the file value in the red channel is R, the screen 
emits light proportional to Rγ with SPD equal to that ofemits light proportional to Rγ, with SPD equal to that of 
the red phosphor paint on the screen that is the target 
of the red channel electron gun. The value of gamma is g g
around 2.2.

b) It is customary to append a prime to signals that are 
gamma corrected by raising to the gamma‐power (1/γ) 
before transmission. Thus we arrive at linear signals:
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• Fig 4 6(a) shows light output with gamma‐
correction applied. We see that darker values 
are displayed too dark. This is also shown in Fig. 

( )4.7(a), which displays a linear ramp from left to 
right.

• Fig 4 6(b) the effect of pre‐correcting signals by 
applying the power law R1/γ; it is customary to 
normalize voltage to the range [0,1].
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Color‐Matching Functions
• Even without knowing the eye sensitivity curves a• Even without knowing the eye‐sensitivity curves, a 
technique evolved in psychology for matching a 
combination of basic R, G, and B lights to given shade.combination of basic R, G, and B lights to given shade.

• The particular set of three basic lights used in an 
experiment are called the set of color primaries.p p

• To match a given color, a subject is asked to separately 
adjust the brightness of the three primaries using a set j g p g
of controls until the resulting spot of light most closely 
matches the desired color.

• The basic situation is shown in Fig.

A device for carrying out such an experiment is called a

colorimeter.
92
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Color Monitor Specifications
• Color monitors are specified in part by the 
white point chromaticity that is desired if the 
RGB electron guns are all activated at their 
highest value (1.0, if we normalize to [0,1]).

• We want the monitor to display a specified 
white when R’=G’=B’=1.

• There are several monitor specifications in 
current use ( Table 4.1).( )
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• RGB Color Model for CRT Displays
Color Models in Images

1.We expect to be able to use bits per color channel for color 
that is accurate enough.

2.However, in fact we have to use about 12 bits per channel to 
avoid an aliasing effect in dark image areas —contour bands 
th t lt f tithat result from gamma correction.

3.For images produced from computer graphics, we store 
integers proportional to intensity in the frame buffer Sointegers proportional to intensity in the frame buffer. So 
should have a gamma correction LUT between the frame 
buffer and the CRT. 

4.If gamma correction is applied to floats before quantizing to 
integers, before storage in the  frame buffer, then in fact we 
can use only 8 bits per channel and still avoid contouring 
artifacts. 96
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Subtractive Color: CMY Color Model
• So far we have effectively been dealing only with• So far we have effectively been dealing, only with 
additive color. Namely, when two light beams impinge 
on a target, their colors add; when two phosphors on aon a target, their colors add; when two phosphors on a 
CRT screen are turned on, their colors add.

• But for ink deposited on paper, the opposite situation p p p , pp
holds: yellow ink subtracts blue from white 
illumination, but reflects red and green; it appears 
yellow.

• Instead of red, green, and blue primaries, we need 
primaries that amount to ‐red, ‐green, ‐blue. I.e., we 
need to subtract R, or G, or B.

Th b i l i i C (C)• These subtractive color primaries are Cyan (C), 
Magenta (M) and Yellow (Y )inks. 97
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Transformation from RGB to CMY
Si l t d l i t t if h t i k• Simplest model we can invent to specify what ink 
density to lay down on paper, to make a certain 
d i d RGB ldesired RGB color.

• Then the inverse transform is:
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color combinations that result from combining 
primary colors available in the two situationsprimary colors available in the two situations, 
additive color and subtractive color.
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Printer Gamuts
• Actual transmission curves overlap for the C M Y• Actual transmission curves overlap for the C, M, Y 
inks. This leads to "crosstalk“ between the color 
channels and difficulties in predicting colorschannels and difficulties in predicting colors 
achievable in printing.

Fi ( ) h t i l t i i f l "bl k• Fig (a) shows typical transmission for real "block 
dyes", and Fig.(b) shows the resulting color 

t f l i tgamut for a color printer.
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Color Models in Video
Video Color TransformsVideo Color Transforms
• Methods of dealing with color in digital video derive 
largely from older analog methods of coding color for TV. 
Luminance is separated from color information.

• For example, a matrix transform method called YIQ is used 
t t it TV i l i N th A i d Jto transmit TV signals in North America and Japan.

• This coding also makes its way into VHS video tape coding 
in these countries since video tape technologies also usein these countries since video tape technologies also use 
YIQ. 

• In Europe, video tape uses the PAL or SECAM codings, 
which are based on TV that uses a matrix transform called 
YUV.
Di i l id l i f ll d YCbC• Digital video mostly uses a matrix transform called YCbCr 
that is closely related to YUV.
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YUV Color Model
• YUV codes a luminance signal (for gamma corrected• YUV codes a luminance signal (for gamma‐corrected 
signals)  equal to Y’ in Eq. (4.20). the "luma".

• Chrominance refers to the difference between a color• Chrominance refers to the difference between a color 
and a reference white at the same luminance → use 
color differences U, V :,

• U = B’−Y’ V = R’−Y’  (4.27)

• From Eq (4 20) [Y’ =0 299∙R’+0 587∙G’+0 114∙B’] & eqFrom Eq. (4.20) [Y   0.299 R +0.587 G +0.114 B ] & eq 
(4.27)
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• For gray, R’ = G’ = B’ , the luminance Y’ equals to that 
gray since 0 299 + 0 587 + 0 114 = 1 0 And for a graygray, since 0.299 + 0.587 + 0.114 = 1.0. And for a gray 
("black & white") image the chrominance (U, V )is zero.

• In the actual implementation U and V are rescaled toIn the actual implementation U and V are rescaled to 
have a more convenient maximum and minimum.

• For dealing with composite video, it turns out to be g p ,
convenient to contain U, V within the range − 1/3to 
+4/3. So U and V are rescaled:

• U =0.492111 (B’− Y’)

• V =0.877283 ( R’− Y’)  ( 4.29) 

• The chrominance signal = the composite signal C:

• C = U∙cos(ωt)+V ∙sin(ωt)  (4.30)
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• Zero is not the minimum value for U, V. 

i i l f bl ( ) ll• U is approximately from blue (U> 0) to yellow 
(U< 0) in the RGB cube; V is approximately 
f d (V 0) (V 0)from red (V> 0) to cyan (V< 0).

• Fig. shows the decomposition of a color image 
into its Y’, U, V components. Since both U and 
V go negative, in fact the images displayed are 
shifted and rescaled.
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UNIT II
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Fundamental Concepts in
Video

• Types of Video SignalsTypes of Video Signals
– Component  Video

Composite Video– Composite Video

– S Video
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Component Video Signals
• Higher‐end video systems, such as studios make use of three 

separate video signals for the red, green, and blue image planes.  
This is referred as Component Video.This is referred as Component Video.

• Each color  channel is sent as a separate video signal.

a) Most computer systems use Component Video, with separate 
signals for R, G, and B signals.

b) For any color separation scheme, Component Video gives the 
best color reproduction since there is no "crosstalk" betweenbest color reproduction since there is no  crosstalk  between 
the three channels.

c) This is not the case for S‐Video or Composite Video. Component 
video, however, requires more bandwidth and good 
synchronization of the three components .
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Composite Video Signal
• In Composite video color ("chrominance") and intensity• In Composite video color ( chrominance ) and intensity 
("luminance") signals are mixed into a single carrier 
wave.

a) Chrominance is a composition of two color 
components (I and Q, or U and V). )

b) In NTSC TV, e.g., I and Q are combined into a chroma 
signal, and a color subcarrier is then employed to put 
the chroma signal at the high‐frequency end of the 
signal shared with the luminance signal.

c) The chrominance and luminance components can be 
separated at the receiver end and then the two color 
components can be further recoveredcomponents can be further recovered .
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d) When connecting to TVs or VCRs, Composite Video 
l i d id l i l i duses only one wire and video color signals are mixed, 

not sent separately.

The a dio and s nc signals are additions to this oneThe audio and sync signals are additions to this one 
signal.

• Since color and intensity are wrapped into the same 
signal some interference between the luminance andsignal, some interference between the luminance and 
chrominance signals is inevitable.
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S Video Signal
• S Video: as a compromise (Separated video or• S‐Video: as a compromise, (Separated video, or 
Super‐video, e.g., in S‐VHS) uses two wires, one 
for luminance and another for a compositefor luminance and another for a composite 
chrominance signal.

A lt th i l t lk b t th• As a result, there is less crosstalk between the 
color information and the crucial gray‐scale 
i f tiinformation.

• The reason for placing luminance into its own 
part of the signal is that black‐and‐white 
information is most crucial for visual perception.
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• In fact, humans are able to differentiate spatial 
resolution in gray scale images with a muchresolution in gray‐scale images with a much 
higher acuity than for the color part of color 
imagesimages.

• As a result, we can send less accurate color 
i f i h b f i iinformation than must be sent for intensity 
information —we can only see fairly large blobs 
f l i k d l lof color, so it makes sense to send less color 

detail.
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Analog Video
• An analog signal f(t) samples a time‐varying image.An analog signal f(t) samples a time varying image. 
So‐called "progressive" scanning traces through a 
complete picture (a frame) row‐wise for each time 
intervalinterval.

• In TV, and in some monitors and multimedia 
standards, another system, called "interlaced" , y ,
scanning is used:
a) The odd‐numbered lines are traced first, and then 
th b d li t d Thi lt ithe even‐numbered lines are traced. This results in 
"odd" and "even" fields — two fields make up one 
frame.
b) In fact, the odd lines (starting from 1) end up at 
the middle of a line at the end of the odd field, and 
the even scan starts at a half way pointthe even scan starts at a half‐way point.
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The jump from Q to R, etc. in Figure  is called the horizontal retrace, during 
which the electronic beam in the CRT is blanked. The jump from T to U or V 
to P is called the vertical retrace.
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• Because of interlacing the odd and even 
interlacing lines are displaced in time from eachinterlacing, lines are displaced in time from each 
other — generally not noticeable except when 
very fast action is taking place on screen whenvery fast action is taking place on screen, when 
blurring may occur.

• For example in the video in Fig the moving• For example in the video in Fig. the moving 
helicopter is blurred more than is the still 
backgroundbackground.
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• Since it is sometimes necessary to change the frame rate, 
resize, or even produce stills from an interlaced source 
video, various schemes are used to de‐interlace it.

a) The simplest de‐interlacing method consists of 
discarding one field and duplicating the scan lines of the 
other field. The information in one field is lost 
completely using this simple techniquecompletely using this simple technique.

b) Other more complicated methods that retain 
information from both fields are also possibleinformation from both fields are also possible.

• Analog video use a small voltage offset from zero to 
indicate “black" and another value such as zero toindicate  black , and another value such as zero to 
indicate the start of a line. 

• For example we could use a "blacker‐than‐black" zeroFor example, we could use a  blacker than black  zero 
signal to indicate the beginning of a line.
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NTSC Video
• NTSC (National Television System Committee) TV• NTSC (National Television System Committee) TV 
standard is mostly used in North America and Japan. It 
uses the familiar 4:3 aspect ratio (i.e., the ratio ofuses the familiar 4:3 aspect ratio (i.e., the ratio of 
picture width to its height) and uses 525 scan lines per 
frame at 30 frames per second (fps).

a) NTSC follows the interlaced scanning system, and each 
frame is divided into two fields, with 262.5 lines/field.

b) Thus the horizontal sweep frequency is 525×29.97 ≈ 15, 
734 lines/sec, so that each line is swept out in 1/15.734 
× 103 sec ≈ 63.6µsec.

c) Since the horizontal retrace takes 10.9 µsec, this leaves 
52 7 f h i li i l d i hi h i52.7 µsec for the active line signal during which image 
data is displayed.
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PAL Video
PAL ( Phase Alternating Line) is a TV standard widely used inPAL ( Phase Alternating Line) is a TV standard widely used in 
Western Europe, China, India, and many other parts of the world.

PAL uses 625 scan frame at 25 frames/second with a 4:3 aspect 
ratio and interlaced fields.

a) PAL uses the YUV color model. It uses an 8 MHz channel and 
allocates a bandwidth of 5 5 MHz to Y and 1 8 MHz each to U andallocates a bandwidth of 5.5 MHz to Y, and 1.8 MHz each to U and 
V. The color subcarrier frequency is fsc ≈ 4.43 MHz.

b) In order to improve picture quality, chroma signals have alternate 
signs (e.g., +U and ‐U) in successive scan lines, hence the name 
"Phase Alternating Line".

c) This facilitates the use of a (line rate) comb filter at the receiver —c) This facilitates the use of a (line rate) comb filter at the receiver 
the signals in consecutive lines are averaged so as to cancel the 
chroma signals (that always carry opposite signs) for separating Y 
d C d b i i hi h li Y i land C and obtaining high quality Y signals.
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SECAM Video
• SECAM stands for Syst `eme Electronique CouleurSECAM stands for Syst  eme Electronique Couleur 
Avec M´emoire, the third major broadcast TV 
standard.

• SECAM also uses 625 scan lines per frame, at 25 
frames per second, with a 4:3 aspect ratio and 
interlaced fields.

• SECAM and PAL are very similar. They differ slightly in 
their color coding scheme:

a) In SECAM, U and V signals are modulated using 
l b i 4 25 MH d 4 41 MHseparate color subcarriers at 4.25 MHz and 4.41 MHz 

respectively.
b) They are sent in alternate lines i e only one of the Ub) They are sent in alternate lines, i.e., only one of the U 
or V signals will be sent on each scan line.
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Digital Video
The advantages of digital representation for videoThe advantages of digital representation for video

are many. For example:

) Vid b d di i l d i ia) Video can be stored on digital devices or in memory, 
ready to be processed (noise removal, cut and paste, 
etc ) and integrated to various multimediaetc.), and integrated to various multimedia 
applications;

b) Di t i ibl hi h k lib) Direct access is possible, which makes nonlinear 
video editing achievable as a simple, rather than a 
complex task;complex, task;

c) Repeated recording does not degrade image quality;

d) f i d b l h ld) Ease of encryption and better tolerance to channel 
noise.
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Chroma Subsampling
• Since humans see color with much less spatial Since humans see color with much less spatial

resolution than they see black and white, it makes

"d i " h h i i lsense to "decimate" the chrominance signal.

Numbers are given stating how many pixel values, 
per four original pixels, are actually sent:

a) The chroma subsampling scheme "4:4:4"  ) p g
indicates that no chroma subsampling is used: 
each pixel's Y, Cb and Cr values are transmitted, p , ,
4 for each of Y, Cb, Cr.
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b) The scheme "4:2:2" indicates horizontal 
subsampling of the Cb, Cr signals by a factor of 2.subsampling of the Cb, Cr signals by a factor of 2. 
That is, of four pixels horizontally labelled as 0 to 
3, all four Ys are sent, and every two Cb's and3, all four Ys are sent, and every two Cb s and 
two Cr's are sent, as (Cb0, Y0)(Cr0, Y1)(Cb2, 
Y2)(Cr2, Y3)(Cb4, Y4), and so on ( or averaging isY2)(Cr2, Y3)(Cb4, Y4), and so on ( or averaging is 
used).

c) The scheme "4:1:1" subsamples horizontally by ac) The scheme  4:1:1  subsamples horizontally by a 
factor of 4.

d) The scheme "4 2 0" s bsamples in both thed) The scheme "4:2:0" subsamples in both the 
horizontal and vertical dimensions by a factor of 
2 Theoretically average chroma pixel is2. Theoretically average chroma pixel is 
positioned between the rows and columns
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Basics of Digital Audio
• What is Sound?What is Sound?

• Sound is a wave phenomenon like light, but is
macroscopic and involves molecules of air beingmacroscopic and involves molecules of air being
compressed and expanded under the action of
some physical devicesome physical device.

a) For example, a speaker in an audio system
ib b k d f h d dvibrates back and forth and produces a
longitudinal pressure wave that we perceive as

dsound.

b) Since sound is a pressure wave, it takes on
continuous values, as opposed to digitized
ones.
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• They have ordinary wave properties and 
behaviors, such as reflection (bouncing), 
refraction (change of angle when entering a 
medium with a different density) and 
diffraction (bending around an obstacle).

• If we wish to use a digital version of sound 
waves we must form digitized representations g p
of audio information.
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Digitization
• Digitization means conversion to a stream of• Digitization means conversion to a stream of 
numbers, and preferably these numbers should 
be integers for efficiencybe integers for efficiency.

An analog signal: continuous measurement of pressure wave.
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Sampling and Quantization
• The graph in Fig. has to be made digital in both time and 
amplitude. To digitize, the signal must be sampled in each 
dimension: in time, and amplitude.

a) Sampling means measuring the quantity we are 
interested in, usually at evenly‐spaced intervals.

b) The first kind of sampling, using measurements only at 
evenly spaced time intervals, is simply called, sampling 
The rate at which it is performed is called the samplingThe rate at which it is performed is called the sampling 
frequency (see Fig. (a)).

c) For audio typical sampling rates are from 8 kHz (8 000c) For audio, typical sampling rates are from 8 kHz (8,000 
samples per second) to 48 kHz. This range is determined 
by Nyquist theorem.y yq

d) Sampling in the amplitude or voltage dimension is called 
quantization. Fig. (b) shows this kind of sampling.
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Sampling and Quantization. 
(a): Sampling the analog signal in the time dimension. 
(b) Q i i i li h l i l i h(b): Quantization is sampling the analog signal in the 
amplitude dimension. 
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Nyquist Theorem
Th N i t th t t h f tl• The Nyquist theorem states how frequently we 
must sample in time to be able to recover the 
i i l doriginal sound.

Fig (a) shows a single sinusoid: 
it is a single, pure frequency 
( l l t i i t t(only electronic instruments can 
create such
sounds).)
If sampling rate just equals the 
actual frequency, Fig. (b) shows 
that a false signal is detected: itthat a false signal is detected: it 
is simply a constant, with zero 
frequency.
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• Now sample at 1.5 times the actual frequency, Fig. 
(c) shows that we obtain an incorrect (alias)(c) shows that we obtain an incorrect (alias) 
frequency that is lower than the correct one — it is 
half the correct one (the wavelength from peak 
wavelength, peak to peak, is double that of the 
actual signal).

• Thus for correct sampling we must use a sampling 
rate equal to at least twice the maximum frequency 
content in the signal This rate is called the Nyquistcontent in the signal. This rate is called the Nyquist 
rate.
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• Nyquist Theorem: If a signal is band‐limitedNyquist Theorem: If a signal is band limited, 
i.e., band there is a lower limit f1 and an 
upper limit f2 of frequency components in theupper limit f2 of frequency components in the 
signal, then the sampling rate should be at 
least 2(f2 − f1)least 2(f2   f1).
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Signal to Noise Ratio (SNR)
Th ti f th f th t i l• The ratio of the power of the correct signal 
and the noise is called the signal to noise ratio 
(SNR) f th lit f th i l(SNR) a measure of the quality of the signal —
signal.

• The SNR is usually measured in decibels (dB), 
where 1 dB is a tenth of a bel The SNR value in 
bel. value, units of dB, is defined in terms of 
base‐10 logarithms of squared voltages, as 
follows: 
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UNIT II
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Fundamental Concepts in
Video

• Types of Video SignalsTypes of Video Signals
– Component  Video

Composite Video– Composite Video

– S Video
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Component Video Signals
• Higher‐end video systems, such as studios make use of three 

separate video signals for the red, green, and blue image planes.  
This is referred as Component Video.This is referred as Component Video.

• Each color  channel is sent as a separate video signal.

a) Most computer systems use Component Video, with separate 
signals for R, G, and B signals.

b) For any color separation scheme, Component Video gives the 
best color reproduction since there is no "crosstalk" betweenbest color reproduction since there is no  crosstalk  between 
the three channels.

c) This is not the case for S‐Video or Composite Video. Component 
video, however, requires more bandwidth and good 
synchronization of the three components .
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Composite Video Signal
• In Composite video color ("chrominance") and intensity• In Composite video color ( chrominance ) and intensity 
("luminance") signals are mixed into a single carrier 
wave.

a) Chrominance is a composition of two color 
components (I and Q, or U and V). )

b) In NTSC TV, e.g., I and Q are combined into a chroma 
signal, and a color subcarrier is then employed to put 
the chroma signal at the high‐frequency end of the 
signal shared with the luminance signal.

c) The chrominance and luminance components can be 
separated at the receiver end and then the two color 
components can be further recoveredcomponents can be further recovered .
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d) When connecting to TVs or VCRs, Composite Video 
l i d id l i l i duses only one wire and video color signals are mixed, 

not sent separately.

The a dio and s nc signals are additions to this oneThe audio and sync signals are additions to this one 
signal.

• Since color and intensity are wrapped into the same 
signal some interference between the luminance andsignal, some interference between the luminance and 
chrominance signals is inevitable.
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S Video Signal
• S Video: as a compromise (Separated video or• S‐Video: as a compromise, (Separated video, or 
Super‐video, e.g., in S‐VHS) uses two wires, one 
for luminance and another for a compositefor luminance and another for a composite 
chrominance signal.

A lt th i l t lk b t th• As a result, there is less crosstalk between the 
color information and the crucial gray‐scale 
i f tiinformation.

• The reason for placing luminance into its own 
part of the signal is that black‐and‐white 
information is most crucial for visual perception.
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• In fact, humans are able to differentiate spatial 
resolution in gray scale images with a muchresolution in gray‐scale images with a much 
higher acuity than for the color part of color 
imagesimages.

• As a result, we can send less accurate color 
i f i h b f i iinformation than must be sent for intensity 
information —we can only see fairly large blobs 
f l i k d l lof color, so it makes sense to send less color 

detail.
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Analog Video
• An analog signal f(t) samples a time‐varying image.An analog signal f(t) samples a time varying image. 
So‐called "progressive" scanning traces through a 
complete picture (a frame) row‐wise for each time 
intervalinterval.

• In TV, and in some monitors and multimedia 
standards, another system, called "interlaced" , y ,
scanning is used:
a) The odd‐numbered lines are traced first, and then 
th b d li t d Thi lt ithe even‐numbered lines are traced. This results in 
"odd" and "even" fields — two fields make up one 
frame.
b) In fact, the odd lines (starting from 1) end up at 
the middle of a line at the end of the odd field, and 
the even scan starts at a half way pointthe even scan starts at a half‐way point.

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



The jump from Q to R, etc. in Figure  is called the horizontal retrace, during 
which the electronic beam in the CRT is blanked. The jump from T to U or V 
to P is called the vertical retrace.

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



• Because of interlacing the odd and even 
interlacing lines are displaced in time from eachinterlacing, lines are displaced in time from each 
other — generally not noticeable except when 
very fast action is taking place on screen whenvery fast action is taking place on screen, when 
blurring may occur.

• For example in the video in Fig the moving• For example in the video in Fig. the moving 
helicopter is blurred more than is the still 
backgroundbackground.
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• Since it is sometimes necessary to change the frame rate, 
resize, or even produce stills from an interlaced source 
video, various schemes are used to de‐interlace it.

a) The simplest de‐interlacing method consists of 
discarding one field and duplicating the scan lines of the 
other field. The information in one field is lost 
completely using this simple techniquecompletely using this simple technique.

b) Other more complicated methods that retain 
information from both fields are also possibleinformation from both fields are also possible.

• Analog video use a small voltage offset from zero to 
indicate “black" and another value such as zero toindicate  black , and another value such as zero to 
indicate the start of a line. 

• For example we could use a "blacker‐than‐black" zeroFor example, we could use a  blacker than black  zero 
signal to indicate the beginning of a line.
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NTSC Video
• NTSC (National Television System Committee) TV• NTSC (National Television System Committee) TV 
standard is mostly used in North America and Japan. It 
uses the familiar 4:3 aspect ratio (i.e., the ratio ofuses the familiar 4:3 aspect ratio (i.e., the ratio of 
picture width to its height) and uses 525 scan lines per 
frame at 30 frames per second (fps).

a) NTSC follows the interlaced scanning system, and each 
frame is divided into two fields, with 262.5 lines/field.

b) Thus the horizontal sweep frequency is 525×29.97 ≈ 15, 
734 lines/sec, so that each line is swept out in 1/15.734 
× 103 sec ≈ 63.6µsec.

c) Since the horizontal retrace takes 10.9 µsec, this leaves 
52 7 f h i li i l d i hi h i52.7 µsec for the active line signal during which image 
data is displayed.
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PAL Video
PAL ( Phase Alternating Line) is a TV standard widely used inPAL ( Phase Alternating Line) is a TV standard widely used in 
Western Europe, China, India, and many other parts of the world.

PAL uses 625 scan frame at 25 frames/second with a 4:3 aspect 
ratio and interlaced fields.

a) PAL uses the YUV color model. It uses an 8 MHz channel and 
allocates a bandwidth of 5 5 MHz to Y and 1 8 MHz each to U andallocates a bandwidth of 5.5 MHz to Y, and 1.8 MHz each to U and 
V. The color subcarrier frequency is fsc ≈ 4.43 MHz.

b) In order to improve picture quality, chroma signals have alternate 
signs (e.g., +U and ‐U) in successive scan lines, hence the name 
"Phase Alternating Line".

c) This facilitates the use of a (line rate) comb filter at the receiver —c) This facilitates the use of a (line rate) comb filter at the receiver 
the signals in consecutive lines are averaged so as to cancel the 
chroma signals (that always carry opposite signs) for separating Y 
d C d b i i hi h li Y i land C and obtaining high quality Y signals.
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SECAM Video
• SECAM stands for Syst `eme Electronique CouleurSECAM stands for Syst  eme Electronique Couleur 
Avec M´emoire, the third major broadcast TV 
standard.

• SECAM also uses 625 scan lines per frame, at 25 
frames per second, with a 4:3 aspect ratio and 
interlaced fields.

• SECAM and PAL are very similar. They differ slightly in 
their color coding scheme:

a) In SECAM, U and V signals are modulated using 
l b i 4 25 MH d 4 41 MHseparate color subcarriers at 4.25 MHz and 4.41 MHz 

respectively.
b) They are sent in alternate lines i e only one of the Ub) They are sent in alternate lines, i.e., only one of the U 
or V signals will be sent on each scan line.
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Digital Video
The advantages of digital representation for videoThe advantages of digital representation for video

are many. For example:

) Vid b d di i l d i ia) Video can be stored on digital devices or in memory, 
ready to be processed (noise removal, cut and paste, 
etc ) and integrated to various multimediaetc.), and integrated to various multimedia 
applications;

b) Di t i ibl hi h k lib) Direct access is possible, which makes nonlinear 
video editing achievable as a simple, rather than a 
complex task;complex, task;

c) Repeated recording does not degrade image quality;

d) f i d b l h ld) Ease of encryption and better tolerance to channel 
noise.
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Chroma Subsampling
• Since humans see color with much less spatial Since humans see color with much less spatial

resolution than they see black and white, it makes

"d i " h h i i lsense to "decimate" the chrominance signal.

Numbers are given stating how many pixel values, 
per four original pixels, are actually sent:

a) The chroma subsampling scheme "4:4:4"  ) p g
indicates that no chroma subsampling is used: 
each pixel's Y, Cb and Cr values are transmitted, p , ,
4 for each of Y, Cb, Cr.
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b) The scheme "4:2:2" indicates horizontal 
subsampling of the Cb, Cr signals by a factor of 2.subsampling of the Cb, Cr signals by a factor of 2. 
That is, of four pixels horizontally labelled as 0 to 
3, all four Ys are sent, and every two Cb's and3, all four Ys are sent, and every two Cb s and 
two Cr's are sent, as (Cb0, Y0)(Cr0, Y1)(Cb2, 
Y2)(Cr2, Y3)(Cb4, Y4), and so on ( or averaging isY2)(Cr2, Y3)(Cb4, Y4), and so on ( or averaging is 
used).

c) The scheme "4:1:1" subsamples horizontally by ac) The scheme  4:1:1  subsamples horizontally by a 
factor of 4.

d) The scheme "4 2 0" s bsamples in both thed) The scheme "4:2:0" subsamples in both the 
horizontal and vertical dimensions by a factor of 
2 Theoretically average chroma pixel is2. Theoretically average chroma pixel is 
positioned between the rows and columns
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Basics of Digital Audio
• What is Sound?What is Sound?

• Sound is a wave phenomenon like light, but is
macroscopic and involves molecules of air beingmacroscopic and involves molecules of air being
compressed and expanded under the action of
some physical devicesome physical device.

a) For example, a speaker in an audio system
ib b k d f h d dvibrates back and forth and produces a
longitudinal pressure wave that we perceive as

dsound.

b) Since sound is a pressure wave, it takes on
continuous values, as opposed to digitized
ones.
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• They have ordinary wave properties and 
behaviors, such as reflection (bouncing), 
refraction (change of angle when entering a 
medium with a different density) and 
diffraction (bending around an obstacle).

• If we wish to use a digital version of sound 
waves we must form digitized representations g p
of audio information.
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Digitization
• Digitization means conversion to a stream of• Digitization means conversion to a stream of 
numbers, and preferably these numbers should 
be integers for efficiencybe integers for efficiency.

An analog signal: continuous measurement of pressure wave.
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Sampling and Quantization
• The graph in Fig. has to be made digital in both time and 
amplitude. To digitize, the signal must be sampled in each 
dimension: in time, and amplitude.

a) Sampling means measuring the quantity we are 
interested in, usually at evenly‐spaced intervals.

b) The first kind of sampling, using measurements only at 
evenly spaced time intervals, is simply called, sampling 
The rate at which it is performed is called the samplingThe rate at which it is performed is called the sampling 
frequency (see Fig. (a)).

c) For audio typical sampling rates are from 8 kHz (8 000c) For audio, typical sampling rates are from 8 kHz (8,000 
samples per second) to 48 kHz. This range is determined 
by Nyquist theorem.y yq

d) Sampling in the amplitude or voltage dimension is called 
quantization. Fig. (b) shows this kind of sampling.
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Sampling and Quantization. 
(a): Sampling the analog signal in the time dimension. 
(b) Q i i i li h l i l i h(b): Quantization is sampling the analog signal in the 
amplitude dimension. 
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Nyquist Theorem
Th N i t th t t h f tl• The Nyquist theorem states how frequently we 
must sample in time to be able to recover the 
i i l doriginal sound.

Fig (a) shows a single sinusoid: 
it is a single, pure frequency 
( l l t i i t t(only electronic instruments can 
create such
sounds).)
If sampling rate just equals the 
actual frequency, Fig. (b) shows 
that a false signal is detected: itthat a false signal is detected: it 
is simply a constant, with zero 
frequency.
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• Now sample at 1.5 times the actual frequency, Fig. 
(c) shows that we obtain an incorrect (alias)(c) shows that we obtain an incorrect (alias) 
frequency that is lower than the correct one — it is 
half the correct one (the wavelength from peak 
wavelength, peak to peak, is double that of the 
actual signal).

• Thus for correct sampling we must use a sampling 
rate equal to at least twice the maximum frequency 
content in the signal This rate is called the Nyquistcontent in the signal. This rate is called the Nyquist 
rate.
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• Nyquist Theorem: If a signal is band‐limitedNyquist Theorem: If a signal is band limited, 
i.e., band there is a lower limit f1 and an 
upper limit f2 of frequency components in theupper limit f2 of frequency components in the 
signal, then the sampling rate should be at 
least 2(f2 − f1)least 2(f2   f1).
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Signal to Noise Ratio (SNR)
Th ti f th f th t i l• The ratio of the power of the correct signal 
and the noise is called the signal to noise ratio 
(SNR) f th lit f th i l(SNR) a measure of the quality of the signal —
signal.

• The SNR is usually measured in decibels (dB), 
where 1 dB is a tenth of a bel The SNR value in 
bel. value, units of dB, is defined in terms of 
base‐10 logarithms of squared voltages, as 
follows: 
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Unit III 
Action Script I

1
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ActionScript 2.0 Features

ActionScript 2.0 adds relatively little new runtime 
functionality to the language but radically 
improves object-oriented development in Flashimproves object oriented development in Flash 
by formalizing objected-oriented programming 
(OOP) syntax and methodology. 

ActionScript 2.0 provides a class keyword for 
creating classes and an extends keyword for g y
establishing inheritance. Those keywords were 
absent from ActionScript 1.0 

2
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The class statement, used to create formal classes. 

Key ActionScript 2.0 Features introduced are:
,

The extends keyword, used to establish inheritance. 
The interface statement, used to create Java-style , y
interfaces (i.e., abstract data types). 

Classes provide implementations for interfaces using the 
implements keyword ActionScript 1 0 did not supportimplements keyword. ActionScript 1.0 did not support 
interfaces. 

The official file extension for class files is .as. 
Formerly, classes could be defined in timeline code or 
in external .as files. 

Class files can be edited in Flash MX Professional 2004's

3

Class files can be edited in Flash MX Professional 2004 s 
script editor or in an external text editor. 
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Key ActionScript 2 0 Features introduced are:

Formal method-definition syntax, used to create instance

Key ActionScript 2.0 Features introduced are: 
(contd...)
Formal method definition syntax, used to create instance 
methods and class methods in a class body. In ActionScript 
1.0, methods were added to a class via the class 
constructor's prototype propertyconstructor s prototype property. 
Formal getter and setter method syntax, which replaces 
ActionScript 1.0's 
F l t d fi iti t d t t i tFormal property-definition syntax, used to create instance 
properties and class properties in a class body. In 
ActionScript 1.0, instance properties could be added in 

l i th l t t ' t t tseveral ways—via the class constructor's prototype property, 
in the constructor function, or on each object directly. 
The private and public keywords, used to prevent certain 

4

p p y p
methods and properties from being accessed outside of a 
class. 
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Key ActionScript 2 0 Features introduced are:Key ActionScript 2.0 Features introduced are: 
(contd...)

S i i f i bl i dStatic typing for variables, properties, parameters and return 
values used to declare the datatype for each item
Type casting, used to tell the compiler to treat an object as 
th h it i t f th d t t ithough it were an instance of another datatype, as is 
sometimes required when using static typing. 
Classpaths, used to define the location of one or more central 
class repositories This allo s classes to be re sed acrossclass repositories. This allows classes to be reused across 
projects and helps make source files easy to manage. 
Exception handling —including the throw and try/catch/finally
statements used to generate and respond to programstatements—used to generate and respond to program 
errors. 
Easy linking between movie clip symbols and ActionScript 2.0
classes via the symbol Linkage properties

5

classes via the symbol Linkage properties. 
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Features Introduced by Flash Player 7Features Introduced by Flash Player 7

I dditi t th A ti S i t 2 0 l h tIn addition to the ActionScript 2.0 language enhancements, 
Flash Player 7 introduces some important new classes and 
capabilities. They are:
N ti bilitiNew array-sorting capabilities
The ContextMenu and ContextMenuItem classes for 
customizing the Flash Player context menucustomizing the Flash Player context menu 
ID3 v2 tag support for loaded MP3 files
Mouse wheel support in text fields ( Windows only)
Improved MovieClip depth management methods
The MovieClipLoader class for loading movie clips and 
images

6

images
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Features Introduced by Flash Player 7 (Contd )Features Introduced by Flash Player 7 (Contd…)

The PrintJob class for printing with greater control than 
was previously possible
Support for images in text fields, including flowing text 
around imagesaround images
Improved text metrics (the ability to obtain more accurate 
measurements of the text in a text field than was possible 
in Flash Player 6)
Cascading stylesheet (CSS) support for text fields, allowing 
the text in a movie to be formatted with a standard CSSthe text in a movie to be formatted with a standard CSS 
stylesheet
Improved ActionScript runtime performance

7

p p p
Strict case sensitivity
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Object Oriented ActionScript
Procedural Programming & Object-Oriented Programming

Traditional programming consists of various instructions 
grouped into procedures. 
Procedures perform a specific task without any knowledge 
of or concern for the larger program.g p g
In a procedural-style Flash program, repeated tasks are 
stored in functions and data is stored in variables. 
The program runs by executing functions and changingThe program runs by executing functions and changing 
variable values, typically for the purpose of handling input 
and generating output.
Procedural programming is sensible for certainProcedural programming is sensible for certain 
applications; however, as applications become larger or 
more complex and the interactions between procedures
Th b h d t i t i d b d d

8

They can be hard to maintain, debug, and upgrade.

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Procedural Prog. & Object-Oriented Prog. (Contd…)
OOP is designed to make complex applications more 
manageable by breaking them down into self-contained, 
interacting modulesinteracting modules. 
OOP lets us translate abstract concepts and tangible real-
world things into corresponding parts of a program 
OOP adds a level of conceptual organization to a program. 
It groups related functions and variables together into separate 
classes each of which is a self-contained part of the programclasses , each of which is a self contained part of the program 
with its own responsibilities.
Classes are used to create individual objects that execute 
functions and set variables on one another producing thefunctions and set variables on one another, producing the 
program's behavior. 
Organizing the code into classes makes it easier to create a 

9

program that maps well to real-world problems with real-world 
components
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Key Object-Oriented Programming Concepts
An object is a self-contained software module that 
contains related functions (called its methods ) and 

y j g g p

( )
variables (called its properties). 
Individual objects are created from classes, which 
provide the blueprint for an object's methods and 
properties
A single class can be used to generate any number of 
objects, each with the same general structure 
T b ild bj t i t dTo build an object-oriented program:

Create one or more classes.
Make (i e instantiate) objects from those classes

10

Make (i.e., instantiate) objects from those classes.
Tell the objects what to do.
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Key Object-Oriented Prog. Concepts (Contd…)

We create, a 
program can use 
any of the classes

Class Syntax
class SpaceShip { 

bli d N bany of the classes 
built into the Flash 
Player. 

public var speed:Number; 
private var damage:Number; 
public function SpaceShip ( ) 

The built-in Sound
class to create 
Sound objects, and

{ 
speed = 100;
damage = 0; }Sound objects, and 

use setVolume() & 
loadSound() 
methods

damage  0; } 
public function fireMissile ( ):Void 
{  // Code that fires a missile goes here. } 

bli f ti th t ( ) V idmethods. public function thrust ( ):Void 
{  // Code that propels the ship goes here. } 
} 

11
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Key Object-Oriented Prog. Concepts (Contd…)

Objects are created (instantiated) with the new 

y j g p ( )
Object Creation

j ( )
operator, as in:
new ClassName( )
where ClassName is the name of the class from 
which the object will be created.
Ex. new SpaceShip( ) 
var ship:SpaceShip = new SpaceShip( );
Each object is a discrete data value that can be 
stored in a variable, an array element, or even a 

t f th bj t
12

property of another object. 
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Key Object-Oriented Prog. Concepts (Contd…)
Object UsageObject Usage

An object's methods provide its capabilities (i.e., behaviors)
—things like "fire missile," "move," and "scroll down." g , ,
Methods and properties that are defined as public by an 
object's class can be accessed from anywhere in a program. 
By contrast, methods and properties defined as private canBy contrast, methods and properties defined as private can 
be used only within the source code of the class or its 
subclasses. 
To invoke a method, we use the dot operator (i.e., a period) , p ( , p )
and the function call operator (i.e., parentheses). 
For example: ship.fireMissile( );

To set a property, we use the dot operator and an equals 
sign. For example: ship.speed = 120;

13

To retrieve a property's value, we use the dot operator on its 
own. For example: trace(ship.speed);

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Key Object-Oriented Prog Concepts (Contd )Key Object-Oriented Prog. Concepts (Contd…)
Encapsulation

Objects are said to encapsulate their property values 
and method source code from the rest of the program. 
An object's private properties and the internal codeAn object s private properties and the internal code 
used in its methods (including public methods)
It allows different programmers to work on different 
l i d d tlclasses independently 

A class can be tested thoroughly before being deployed. 
The same test code can be used to reverify the class's 
operation even if the code within the class is refactored 

14
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Key Object-Oriented Prog Concepts (Contd )Key Object-Oriented Prog. Concepts (Contd…)
Datatypes

Each class in an object-oriented program can be thought 
of as defining a unique kind of data, which is formally 
represented as a datatype in the program.represented as a datatype in the program.
Date datatype supports various properties and 
methods uniquely associated with dates
D t t d t i li it h t bDatatypes are used to impose limits on what can be 
stored in a variable, used as a parameter, or passed as 
a return value.
Example:  public var speed:Number

15
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Key Object-Oriented Prog Concepts (Contd )Key Object-Oriented Prog. Concepts (Contd…)
Inheritance

Allow one class to adopt the method and property definitions ofAllow one class to adopt the method and property definitions of 
another
Many classes can reuse the features of a single class
F l ifi C B t d Pl l ldFor example, specific Car, Boat, and Plane classes could reuse 
the features of a generic Vehicle class, thus reducing 
redundancy in the application
A class that inherits properties and methods from another 
class is called a subclass. 
The class from which a subclass inherits properties andThe class from which a subclass inherits properties and 
methods is called the subclass's superclass. 
Naturally, a subclass can define its own properties and 
methods in addition to those it inherits from its superclass

16

methods in addition to those it inherits from its superclass.
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Key Object-Oriented Prog Concepts (Contd )Key Object-Oriented Prog. Concepts (Contd…)
Packages

we can create packages to contain groups of classes. Awe can create packages to contain groups of classes. A 
package lets us organize classes into logical groups and 
prevents naming conflicts between classes.
COMPILATIONCOMPILATION
When an OOP application is exported as a Flash movie (i.e., a 
.swf file), each class is compiled; that is, the compiler attempts 
t t h l f d t b t dto convert each class from source code to bytecode—
instructions that the Flash Player can understand and execute. 
If a class contains errors, compilation fails and the Flash 
compiler displays the errors in the Output panel in the Flash 
authoring tool.
Even if the movie compiles successfully, errors may still occur

17

Even if the movie compiles successfully, errors may still occur 
while a program is running; these are called runtime errors 
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Key Object-Oriented Prog Concepts (Contd )Key Object-Oriented Prog. Concepts (Contd…)
Starting an Objected-Oriented Application

Create one or more classes in .as files.
Create a .fla file.
On frame 1 of the .fla file, add code that creates 
an object of a class.
Optionally invoke a method on the object to 
start the application.
Export a .swf file from the .fla file.
Load the .swf file into the Flash Player.

18
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HOW TO APPLY OOPHOW  TO APPLY OOP

Flash supports both procedural and object-oriented 
programming and allows you to combine both approachesprogramming and allows you to combine both approaches 
in a single Flash movie.
The fundamental organizing structure of a Flash document 
( fl fil ) i th ti li hi h t i(a .fla file) is the timeline , which contains one or more 
frames. 
Each frame defines the content that is displayed on the p y
graphical canvas called the Stage. 
In the Flash Player, frames are displayed one at a time in a 
linear sequence producing an animated effect—exactly likelinear sequence, producing an animated effect exactly like 
the frames in a filmstrip.
Timeline-based project containing predetermined animated 
sequences

19
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Consider using OOP when creating:Consider using OOP when creating:
Traditional desktop-style applications with few transitions 
and standardized user interfaces
Applications that include server-side logic
Functionality that is reused across multiple projects
C tComponents
Games
Highly customized user interfaces that include complexHighly customized user interfaces that include complex 
visual transitions

20
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C id i d l i h tiConsider using procedural programming when creating:
Animations with small scripts that control flow or basic 
interactivityinteractivity
Simple applications such as a one-page product order 
form or a newsletter subscription form
Highly customized user interfaces that include complex 
visual transitions

21
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Introduction : Datatypes and Type Checking
ActionScript 2.0 defines a wide variety of datatypes. p y yp
Some datatypes are native to the language itself (e.g., 
String, Number, and Boolean). 
Others are included in the Flash Player and are available 
throughout all Flash movies (e.g., Color, Date, and 
TextField).TextField). 
Still other datatypes are defined by components that can be 
added individually to Flash movies (e.g., List, RadioButton, 

d S llP )and ScrollPane).
ActionScript 2.0 belongs to a datatype, whether built-in or 
programmer-defined.programmer defined.  
Ex. MovieClip class getTime( ), gotoAndPlay( ).

22
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Introduction: Datatypes and Type Checking (Contd )

var today;

Introduction: Datatypes and Type Checking (Contd..)

today = new Date( ).getDay( );  
// Sunday is 0, Monday is 1, ... Friday is 5.
if (t d 5) {if (today == 5) {
trace("Looking forward to the weekend!");

}}
To help us recognize and isolate datatype-related problems 
in our code, we use ActionScript 2.0's type checking 
capabilities.
ActionScript 2.0 requires that you formally declare the 
datatype of every variable property parameter anddatatype of every variable, property, parameter, and 
return value that you want checked.  

23
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Introduction: Datatypes and Type Checking (Contd )
To declare the datatype of a variable or property, we use this 
general form referred to as post colon syntax:

Introduction: Datatypes and Type Checking (Contd..)

general form, referred to as post-colon syntax:
var variableOrPropertyName:datatype
var count:Number;var count:Number;

ActionScript 2.0 performs type checking on every variable, 
property, parameter, and return value that has a declared 
d t tdatatype. 

var today; 
today = new Date( ) getDay( );today = new Date( ).getDay( );

The preceding code simply stores the return value of getDay( )
into today. Because the return value of getDay( ) is a number, 
today stores a number, not a string.

24
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Introduction: Datatypes and Type Checking (Contd..)
Fixing a datatype mismatch error
var today:Number
t d D t ( ) tD ( )today = new Date( ).getDay( );
// Sunday is 0, Monday is 1, ... Friday is 5.
if (today == 5) {if (today == 5) {
trace("Looking forward to the weekend!"); }

One way to derive a string from a numbery g
var today:Number = new Date( ).getDay( );
var dayNames:Array = ["Sunday", "Monday", "Tuesday", 

"Wednesday", “Thursday", “Friday", "Saturday"];
var todayName:String = dayNames[today];
currentDay txt text = todayName;currentDay_txt.text = todayName;
trace(todayName);

25
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Introduction: Datatypes and Type Checking (Contd )

ActionScript 2.0's approach to datatyping is called static 

Introduction: Datatypes and Type Checking (Contd..)

typing . 
In static typing, the datatype of variables and other data 
containers is fixed at compile time so that the compiler cancontainers is fixed at compile time so that the compiler can 
guarantee the validity of every method called and property 
accessed in the program. 
The converse of static typing is dynamic typing , in which 
each value is associated with a datatype at runtime, not at 
compile timecompile time. 
With dynamic typing, data containers such as variables can 
change datatypes at runtime because type information is 
associated with each value, not with each data container

26
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Why Static Typing?Why Static Typing?
If a type mismatch error occurs, a program may be 
able to run, but it wouldn't likely be able to performable to run, but it wouldn t likely be able to perform 
one or more requested operations. 
Such errors often lead to program failures. Some p g
compilers merely warn of type mismatch errors but still 
allow compilation to continue. 
However, ActionScript 2.0's static typing facilities 
prevent the movie from compiling if type mismatch 

i terrors exist. 
Type checking guarantees the validity of most 
operations at compile time catching potential errorsoperations at compile time, catching potential errors 
before they ever occur. 

27
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Why Static Typing (Contd..)
Type checking reduces the amount of manualType checking reduces the amount of manual 
data-verification code you need in your methods 
Dynamic type checking is often less restrictive andDynamic type checking is often less restrictive and 
can make code easier to change than statically 
typed code. yp
The main advantage of static type checking is that 
it can check all your code at compile time, whereas 
dynamic type checking requires that you execute 
the code in order to verify it. 

28
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Type SyntaxType Syntax
ActionScript 2.0's compile-time type checking can 
be applied to:be applied to:

A variable
A propertyA property
A function or method parameter
A function or method return value

To enable type checking for any of the preceding 
items, we declare the item's type using post-colon 
syntax
Declaring an item's type tells the compiler what kind 
of data it should contain.
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Type Syntax (Contd…)Type Syntax (Contd…)
The compiler can warn us of two possible error 
conditions:conditions:
If a value of an incompatible type is stored in a 
variable, passed as a function parameter orvariable, passed as a function parameter, or 
returned by a function, the compiler generates a 
type mismatch error.
If a nonexistent property or method is accessed 
through a typed variable, function parameter, or 
function return value, the compiler generates an 
error explaining that the property or method cannot 
be foundbe found

30
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Declaring Variable and Property Datatypesg p y yp
To declare the datatype of a variable or property, use the 
following syntax:

var variableOrPropertyName:datatype;
Ex1.Create a variable that can contain only data compatible with 

the Date datatype.
var currentTime:Date;

EX2 St D t i t i th tTi i blEX2. Store a Date instance in the currentTime variable.
currentTime = new Date( );

We could also reduce the preceding two lines to a single step:
var currentTime:Date = new Date( );var currentTime:Date = new Date( );

31
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Declaring Variable and Property Datatypes (Contd..)g p y yp ( )

Once a variable's datatype is declared, it is fixed until the 
variable is destroyed.y
Type checking is intended to help you write better code more 
quickly var currentTime:Date;

var currentTime:Number;
In ActionScript 2.0, the preceding code does not change the 
d t t f tTi t N bdatatype of currentTime to Number. 
The second line is simply ignored and later attempts to assign a 
numeric value to currentTime will generate errors.numeric value to currentTime will generate errors.
Instead of redeclaring a variable's datatype, you should use 
two separate variables when you need to store values of two 
diff t d t tdifferent datatypes. 
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Declaring Method Parameter and Return Value 
Datatypes

Declaring the datatype of method or function parameters andDeclaring the datatype of method or function parameters and 
return values:
function methodName (param1Name:param1Type,   (p p yp

param2Name:param2Type):returnType {
// ...

}
Functions that return no value should specify a returnType of 
Void. 
Storing the return value of a function or method in a variable 
or property of an incompatible type causes a type mismatchor property of an incompatible type causes a type mismatch 
error. 
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Post-Colon SyntaxPost Colon Syntax

Ex: function sum (x:Number, y:Number):Number {
return x+y;
}
var result:SClass = sum(10, 20);

ActionScript 2.0 uses the following, slightly unusual syntax 
f t d l tifor type declarations:

variableOrPropertyName:datatype = value;
B t t J d C++By contrast, Java and C++ use:

datatype variableName = value;

34
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C tibl TCompatible Types

A variable of one type can store only a value of aA variable of one type can store only a value of a 
compatible type. 
A type, X, is compatible with another type, Y, if X is of type yp , , p yp , , yp
Y, or if X is any subtype of Y.

Ex: class Ball and a subclass Basketball. 
var ball1:Ball = new Basketball( );  // Legal!

Every Ball instance does not necessarily have the 
properties and methods of the Basketball class (Compileproperties and methods of the Basketball class. (Compile 
time type mismatch error)

var ball2:Basketball = new Ball( );  // Illegal!

35
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Handling Any Datatypeg y yp
In ActionScript 2.0, we can make a variable, property, parameter
or return value accept data of any type by specifying Object as 
th d t tthe datatype. 
We declare the datatype of container as Object. We can 
subsequently store an instance of any class in it without error.q y y

var container:Object = new Date( ); // No error.
container = new Color( );           // No error.

This technique works because the Object class is the superclass
of all ActionScript classes, so all types are compatible with the 
Object typeObject type 
trace(container.toString( )); // Execute toString( ) normally.
container.blahblah( );// Invoke nonexistent method. No error.( );
toString( )method excutes, because it is supported by all objects.

36
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Compatibility with null and undefined
AS 2.0 program store null or undefined in a variable as an 
indication of an absence of data or an uninitialized variable. 

t t M i Cli ll // L lvar target:MovieClip = null;  // Legal.
function square (x:Number):Number {
return x*x;return x x;

}
square(null);  // Legal.q ( ); g
function square (x:Number):Number {
if (x == 0) {
return null;  // Legal.

}
t *return x*x;

} 37
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Compatibility with null and undefined (Contd..)p y ( )
This flexibility allows us to use the null type to indicate an 
empty value for any data container. 

tf T tF t T tF t( ll ll ll t )var tf:TextFormat = new TextFormat(null, null, null, true);
Compatibility with undefined also allows ActionScript to assign 
undefined to parameters, variables, and properties that haveundefined to parameters, variables, and properties that have 
never been assigned a value. 

public function displayMsg (msg:String,  
sentBy:String):Void {

// Use "Anonymous" if a name was not supplied.
if ( tB d fi d) {if (sentBy == undefined) {
sentBy = "Anonymous";   }

// Display the message in a text field// Display the message in a text field.
output.text = sentBy + ": " + msg;

} 38
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Built-in Dynamic Classesu t y a c C asses
To allow new properties and methods to be added to a class's 
instances without generating a compile-time errorinstances without generating a compile time error
We can define your own dynamic classes, but some built-in 
classes are dynamic by default.
Array, ContextMenu, ContextMenuItem, TextField, 
Function,FunctionArguments ,LoadVars, MovieClip, Object
When we attempt to access a nonexistent property or methodWhen we attempt to access a nonexistent property or method 
on an object of one of the preceding dynamic classes, the 
ActionScript 2.0 compiler does not generate an error. 

var dataSender:LoadVars = new LoadVars( );
dataSender.firstName = "Rebecca";  // No error
(Type mismatch)  var list:Array = new Date( );

39

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



CastingCasting
Casting is used to tell the compiler the type of an object 
when the compiler can’t determine the object types onwhen the compiler can t determine the object types on 
it’s own.
Syntax : Type(object);y yp ( j );

Where object is the object to cast and Type is the 
datatype.

E.g.: var obj:Object =new Object();
var tf:TextField = new TextField(obj);

C ti d ’t t bj t f l tCasting doesn’t convert an object from one class to 
another. It tells the compiler to treat the object or datum as 
though it were an instance of the specified datatype. It usethough it were an instance of the specified datatype. It use 
a cast to tell the compiler the type of an object .

40
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Casting (Contd…)Casting (Contd…)
var ship: EnemyShip =theEnemyManager.getClosestShip();

if(ship instanceof Bomber){
Bomber(ship).bomb (); // cast to bomber
}}
else if(ship instanceof Cruiser){
C i ( hi ) d ()Cruiser(ship).evade(); 
}
else if(ship instanceof Fighter){else if(ship instanceof Fighter){
Fighter(ship).callReinforcements();
Fighter(ship) fire();Fighter(ship).fire();
}

41
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Casting TerminologyCasting Terminology
Casting an object to one of its supertypes is known as 

tupcast.
E.g.: var bball:BasketBall =new BasketBall();
var genericball:Ball new Ball(bball); // upcast bballvar genericball:Ball =new Ball(bball); // upcast bball

Casting an object one of its subtypes is known as downcast.
E g : var b:Ball =new Ball();E.g.: var b:Ball new Ball();
var bball:BasketBall =new BasketBall(b); // downcast of b

An upcast is safe and downcast is unsafe. Because p
supertype is not necessarily be  an instance of its subtype.
E.g.: var ball1: Ball =new BasketBall(); // without casting

1 ( ()) // fvar ball1 : Ball=Ball(new BasketBall()); // safe upcast

42
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Casting does not affect method or 
Property selection
If a superclass define a method or property i.e., overhidden 
by a subclass, casting does not affect which version of a 
method or property to be used.
When an overridden method is invoked on an instance of aWhen an overridden method is invoked on an instance of a 
subclass, the subclass version of the method is always used, 
even if the subclass instance is cast to the superclass.
Casting versus Conversion
Casting merely tells the compiler to treat an object as 
th h it i t f th ifi d d t tthough it were an instance of the specified datatype. 
Conversion does change an object from one datatype to 
another.another.

43

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Casting to String Number Boolean Date & ArrayCasting to String, Number, Boolean, Date & Array
The String(), Number(), Boolean() and Array() functions 
perform data conversionsperform data conversions
The Date() function returns the current time as a string
Syntax: Number(value) // to convert a value to a numbery ( )
E.g: Var obj:Object=[1,2,3];
function output (msg:Object):Void {

// use typeof to detect the datatype of primitive values
if ( typeof msg==“string”) { trace(msg); }

// I t f t h k th l f bj t// use Instanceof to check the class of an object
if (msg instanceof Array){

trace(msg join(“\n”)); }}trace(msg.join( \n )); }}
Output panel display 1 2 3 (line by line)

44
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Defining Classesg
A class is a template for the creation of objects. Classes are 
the building blocks of an object-oriented program. 
class declaration:

class ClassIdentifier { }
where ClassIdentifier is the name of the class 

E.x.: class Box {}
A l d fi iti t id i t l l i t t fil th tA class definition must reside in an external plain text file that 
has the extension .as. 
Everything between the curly braces in a class declarationEverything between the curly braces in a class declaration 
constitutes the class definition block, or more informally, the 
class body. 
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The class body can contain:The class body can contain:
A constructor function (used to initialize instances 
of the class)of the class)
Variable definitions (the class's properties)
F ti d fi iti (th l ' th d )Function definitions (the class's methods)
#include directives, which can include files 
containing properties methods and constructorcontaining properties, methods, and constructor 
functions
Metadata tags used in Flash MX 2004 componentsMetadata tags used in Flash MX 2004 components
Comments
Class definitions cannot be nested and no otherClass definitions cannot be nested, and no other 
code can appear in a class definition. 
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Examplep
class Box {
private static var inited:Boolean = false;
public function Box ( ) {
if (!inited) {      init( );    }  }

private static function init( ):Void {
if (100 == (10*10)) {
trace("One hundred is ten times ten"); }trace( One hundred is ten times ten );    }

inited = true;  }}

The term instance member refers to either an instance 
property or an instance method, while the term class 

b f i h l l h dmember refers to either a class property or a class method 
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Constructor Functions (Take 1)Constructor Functions (Take 1)
When we create an object, we also want to initialize it.
Ex Box Class: Initialize the new instance's sizeEx. Box Class: Initialize the new instance s size     

(i.e., set its width and height properties)
Represent the new instance on screenRepresent the new instance on screen                        

(i.e., call the draw( ) method)
To initialize and perform setup tasks for new objects ofTo initialize and perform setup tasks for new objects of 
a class, we create a constructor function. 
The constructor function executes automatically y
each time an instance is created. 
Typically, when we create a class, we immediately y y y
add an empty constructor function to it. 
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Constructor Functions (Take 1) (Contd…)Constructor Functions (Take 1) (Contd…)
class Box {

p blic f nction Bo ( ) {public function Box ( ) {
}}

Now that our Box class has an empty constructor 
function, we'll give the class some properties and 
methods. 
When no constructor is provided for a class, 
A ti S i t dd t t ti ll tActionScript adds an empty one automatically at 
compile time.
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Propertiesope t es
Classes use properties to store information. But some 
information relates to a class as a whole 

Class properties
Named data containers associated with a class

Instance properties
Named data containers associated with objects (i.e., 
instances of the class)instances of the class)
Together, class properties and instance properties are 
sometimes referred to as fixed propertiesp p
In ActionScript and ECMAScript 4, instance properties are 
sometimes called instance variables, and class properties 
are sometimes called class variablesare sometimes called class variables
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Instance properties:Instance properties:
Are stored individually on each instance of a class
Are accessed through instances onlyAre accessed through instances only
Can be set uniquely for one instance without affecting any 
other instances
An instance property is declared once for the entire class, 
but each instance of the class maintains its own value. 
Th l t iThe general syntax is:                  

var propertyName:datatype = value;
If d t t i itt d t h ki i f d thIf datatype is omitted, no type checking is performed on the 
property 
var propertyName = value;var propertyName  value;  

// No type checking for this property.
51
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Access control modifiers in AS, Java, & C++
Access control 

modifier ActionScript Java C++

public No access 
restrictions

No access 
restrictions

No access 
restrictions

Class and subclassprivate Class and subclass 
access only Class access only Class access only

Access allowed 
no modifier Same as public from class's own 

package only
Same as private

Access allowed

protected Not supported

Access allowed 
from class's own 
package and 
class's subclasses

Access allowed 
from class and p pp class's subclasses 

in any other 
package

subclass only
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Compile-Time Constant Expressions
An instance property definition can assign a default value to a 
property, provided that the value is a so-called compile-time 
constant expressionconstant expression. 
A compile-time constant expression is an expression whose 
value can be fully determined at compile time. They include :
null, numeric, boolean, and string constants
The following operators (used only on numbers, booleans, 
t i ll d fi d) ( d bi ) ( dstrings, null, or undefined): + (unary and binary), - (unary and 

binary), ~, !, *, /, %, <<, >>, >>>, <, >, <=, >=, instanceof, ==, 
!=, ===, !==, &, ^, |, &&, ^^, ||, and ?: (ternary operator)| || ( y p )
Array literals, Object literals, and instances of the following 
classes: Array, Boolean, Number, Object, and String
R f t th il ti t t iReferences to other compile-time constant expressions
Example: 4 + 5, “Hello" + " world", null, [4, 5], new Array(4, 5)53
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MethodsMethods
Methods are functions that determine the behavior of a class.
If a parameter's type is omitted in the method definition, no 
type checking is performed for that parameter . 
If returnType is omitted, no type checking is performed for 
the return valuethe return value. 
A function with return type Void may not return a value.
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Referring to the Current Object with the 
Keyword this
Using this helps our class to remain encapsulated, 
eliminating the need for the outside world to worry about the 
object's internal requirements. 
The this reference to the current object allows an object toThe this reference to the current object allows an object to 
refer to itself without the need for an additional parameter, and 
is therefore much cleaner.

Passing the current object to a method
The this keyword is most often used when passing the current 
object to another object's methodobject to another object s method
function someMethod ( ):Void {
// Pass this as a parameter to a completely separate object// Pass this as a parameter to a completely separate object  
someOtherObject.someOtherMethod(this);  }
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Garbage collection
Wh bj t i t li t f th bj t itWhen an object registers as a listener of another object, it 
should always unregister itself before it is deleted.
This sloppiness can cause serious waste of memory. A classThis sloppiness can cause serious waste of memory. A class 
should always provide a means of cleaning up stray object 
references before an object is deleted. 
A i S i d ' b ll bj (i f hActionScript doesn't garbage-collect an object (i.e., free up the 
memory used by an object) until no more references to it 
remain. Cleanup is done in a custom die( ) or destroy( ) p ( ) y( )
method that must be invoked before an object is deleted. 
By providing a die( ) method, a class guarantees a safe means 
of deleting its instancesof deleting its instances. .
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Nesting Functions in Methods
ActionScript supports nested functions, which means 
that functions can be declared within methods or even 
within other functionswithin other functions. 
A local variable, a nested function is accessible only to 
its parent function (the function in which it is declared). 
Code outside the parent function cannot execute the 
nested function:

57

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Accessing the current object from a 
function nested in a method

A function nested in a method does not have direct accessA function nested in a method does not have direct access 
to the current object (the object on which the method 
was called). 
The current object by storing a reference to it in a local 
variable.
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Getter and Setter Methods
To bridge the gap between the convenience of property 
assignment and the safety of accessor methods, ActionScript 
2.0 supports "getter" and "setter" methods.2.0 supports getter  and setter  methods. 
Getter and setter methods are accessor-like methods, 
defined within a class body, that are invoked automatically 
when a developer tries to get or set a property directly.

function get propertyName ( ):returnType { 
// getter method statements }// getter method   statements    }

function set propertyName (newValue:type):Void { 
// setter method statements }// setter method  statements   }

Getter and setter methods cannot be declared with the 
private attribute. 
When invoked getter and setter methods does not require use 
of the function call operator, ( ). 59

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



A class with getter and setter methods
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Extra or Missing ArgumentsExtra or Missing Arguments
Extra arguments are not (indeed cannot be) type checked 
automatically by the compiler. y y p

public function setWidth (w:Number):Void {
// If w is undefined, then quit
if (w == undefined) {

return;         }
idth }width = w; }

The arguments object also stores:
A reference to the method currently executingA reference to the method currently executing 
(arguments.callee)
A reference to the method that called the method 
currently executing, if any (arguments.caller)
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4.5 Constructor Functions (Take 2)( )
A constructor function is the metaphoric womb of a class; it 
isn't responsible for creating new instances, but it can be 
used to initialize each new instanceused to initialize each new instance.
When we create a new instance of a class using the new 
operator, the class's constructor function runs. Within the 
constructor function, we can customize the newly created 
instance by setting its properties or invoking its methods. 

class Box {class Box {
public function Box ( ) {
} }}  }

To define a constructor function, we use the function 
statement within a class body. 
The constructor function's name must match its class's 
name exactly (case sensitivity matters). 62
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Constructor Functions (Take 2) (Contd…)( ) ( )
The constructor function's definition must not specify a 
return type (not even Void).
The constructor function must not return a value
The constructor function's definition must not include the 
static attribute but it can be public or privatestatic attribute, but it can be public or private.
ActionScript automatically provides a default constructor
that takes no parameters and performs no initialization on p p
new instances of the class. 
A constructor function's parameter values are passed to it via 
th t t bj t ti tithe new operator at object-creation time

.
new SomeClass(value1 value2 valuen);new SomeClass(value1, value2,...valuen);
new Box(2, 3);
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Simulating Multiple Constructor Functions
Unlike Java, ActionScript does not support multiple constructor 
functions for a single class (overloaded constructors in Java).

64

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



overloaded constructors
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Completing the Box Class
First decide whether the display elements will render themselves or be 
rendered by a central class. 
Decide how often the displayed elements should be updated—either p y p
when some event occurs (such as a mouseclick) or repeatedly (as fast 
as frames are displayed in the Flash Player).
Decide on the rendering technique. Each visual element in a Flash movie g q
must be displayed in a movie clip. 
Decide on a screen refresh strategy. 
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A Box class complete with drawing routines
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A Box class complete with drawing routines (Contd..)
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Authoring An ActionScript 2.0 Class
Class Authoring Quick Start

To create an ActionScript 2.0 class, follow these general p , g
steps: 
Create a new text file with the .as extension using any 
l i t t dit Fl h MX P f i l 2004' b ilt iplain text editor or Flash MX Professional 2004's built-in 

editor. 
The .as file's name must match the class name exactlyThe .as file s name must match the class name exactly 
(case sensitivity matters).
Add the class definition to the .as file. 
class NameOfClass {

// Class body goes here   
}}
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To use an ActionScript 2.0 class in a Flash 
movie, Steps: 

1. Create a .fla file with any name, and place it in the same 
folder as the .as file from Step 1 in the preceding procedure.

2. Optionally specify the class's export frame for the .fla file via 
File Publish Settings Flash ActionScript Version SettingsFile Publish Settings Flash ActionScript Version Settings 
Export Frame for Classes. This determines when the class 
loads and when it becomes available in the movie. The export 
f i ll f f i 'frame is usually set to some frame after your movie's 
preloader.

3 Use the class as desired throughout the fla file but after the3. Use the class as desired throughout the .fla file, but after the 
export frame specified in Step 2 (if any).

4. Export a .swf file using one of the following: File Publish, 
Control Test Movie, or File Export Export Movie.

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Designing the ImageViewer Class
With our ImageViewer class's name  we have a list of 
functionality that could be required of the ImageViewer class:

Load an image
Display an image
Crop an image to a particular rectangular "view region"
Display a border around the image
Display image load progressDisplay image load progress
Reposition the view region
Resize the view regionResize the view region
Pan (reposition) the image within the view region
Zoom (resize) the image within the view region
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ImageViewer Implementation (Take 1)ImageViewer Implementation (Take 1)
To create the ImageViewer.as file using Flash MX 
Professional 2004 follow these steps:Professional 2004, follow these steps:
Choose File New.
In the New Document dialog box, on the General tab, for the g
document Type, choose ActionScript File.
Click OK. The script editor launches with an empty file.
Ch Fil S AChoose File Save As.
In the Save As dialog box, specify ImageViewer.as as the 
filename (using upper- and lowercase as shown) and save thefilename (using upper and lowercase as shown) and save the 
file in the imageviewer folder you created.
Notice that the class name, ImageViewer, and the filename, 
ImageViewer.as, must match exactly (apart from the .as file 
extension).
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The ImageViewer class with constructor and 
( ) ( )loadImage( ) method, properties (Take 1)
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Using ImageViewer in a Movie
Find a (nonprogressive format) JPEG image on your system. 
Name the JPEG image picture.jpg and place it in the same 
folder as the ImageViewer as file you created earlierfolder as the ImageViewer.as file you created earlier.
Next we'll create a Flash document (.fla file) from which we'll 
publish a Flash movie (.swf file) containing an instance of our 
ImageViewer class. 
For now, we'll place the .fla file, .as file, .swf file, and .jpg file 
all in the same folder making it easy for each file to accessall in the same folder, making it easy for each file to access 
the other files.
Create the Flash document that uses the ImageViewer class. g
Follow these steps:

In the Flash authoring tool, choose File -> New.
I th N D t di l b th G l t b f thIn the New Document dialog box, on the General tab, for the 
document Type, choose Flash Document, then click OK.
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Using ImageViewer in a Movie (Contd…)
Use File -> Save As to save the Flash document as 
imageViewer.fla in the same folder as the ImageViewer.as file. 
In imageViewer.fla's main timeline, rename Layer 1 to scripts
Follow these steps to instantiate ImageViewer on frame 1 of 
imageViewer fla's main timeline:imageViewer.fla s main timeline:

Use Window -> Development Panels ->Actions (F9) to open 
the Actions panel.
Select frame 1 in imageViewer.fla's main timeline.
Into the Actions panel, enter the following code:

var viewer:ImageViewer = new ImageViewer(this, 1);
viewer.loadImage("picture.jpg");
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Using ImageViewer in a Movie (Contd )Using ImageViewer in a Movie (Contd…)
Let's export our imageViewer.swf file and test it in Flash's Test 
Movie mode as follows:Movie mode, as follows:

Choose Control -> Test Movie. The .swf file should play, 
and your image should load and appear.y g pp
When you're finished marveling at your work, choose File -
> Close to return to the imageViewer.fla file.

T h i Vi fl ' t tti t tTo change imageViewer.fla's export settings to support 
playback in Flash Player 6, follow these steps:

Choose File -> Publish SettingsChoose File > Publish Settings.
On the Flash tab of the Publish Settings dialog box, select 
Flash Player 6 as the Version option.
Click OK.
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Preloading the ImageViewer Classg g
Let's change our imageViewer.fla file so that the classes it 
uses aren't loaded until frame 10:
Choose File -> Publish Settings.
In the Publish Settings dialog box, on the Flash tab, next to 
the ActionScript Version click Settingsthe ActionScript Version, click Settings.
In the ActionScript Settings dialog box, for Export Frame for 
Classes, enter 10.
Click OK to confirm the ActionScript Settings.
Click OK to confirm the Publish Settings.
Now let's add a very basic preloader to our imageViewer.fla 
file so load progress is reported while the ImageViewer class 
loads. When loading is complete, we'll advance the playhead g p , p y
to frame 15 where we'll instantiate ImageViewer (as we 
previously did on frame 1).
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Preloading the ImageViewer Class (Contd..)
First, we'll make the timeline 15 frames long, as follows:

In the main timeline of imageViewer.fla, select frame 15 of the scripts 
layer.y
Choose Insert -> Timeline ->Keyframe (F6).

Next, we'll add a labels layer with two frame labels, loading and main. The 
labels designate the application's loading state and startup pointlabels designate the application s loading state and startup point, 
respectively.
Choose Insert ->Timeline ->Layer.
Double click the new layer's name and change it to labelsDouble-click the new layer s name and change it to labels.
At frames 4 and 15 of the labels layer, add a new keyframe (using Insert -
>Timeline ->Keyframe).
With f 4 f th l b l l l t d i th P ti l dWith frame 4 of the labels layer selected, in the Properties panel, under 
Frame, change <Frame Label> to loading.
With frame 15 of the labels layer selected, in the Properties panel, under 
F h F L b l t iFrame, change <Frame Label> to main.
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Now add the preloader script to the scripts layer:p p p y
At frame 5 of the scripts layer, add a new keyframe (using 
Insert ->timeline ->Keyframe).
With frame 5 of the scripts layer selected, enter the following 
code into the Actions panel:

if ( framesloaded == totalframes) {if (_framesloaded == _totalframes) {
gotoAndStop("main");} 
else {  gotoAndPlay("loading");   }{ g y( g ); }

Next, we'll move the code that creates our ImageViewer
instance from frame 1 to frame 15 of the scripts layer:
Select frame 1 of the scripts layer.
In the Actions panel, cut (delete using Ctrl-X or Cmd-X) the 
following code from frame:following code from frame:
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var viewer:ImageViewer = new ImageViewer(this, 1);
viewer.loadImage("picture.jpg");

With frame 15 of the scripts layer selected, paste (using Ctrl-
V ) the code o deleted in Step 2 into the Actions panelV ) the code you deleted in Step 2 into the Actions panel.
Finally, we'll add a loading message that displays while the 
ImageViewer class loads:g
With frame 1 of the scripts layer selected, enter the following 
code into the Actions panel:

this.createTextField("loadmsg_txt", 0, 200, 200, 0, 0);
loadmsg_txt.autoSize = true;
loadmsg txt text = "Loading Please wait ";loadmsg_txt.text = "Loading...Please wait.";

With frame 15 of the scripts layer selected, enter the 
following code at the end of the Actions panelg p

loadmsg_txt.removeTextField( );
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ImageViewer Implementation (Take 2)
The third and fourth requirements: cropping the image and 
giving it a border. We must apply a mask to it, which hides 

t d f th i f iunwanted areas of the image from view. 
We'll add parameters to the ImageViewer constructor to 
specify the size of the mask and the position of the croppedspecify the size of the mask and the position of the cropped 
image.
To create border, we'll create a movie clip, then draw a square 

tli i itoutline in it. 
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Splitting out the work into separate methods 
has the following benefits:
It makes the code more intelligible.
It simplifies the testing process (testing each 
method individually is easier than testing a large 
block of code that performs many operations).
It allows assets to be created and re-created 
i d d tl ( th b d iindependently (e.g., the border on an image can 
change without reloading the image).
It allo s asset creation operations to be modifiedIt allows asset-creation operations to be modified 
or overridden independently (e.g., a new border-
creation routine can be coded without disturbingcreation routine can be coded without disturbing 
other code).
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Table The ImageViewer class's new 
i t th d th t t i liinstance methods that create movie clips

Method name Method descriptionMethod name Method description

buildViewer( )
Invokes individual methods to create the container, 
image, mask, and border clips

createMainContainer( ) Creates the container_mc clip

createImageClip( ) Creates the image_mc clip

createImageClipMask( ) Creates the mask_mc clip

createBorder( ) Creates the border_mc clip

•A reference to the target clip to which container_mc should be 
attached
•A list of depths indicating the visual stacking order of the container, g g
image, mask, and border clips
•The style (line weight and color) of the border around the image
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Table The ImageViewer class's instance 
and class properties

Property name Type Property description

container_mc Instance
A reference to the main container clip, which contains all movie 
clips used by each ImageViewer instance

target mc Instance
A reference to the clip that will contain the container_mc

target_mc Instance
clip, as specified by the ImageViewer constructor

containerDepth Instance
The depth on which container_mc is created in target_mc, 
as specified by the ImageViewer constructor

imageDepth Class The depth on which image_mc is created in container_mc

maskDepth Class The depth on which mask_mc is created in container_mc

borderDepth Class The depth on which border_mc is created in container_mc

borderThickness Instance The thickness, in pixels, of the border around the image_mc clip

h l f h b d d h lborderColor Instance The integer RGB color of the border around the image_mc clip
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The ImageViewer class, take 2
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The ImageViewer class, take 2g ,
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The ImageViewer class, take 2g
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The ImageViewer class, take 2

•Now that our ImageViewer class can crop an image and add a border to it. 
•When we used the first version of the ImageViewer class we placed the•When we used the first version of the ImageViewer class, we placed the 
following code on frame 15 of imageViewer.fla:
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Unit III 
Action Script I

1
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ActionScript 2.0 Features

ActionScript 2.0 adds relatively little new runtime 
functionality to the language but radically 
improves object-oriented development in Flashimproves object oriented development in Flash 
by formalizing objected-oriented programming 
(OOP) syntax and methodology. 

ActionScript 2.0 provides a class keyword for 
creating classes and an extends keyword for g y
establishing inheritance. Those keywords were 
absent from ActionScript 1.0 

2
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The class statement, used to create formal classes. 

Key ActionScript 2.0 Features introduced are:
,

The extends keyword, used to establish inheritance. 
The interface statement, used to create Java-style , y
interfaces (i.e., abstract data types). 

Classes provide implementations for interfaces using the 
implements keyword ActionScript 1 0 did not supportimplements keyword. ActionScript 1.0 did not support 
interfaces. 

The official file extension for class files is .as. 
Formerly, classes could be defined in timeline code or 
in external .as files. 

Class files can be edited in Flash MX Professional 2004's

3

Class files can be edited in Flash MX Professional 2004 s 
script editor or in an external text editor. 
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Key ActionScript 2 0 Features introduced are:

Formal method-definition syntax, used to create instance

Key ActionScript 2.0 Features introduced are: 
(contd...)
Formal method definition syntax, used to create instance 
methods and class methods in a class body. In ActionScript 
1.0, methods were added to a class via the class 
constructor's prototype propertyconstructor s prototype property. 
Formal getter and setter method syntax, which replaces 
ActionScript 1.0's 
F l t d fi iti t d t t i tFormal property-definition syntax, used to create instance 
properties and class properties in a class body. In 
ActionScript 1.0, instance properties could be added in 

l i th l t t ' t t tseveral ways—via the class constructor's prototype property, 
in the constructor function, or on each object directly. 
The private and public keywords, used to prevent certain 

4

p p y p
methods and properties from being accessed outside of a 
class. 
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Key ActionScript 2 0 Features introduced are:Key ActionScript 2.0 Features introduced are: 
(contd...)

S i i f i bl i dStatic typing for variables, properties, parameters and return 
values used to declare the datatype for each item
Type casting, used to tell the compiler to treat an object as 
th h it i t f th d t t ithough it were an instance of another datatype, as is 
sometimes required when using static typing. 
Classpaths, used to define the location of one or more central 
class repositories This allo s classes to be re sed acrossclass repositories. This allows classes to be reused across 
projects and helps make source files easy to manage. 
Exception handling —including the throw and try/catch/finally
statements used to generate and respond to programstatements—used to generate and respond to program 
errors. 
Easy linking between movie clip symbols and ActionScript 2.0
classes via the symbol Linkage properties

5

classes via the symbol Linkage properties. 
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Features Introduced by Flash Player 7Features Introduced by Flash Player 7

I dditi t th A ti S i t 2 0 l h tIn addition to the ActionScript 2.0 language enhancements, 
Flash Player 7 introduces some important new classes and 
capabilities. They are:
N ti bilitiNew array-sorting capabilities
The ContextMenu and ContextMenuItem classes for 
customizing the Flash Player context menucustomizing the Flash Player context menu 
ID3 v2 tag support for loaded MP3 files
Mouse wheel support in text fields ( Windows only)
Improved MovieClip depth management methods
The MovieClipLoader class for loading movie clips and 
images

6
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Features Introduced by Flash Player 7 (Contd )Features Introduced by Flash Player 7 (Contd…)

The PrintJob class for printing with greater control than 
was previously possible
Support for images in text fields, including flowing text 
around imagesaround images
Improved text metrics (the ability to obtain more accurate 
measurements of the text in a text field than was possible 
in Flash Player 6)
Cascading stylesheet (CSS) support for text fields, allowing 
the text in a movie to be formatted with a standard CSSthe text in a movie to be formatted with a standard CSS 
stylesheet
Improved ActionScript runtime performance

7

p p p
Strict case sensitivity
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Object Oriented ActionScript
Procedural Programming & Object-Oriented Programming

Traditional programming consists of various instructions 
grouped into procedures. 
Procedures perform a specific task without any knowledge 
of or concern for the larger program.g p g
In a procedural-style Flash program, repeated tasks are 
stored in functions and data is stored in variables. 
The program runs by executing functions and changingThe program runs by executing functions and changing 
variable values, typically for the purpose of handling input 
and generating output.
Procedural programming is sensible for certainProcedural programming is sensible for certain 
applications; however, as applications become larger or 
more complex and the interactions between procedures
Th b h d t i t i d b d d

8

They can be hard to maintain, debug, and upgrade.
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Procedural Prog. & Object-Oriented Prog. (Contd…)
OOP is designed to make complex applications more 
manageable by breaking them down into self-contained, 
interacting modulesinteracting modules. 
OOP lets us translate abstract concepts and tangible real-
world things into corresponding parts of a program 
OOP adds a level of conceptual organization to a program. 
It groups related functions and variables together into separate 
classes each of which is a self-contained part of the programclasses , each of which is a self contained part of the program 
with its own responsibilities.
Classes are used to create individual objects that execute 
functions and set variables on one another producing thefunctions and set variables on one another, producing the 
program's behavior. 
Organizing the code into classes makes it easier to create a 

9

program that maps well to real-world problems with real-world 
components
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Key Object-Oriented Programming Concepts
An object is a self-contained software module that 
contains related functions (called its methods ) and 

y j g g p

( )
variables (called its properties). 
Individual objects are created from classes, which 
provide the blueprint for an object's methods and 
properties
A single class can be used to generate any number of 
objects, each with the same general structure 
T b ild bj t i t dTo build an object-oriented program:

Create one or more classes.
Make (i e instantiate) objects from those classes

10

Make (i.e., instantiate) objects from those classes.
Tell the objects what to do.
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Key Object-Oriented Prog. Concepts (Contd…)

We create, a 
program can use 
any of the classes

Class Syntax
class SpaceShip { 

bli d N bany of the classes 
built into the Flash 
Player. 

public var speed:Number; 
private var damage:Number; 
public function SpaceShip ( ) 

The built-in Sound
class to create 
Sound objects, and

{ 
speed = 100;
damage = 0; }Sound objects, and 

use setVolume() & 
loadSound() 
methods

damage  0; } 
public function fireMissile ( ):Void 
{  // Code that fires a missile goes here. } 

bli f ti th t ( ) V idmethods. public function thrust ( ):Void 
{  // Code that propels the ship goes here. } 
} 

11
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Key Object-Oriented Prog. Concepts (Contd…)

Objects are created (instantiated) with the new 

y j g p ( )
Object Creation

j ( )
operator, as in:
new ClassName( )
where ClassName is the name of the class from 
which the object will be created.
Ex. new SpaceShip( ) 
var ship:SpaceShip = new SpaceShip( );
Each object is a discrete data value that can be 
stored in a variable, an array element, or even a 

t f th bj t
12

property of another object. 
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Key Object-Oriented Prog. Concepts (Contd…)
Object UsageObject Usage

An object's methods provide its capabilities (i.e., behaviors)
—things like "fire missile," "move," and "scroll down." g , ,
Methods and properties that are defined as public by an 
object's class can be accessed from anywhere in a program. 
By contrast, methods and properties defined as private canBy contrast, methods and properties defined as private can 
be used only within the source code of the class or its 
subclasses. 
To invoke a method, we use the dot operator (i.e., a period) , p ( , p )
and the function call operator (i.e., parentheses). 
For example: ship.fireMissile( );

To set a property, we use the dot operator and an equals 
sign. For example: ship.speed = 120;

13

To retrieve a property's value, we use the dot operator on its 
own. For example: trace(ship.speed);
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Key Object-Oriented Prog Concepts (Contd )Key Object-Oriented Prog. Concepts (Contd…)
Encapsulation

Objects are said to encapsulate their property values 
and method source code from the rest of the program. 
An object's private properties and the internal codeAn object s private properties and the internal code 
used in its methods (including public methods)
It allows different programmers to work on different 
l i d d tlclasses independently 

A class can be tested thoroughly before being deployed. 
The same test code can be used to reverify the class's 
operation even if the code within the class is refactored 

14
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Key Object-Oriented Prog Concepts (Contd )Key Object-Oriented Prog. Concepts (Contd…)
Datatypes

Each class in an object-oriented program can be thought 
of as defining a unique kind of data, which is formally 
represented as a datatype in the program.represented as a datatype in the program.
Date datatype supports various properties and 
methods uniquely associated with dates
D t t d t i li it h t bDatatypes are used to impose limits on what can be 
stored in a variable, used as a parameter, or passed as 
a return value.
Example:  public var speed:Number

15
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Key Object-Oriented Prog Concepts (Contd )Key Object-Oriented Prog. Concepts (Contd…)
Inheritance

Allow one class to adopt the method and property definitions ofAllow one class to adopt the method and property definitions of 
another
Many classes can reuse the features of a single class
F l ifi C B t d Pl l ldFor example, specific Car, Boat, and Plane classes could reuse 
the features of a generic Vehicle class, thus reducing 
redundancy in the application
A class that inherits properties and methods from another 
class is called a subclass. 
The class from which a subclass inherits properties andThe class from which a subclass inherits properties and 
methods is called the subclass's superclass. 
Naturally, a subclass can define its own properties and 
methods in addition to those it inherits from its superclass

16

methods in addition to those it inherits from its superclass.
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Key Object-Oriented Prog Concepts (Contd )Key Object-Oriented Prog. Concepts (Contd…)
Packages

we can create packages to contain groups of classes. Awe can create packages to contain groups of classes. A 
package lets us organize classes into logical groups and 
prevents naming conflicts between classes.
COMPILATIONCOMPILATION
When an OOP application is exported as a Flash movie (i.e., a 
.swf file), each class is compiled; that is, the compiler attempts 
t t h l f d t b t dto convert each class from source code to bytecode—
instructions that the Flash Player can understand and execute. 
If a class contains errors, compilation fails and the Flash 
compiler displays the errors in the Output panel in the Flash 
authoring tool.
Even if the movie compiles successfully, errors may still occur

17

Even if the movie compiles successfully, errors may still occur 
while a program is running; these are called runtime errors 
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Key Object-Oriented Prog Concepts (Contd )Key Object-Oriented Prog. Concepts (Contd…)
Starting an Objected-Oriented Application

Create one or more classes in .as files.
Create a .fla file.
On frame 1 of the .fla file, add code that creates 
an object of a class.
Optionally invoke a method on the object to 
start the application.
Export a .swf file from the .fla file.
Load the .swf file into the Flash Player.

18
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HOW TO APPLY OOPHOW  TO APPLY OOP

Flash supports both procedural and object-oriented 
programming and allows you to combine both approachesprogramming and allows you to combine both approaches 
in a single Flash movie.
The fundamental organizing structure of a Flash document 
( fl fil ) i th ti li hi h t i(a .fla file) is the timeline , which contains one or more 
frames. 
Each frame defines the content that is displayed on the p y
graphical canvas called the Stage. 
In the Flash Player, frames are displayed one at a time in a 
linear sequence producing an animated effect—exactly likelinear sequence, producing an animated effect exactly like 
the frames in a filmstrip.
Timeline-based project containing predetermined animated 
sequences

19
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Consider using OOP when creating:Consider using OOP when creating:
Traditional desktop-style applications with few transitions 
and standardized user interfaces
Applications that include server-side logic
Functionality that is reused across multiple projects
C tComponents
Games
Highly customized user interfaces that include complexHighly customized user interfaces that include complex 
visual transitions

20
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C id i d l i h tiConsider using procedural programming when creating:
Animations with small scripts that control flow or basic 
interactivityinteractivity
Simple applications such as a one-page product order 
form or a newsletter subscription form
Highly customized user interfaces that include complex 
visual transitions

21
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Introduction : Datatypes and Type Checking
ActionScript 2.0 defines a wide variety of datatypes. p y yp
Some datatypes are native to the language itself (e.g., 
String, Number, and Boolean). 
Others are included in the Flash Player and are available 
throughout all Flash movies (e.g., Color, Date, and 
TextField).TextField). 
Still other datatypes are defined by components that can be 
added individually to Flash movies (e.g., List, RadioButton, 

d S llP )and ScrollPane).
ActionScript 2.0 belongs to a datatype, whether built-in or 
programmer-defined.programmer defined.  
Ex. MovieClip class getTime( ), gotoAndPlay( ).

22
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Introduction: Datatypes and Type Checking (Contd )

var today;

Introduction: Datatypes and Type Checking (Contd..)

today = new Date( ).getDay( );  
// Sunday is 0, Monday is 1, ... Friday is 5.
if (t d 5) {if (today == 5) {
trace("Looking forward to the weekend!");

}}
To help us recognize and isolate datatype-related problems 
in our code, we use ActionScript 2.0's type checking 
capabilities.
ActionScript 2.0 requires that you formally declare the 
datatype of every variable property parameter anddatatype of every variable, property, parameter, and 
return value that you want checked.  

23
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Introduction: Datatypes and Type Checking (Contd )
To declare the datatype of a variable or property, we use this 
general form referred to as post colon syntax:

Introduction: Datatypes and Type Checking (Contd..)

general form, referred to as post-colon syntax:
var variableOrPropertyName:datatype
var count:Number;var count:Number;

ActionScript 2.0 performs type checking on every variable, 
property, parameter, and return value that has a declared 
d t tdatatype. 

var today; 
today = new Date( ) getDay( );today = new Date( ).getDay( );

The preceding code simply stores the return value of getDay( )
into today. Because the return value of getDay( ) is a number, 
today stores a number, not a string.

24
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Introduction: Datatypes and Type Checking (Contd..)
Fixing a datatype mismatch error
var today:Number
t d D t ( ) tD ( )today = new Date( ).getDay( );
// Sunday is 0, Monday is 1, ... Friday is 5.
if (today == 5) {if (today == 5) {
trace("Looking forward to the weekend!"); }

One way to derive a string from a numbery g
var today:Number = new Date( ).getDay( );
var dayNames:Array = ["Sunday", "Monday", "Tuesday", 

"Wednesday", “Thursday", “Friday", "Saturday"];
var todayName:String = dayNames[today];
currentDay txt text = todayName;currentDay_txt.text = todayName;
trace(todayName);

25
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Introduction: Datatypes and Type Checking (Contd )

ActionScript 2.0's approach to datatyping is called static 

Introduction: Datatypes and Type Checking (Contd..)

typing . 
In static typing, the datatype of variables and other data 
containers is fixed at compile time so that the compiler cancontainers is fixed at compile time so that the compiler can 
guarantee the validity of every method called and property 
accessed in the program. 
The converse of static typing is dynamic typing , in which 
each value is associated with a datatype at runtime, not at 
compile timecompile time. 
With dynamic typing, data containers such as variables can 
change datatypes at runtime because type information is 
associated with each value, not with each data container

26
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Why Static Typing?Why Static Typing?
If a type mismatch error occurs, a program may be 
able to run, but it wouldn't likely be able to performable to run, but it wouldn t likely be able to perform 
one or more requested operations. 
Such errors often lead to program failures. Some p g
compilers merely warn of type mismatch errors but still 
allow compilation to continue. 
However, ActionScript 2.0's static typing facilities 
prevent the movie from compiling if type mismatch 

i terrors exist. 
Type checking guarantees the validity of most 
operations at compile time catching potential errorsoperations at compile time, catching potential errors 
before they ever occur. 

27
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Why Static Typing (Contd..)
Type checking reduces the amount of manualType checking reduces the amount of manual 
data-verification code you need in your methods 
Dynamic type checking is often less restrictive andDynamic type checking is often less restrictive and 
can make code easier to change than statically 
typed code. yp
The main advantage of static type checking is that 
it can check all your code at compile time, whereas 
dynamic type checking requires that you execute 
the code in order to verify it. 

28
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Type SyntaxType Syntax
ActionScript 2.0's compile-time type checking can 
be applied to:be applied to:

A variable
A propertyA property
A function or method parameter
A function or method return value

To enable type checking for any of the preceding 
items, we declare the item's type using post-colon 
syntax
Declaring an item's type tells the compiler what kind 
of data it should contain.

29
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Type Syntax (Contd…)Type Syntax (Contd…)
The compiler can warn us of two possible error 
conditions:conditions:
If a value of an incompatible type is stored in a 
variable, passed as a function parameter orvariable, passed as a function parameter, or 
returned by a function, the compiler generates a 
type mismatch error.
If a nonexistent property or method is accessed 
through a typed variable, function parameter, or 
function return value, the compiler generates an 
error explaining that the property or method cannot 
be foundbe found

30
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Declaring Variable and Property Datatypesg p y yp
To declare the datatype of a variable or property, use the 
following syntax:

var variableOrPropertyName:datatype;
Ex1.Create a variable that can contain only data compatible with 

the Date datatype.
var currentTime:Date;

EX2 St D t i t i th tTi i blEX2. Store a Date instance in the currentTime variable.
currentTime = new Date( );

We could also reduce the preceding two lines to a single step:
var currentTime:Date = new Date( );var currentTime:Date = new Date( );

31
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Declaring Variable and Property Datatypes (Contd..)g p y yp ( )

Once a variable's datatype is declared, it is fixed until the 
variable is destroyed.y
Type checking is intended to help you write better code more 
quickly var currentTime:Date;

var currentTime:Number;
In ActionScript 2.0, the preceding code does not change the 
d t t f tTi t N bdatatype of currentTime to Number. 
The second line is simply ignored and later attempts to assign a 
numeric value to currentTime will generate errors.numeric value to currentTime will generate errors.
Instead of redeclaring a variable's datatype, you should use 
two separate variables when you need to store values of two 
diff t d t tdifferent datatypes. 

32
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Declaring Method Parameter and Return Value 
Datatypes

Declaring the datatype of method or function parameters andDeclaring the datatype of method or function parameters and 
return values:
function methodName (param1Name:param1Type,   (p p yp

param2Name:param2Type):returnType {
// ...

}
Functions that return no value should specify a returnType of 
Void. 
Storing the return value of a function or method in a variable 
or property of an incompatible type causes a type mismatchor property of an incompatible type causes a type mismatch 
error. 

33
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Post-Colon SyntaxPost Colon Syntax

Ex: function sum (x:Number, y:Number):Number {
return x+y;
}
var result:SClass = sum(10, 20);

ActionScript 2.0 uses the following, slightly unusual syntax 
f t d l tifor type declarations:

variableOrPropertyName:datatype = value;
B t t J d C++By contrast, Java and C++ use:

datatype variableName = value;

34
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C tibl TCompatible Types

A variable of one type can store only a value of aA variable of one type can store only a value of a 
compatible type. 
A type, X, is compatible with another type, Y, if X is of type yp , , p yp , , yp
Y, or if X is any subtype of Y.

Ex: class Ball and a subclass Basketball. 
var ball1:Ball = new Basketball( );  // Legal!

Every Ball instance does not necessarily have the 
properties and methods of the Basketball class (Compileproperties and methods of the Basketball class. (Compile 
time type mismatch error)

var ball2:Basketball = new Ball( );  // Illegal!

35
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Handling Any Datatypeg y yp
In ActionScript 2.0, we can make a variable, property, parameter
or return value accept data of any type by specifying Object as 
th d t tthe datatype. 
We declare the datatype of container as Object. We can 
subsequently store an instance of any class in it without error.q y y

var container:Object = new Date( ); // No error.
container = new Color( );           // No error.

This technique works because the Object class is the superclass
of all ActionScript classes, so all types are compatible with the 
Object typeObject type 
trace(container.toString( )); // Execute toString( ) normally.
container.blahblah( );// Invoke nonexistent method. No error.( );
toString( )method excutes, because it is supported by all objects.

36
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Compatibility with null and undefined
AS 2.0 program store null or undefined in a variable as an 
indication of an absence of data or an uninitialized variable. 

t t M i Cli ll // L lvar target:MovieClip = null;  // Legal.
function square (x:Number):Number {
return x*x;return x x;

}
square(null);  // Legal.q ( ); g
function square (x:Number):Number {
if (x == 0) {
return null;  // Legal.

}
t *return x*x;

} 37
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Compatibility with null and undefined (Contd..)p y ( )
This flexibility allows us to use the null type to indicate an 
empty value for any data container. 

tf T tF t T tF t( ll ll ll t )var tf:TextFormat = new TextFormat(null, null, null, true);
Compatibility with undefined also allows ActionScript to assign 
undefined to parameters, variables, and properties that haveundefined to parameters, variables, and properties that have 
never been assigned a value. 

public function displayMsg (msg:String,  
sentBy:String):Void {

// Use "Anonymous" if a name was not supplied.
if ( tB d fi d) {if (sentBy == undefined) {
sentBy = "Anonymous";   }

// Display the message in a text field// Display the message in a text field.
output.text = sentBy + ": " + msg;

} 38
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Built-in Dynamic Classesu t y a c C asses
To allow new properties and methods to be added to a class's 
instances without generating a compile-time errorinstances without generating a compile time error
We can define your own dynamic classes, but some built-in 
classes are dynamic by default.
Array, ContextMenu, ContextMenuItem, TextField, 
Function,FunctionArguments ,LoadVars, MovieClip, Object
When we attempt to access a nonexistent property or methodWhen we attempt to access a nonexistent property or method 
on an object of one of the preceding dynamic classes, the 
ActionScript 2.0 compiler does not generate an error. 

var dataSender:LoadVars = new LoadVars( );
dataSender.firstName = "Rebecca";  // No error
(Type mismatch)  var list:Array = new Date( );

39
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CastingCasting
Casting is used to tell the compiler the type of an object 
when the compiler can’t determine the object types onwhen the compiler can t determine the object types on 
it’s own.
Syntax : Type(object);y yp ( j );

Where object is the object to cast and Type is the 
datatype.

E.g.: var obj:Object =new Object();
var tf:TextField = new TextField(obj);

C ti d ’t t bj t f l tCasting doesn’t convert an object from one class to 
another. It tells the compiler to treat the object or datum as 
though it were an instance of the specified datatype. It usethough it were an instance of the specified datatype. It use 
a cast to tell the compiler the type of an object .

40
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Casting (Contd…)Casting (Contd…)
var ship: EnemyShip =theEnemyManager.getClosestShip();

if(ship instanceof Bomber){
Bomber(ship).bomb (); // cast to bomber
}}
else if(ship instanceof Cruiser){
C i ( hi ) d ()Cruiser(ship).evade(); 
}
else if(ship instanceof Fighter){else if(ship instanceof Fighter){
Fighter(ship).callReinforcements();
Fighter(ship) fire();Fighter(ship).fire();
}
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Casting TerminologyCasting Terminology
Casting an object to one of its supertypes is known as 

tupcast.
E.g.: var bball:BasketBall =new BasketBall();
var genericball:Ball new Ball(bball); // upcast bballvar genericball:Ball =new Ball(bball); // upcast bball

Casting an object one of its subtypes is known as downcast.
E g : var b:Ball =new Ball();E.g.: var b:Ball new Ball();
var bball:BasketBall =new BasketBall(b); // downcast of b

An upcast is safe and downcast is unsafe. Because p
supertype is not necessarily be  an instance of its subtype.
E.g.: var ball1: Ball =new BasketBall(); // without casting

1 ( ()) // fvar ball1 : Ball=Ball(new BasketBall()); // safe upcast
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Casting does not affect method or 
Property selection
If a superclass define a method or property i.e., overhidden 
by a subclass, casting does not affect which version of a 
method or property to be used.
When an overridden method is invoked on an instance of aWhen an overridden method is invoked on an instance of a 
subclass, the subclass version of the method is always used, 
even if the subclass instance is cast to the superclass.
Casting versus Conversion
Casting merely tells the compiler to treat an object as 
th h it i t f th ifi d d t tthough it were an instance of the specified datatype. 
Conversion does change an object from one datatype to 
another.another.
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Casting to String Number Boolean Date & ArrayCasting to String, Number, Boolean, Date & Array
The String(), Number(), Boolean() and Array() functions 
perform data conversionsperform data conversions
The Date() function returns the current time as a string
Syntax: Number(value) // to convert a value to a numbery ( )
E.g: Var obj:Object=[1,2,3];
function output (msg:Object):Void {

// use typeof to detect the datatype of primitive values
if ( typeof msg==“string”) { trace(msg); }

// I t f t h k th l f bj t// use Instanceof to check the class of an object
if (msg instanceof Array){

trace(msg join(“\n”)); }}trace(msg.join( \n )); }}
Output panel display 1 2 3 (line by line)
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Defining Classesg
A class is a template for the creation of objects. Classes are 
the building blocks of an object-oriented program. 
class declaration:

class ClassIdentifier { }
where ClassIdentifier is the name of the class 

E.x.: class Box {}
A l d fi iti t id i t l l i t t fil th tA class definition must reside in an external plain text file that 
has the extension .as. 
Everything between the curly braces in a class declarationEverything between the curly braces in a class declaration 
constitutes the class definition block, or more informally, the 
class body. 
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The class body can contain:The class body can contain:
A constructor function (used to initialize instances 
of the class)of the class)
Variable definitions (the class's properties)
F ti d fi iti (th l ' th d )Function definitions (the class's methods)
#include directives, which can include files 
containing properties methods and constructorcontaining properties, methods, and constructor 
functions
Metadata tags used in Flash MX 2004 componentsMetadata tags used in Flash MX 2004 components
Comments
Class definitions cannot be nested and no otherClass definitions cannot be nested, and no other 
code can appear in a class definition. 
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Examplep
class Box {
private static var inited:Boolean = false;
public function Box ( ) {
if (!inited) {      init( );    }  }

private static function init( ):Void {
if (100 == (10*10)) {
trace("One hundred is ten times ten"); }trace( One hundred is ten times ten );    }

inited = true;  }}

The term instance member refers to either an instance 
property or an instance method, while the term class 

b f i h l l h dmember refers to either a class property or a class method 
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Constructor Functions (Take 1)Constructor Functions (Take 1)
When we create an object, we also want to initialize it.
Ex Box Class: Initialize the new instance's sizeEx. Box Class: Initialize the new instance s size     

(i.e., set its width and height properties)
Represent the new instance on screenRepresent the new instance on screen                        

(i.e., call the draw( ) method)
To initialize and perform setup tasks for new objects ofTo initialize and perform setup tasks for new objects of 
a class, we create a constructor function. 
The constructor function executes automatically y
each time an instance is created. 
Typically, when we create a class, we immediately y y y
add an empty constructor function to it. 

48

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Constructor Functions (Take 1) (Contd…)Constructor Functions (Take 1) (Contd…)
class Box {

p blic f nction Bo ( ) {public function Box ( ) {
}}

Now that our Box class has an empty constructor 
function, we'll give the class some properties and 
methods. 
When no constructor is provided for a class, 
A ti S i t dd t t ti ll tActionScript adds an empty one automatically at 
compile time.
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Propertiesope t es
Classes use properties to store information. But some 
information relates to a class as a whole 

Class properties
Named data containers associated with a class

Instance properties
Named data containers associated with objects (i.e., 
instances of the class)instances of the class)
Together, class properties and instance properties are 
sometimes referred to as fixed propertiesp p
In ActionScript and ECMAScript 4, instance properties are 
sometimes called instance variables, and class properties 
are sometimes called class variablesare sometimes called class variables

50

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Instance properties:Instance properties:
Are stored individually on each instance of a class
Are accessed through instances onlyAre accessed through instances only
Can be set uniquely for one instance without affecting any 
other instances
An instance property is declared once for the entire class, 
but each instance of the class maintains its own value. 
Th l t iThe general syntax is:                  

var propertyName:datatype = value;
If d t t i itt d t h ki i f d thIf datatype is omitted, no type checking is performed on the 
property 
var propertyName = value;var propertyName  value;  

// No type checking for this property.
51
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Access control modifiers in AS, Java, & C++
Access control 

modifier ActionScript Java C++

public No access 
restrictions

No access 
restrictions

No access 
restrictions

Class and subclassprivate Class and subclass 
access only Class access only Class access only

Access allowed 
no modifier Same as public from class's own 

package only
Same as private

Access allowed

protected Not supported

Access allowed 
from class's own 
package and 
class's subclasses

Access allowed 
from class and p pp class's subclasses 

in any other 
package

subclass only
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Compile-Time Constant Expressions
An instance property definition can assign a default value to a 
property, provided that the value is a so-called compile-time 
constant expressionconstant expression. 
A compile-time constant expression is an expression whose 
value can be fully determined at compile time. They include :
null, numeric, boolean, and string constants
The following operators (used only on numbers, booleans, 
t i ll d fi d) ( d bi ) ( dstrings, null, or undefined): + (unary and binary), - (unary and 

binary), ~, !, *, /, %, <<, >>, >>>, <, >, <=, >=, instanceof, ==, 
!=, ===, !==, &, ^, |, &&, ^^, ||, and ?: (ternary operator)| || ( y p )
Array literals, Object literals, and instances of the following 
classes: Array, Boolean, Number, Object, and String
R f t th il ti t t iReferences to other compile-time constant expressions
Example: 4 + 5, “Hello" + " world", null, [4, 5], new Array(4, 5)53
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MethodsMethods
Methods are functions that determine the behavior of a class.
If a parameter's type is omitted in the method definition, no 
type checking is performed for that parameter . 
If returnType is omitted, no type checking is performed for 
the return valuethe return value. 
A function with return type Void may not return a value.
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Referring to the Current Object with the 
Keyword this
Using this helps our class to remain encapsulated, 
eliminating the need for the outside world to worry about the 
object's internal requirements. 
The this reference to the current object allows an object toThe this reference to the current object allows an object to 
refer to itself without the need for an additional parameter, and 
is therefore much cleaner.

Passing the current object to a method
The this keyword is most often used when passing the current 
object to another object's methodobject to another object s method
function someMethod ( ):Void {
// Pass this as a parameter to a completely separate object// Pass this as a parameter to a completely separate object  
someOtherObject.someOtherMethod(this);  }
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Garbage collection
Wh bj t i t li t f th bj t itWhen an object registers as a listener of another object, it 
should always unregister itself before it is deleted.
This sloppiness can cause serious waste of memory. A classThis sloppiness can cause serious waste of memory. A class 
should always provide a means of cleaning up stray object 
references before an object is deleted. 
A i S i d ' b ll bj (i f hActionScript doesn't garbage-collect an object (i.e., free up the 
memory used by an object) until no more references to it 
remain. Cleanup is done in a custom die( ) or destroy( ) p ( ) y( )
method that must be invoked before an object is deleted. 
By providing a die( ) method, a class guarantees a safe means 
of deleting its instancesof deleting its instances. .
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Nesting Functions in Methods
ActionScript supports nested functions, which means 
that functions can be declared within methods or even 
within other functionswithin other functions. 
A local variable, a nested function is accessible only to 
its parent function (the function in which it is declared). 
Code outside the parent function cannot execute the 
nested function:
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Accessing the current object from a 
function nested in a method

A function nested in a method does not have direct accessA function nested in a method does not have direct access 
to the current object (the object on which the method 
was called). 
The current object by storing a reference to it in a local 
variable.
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Getter and Setter Methods
To bridge the gap between the convenience of property 
assignment and the safety of accessor methods, ActionScript 
2.0 supports "getter" and "setter" methods.2.0 supports getter  and setter  methods. 
Getter and setter methods are accessor-like methods, 
defined within a class body, that are invoked automatically 
when a developer tries to get or set a property directly.

function get propertyName ( ):returnType { 
// getter method statements }// getter method   statements    }

function set propertyName (newValue:type):Void { 
// setter method statements }// setter method  statements   }

Getter and setter methods cannot be declared with the 
private attribute. 
When invoked getter and setter methods does not require use 
of the function call operator, ( ). 59
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A class with getter and setter methods
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Extra or Missing ArgumentsExtra or Missing Arguments
Extra arguments are not (indeed cannot be) type checked 
automatically by the compiler. y y p

public function setWidth (w:Number):Void {
// If w is undefined, then quit
if (w == undefined) {

return;         }
idth }width = w; }

The arguments object also stores:
A reference to the method currently executingA reference to the method currently executing 
(arguments.callee)
A reference to the method that called the method 
currently executing, if any (arguments.caller)
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4.5 Constructor Functions (Take 2)( )
A constructor function is the metaphoric womb of a class; it 
isn't responsible for creating new instances, but it can be 
used to initialize each new instanceused to initialize each new instance.
When we create a new instance of a class using the new 
operator, the class's constructor function runs. Within the 
constructor function, we can customize the newly created 
instance by setting its properties or invoking its methods. 

class Box {class Box {
public function Box ( ) {
} }}  }

To define a constructor function, we use the function 
statement within a class body. 
The constructor function's name must match its class's 
name exactly (case sensitivity matters). 62
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Constructor Functions (Take 2) (Contd…)( ) ( )
The constructor function's definition must not specify a 
return type (not even Void).
The constructor function must not return a value
The constructor function's definition must not include the 
static attribute but it can be public or privatestatic attribute, but it can be public or private.
ActionScript automatically provides a default constructor
that takes no parameters and performs no initialization on p p
new instances of the class. 
A constructor function's parameter values are passed to it via 
th t t bj t ti tithe new operator at object-creation time

.
new SomeClass(value1 value2 valuen);new SomeClass(value1, value2,...valuen);
new Box(2, 3);
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Simulating Multiple Constructor Functions
Unlike Java, ActionScript does not support multiple constructor 
functions for a single class (overloaded constructors in Java).
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overloaded constructors
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Completing the Box Class
First decide whether the display elements will render themselves or be 
rendered by a central class. 
Decide how often the displayed elements should be updated—either p y p
when some event occurs (such as a mouseclick) or repeatedly (as fast 
as frames are displayed in the Flash Player).
Decide on the rendering technique. Each visual element in a Flash movie g q
must be displayed in a movie clip. 
Decide on a screen refresh strategy. 
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A Box class complete with drawing routines
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A Box class complete with drawing routines (Contd..)
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Authoring An ActionScript 2.0 Class
Class Authoring Quick Start

To create an ActionScript 2.0 class, follow these general p , g
steps: 
Create a new text file with the .as extension using any 
l i t t dit Fl h MX P f i l 2004' b ilt iplain text editor or Flash MX Professional 2004's built-in 

editor. 
The .as file's name must match the class name exactlyThe .as file s name must match the class name exactly 
(case sensitivity matters).
Add the class definition to the .as file. 
class NameOfClass {

// Class body goes here   
}}
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To use an ActionScript 2.0 class in a Flash 
movie, Steps: 

1. Create a .fla file with any name, and place it in the same 
folder as the .as file from Step 1 in the preceding procedure.

2. Optionally specify the class's export frame for the .fla file via 
File Publish Settings Flash ActionScript Version SettingsFile Publish Settings Flash ActionScript Version Settings 
Export Frame for Classes. This determines when the class 
loads and when it becomes available in the movie. The export 
f i ll f f i 'frame is usually set to some frame after your movie's 
preloader.

3 Use the class as desired throughout the fla file but after the3. Use the class as desired throughout the .fla file, but after the 
export frame specified in Step 2 (if any).

4. Export a .swf file using one of the following: File Publish, 
Control Test Movie, or File Export Export Movie.
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Designing the ImageViewer Class
With our ImageViewer class's name  we have a list of 
functionality that could be required of the ImageViewer class:

Load an image
Display an image
Crop an image to a particular rectangular "view region"
Display a border around the image
Display image load progressDisplay image load progress
Reposition the view region
Resize the view regionResize the view region
Pan (reposition) the image within the view region
Zoom (resize) the image within the view region
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ImageViewer Implementation (Take 1)ImageViewer Implementation (Take 1)
To create the ImageViewer.as file using Flash MX 
Professional 2004 follow these steps:Professional 2004, follow these steps:
Choose File New.
In the New Document dialog box, on the General tab, for the g
document Type, choose ActionScript File.
Click OK. The script editor launches with an empty file.
Ch Fil S AChoose File Save As.
In the Save As dialog box, specify ImageViewer.as as the 
filename (using upper- and lowercase as shown) and save thefilename (using upper and lowercase as shown) and save the 
file in the imageviewer folder you created.
Notice that the class name, ImageViewer, and the filename, 
ImageViewer.as, must match exactly (apart from the .as file 
extension).
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The ImageViewer class with constructor and 
( ) ( )loadImage( ) method, properties (Take 1)
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Using ImageViewer in a Movie
Find a (nonprogressive format) JPEG image on your system. 
Name the JPEG image picture.jpg and place it in the same 
folder as the ImageViewer as file you created earlierfolder as the ImageViewer.as file you created earlier.
Next we'll create a Flash document (.fla file) from which we'll 
publish a Flash movie (.swf file) containing an instance of our 
ImageViewer class. 
For now, we'll place the .fla file, .as file, .swf file, and .jpg file 
all in the same folder making it easy for each file to accessall in the same folder, making it easy for each file to access 
the other files.
Create the Flash document that uses the ImageViewer class. g
Follow these steps:

In the Flash authoring tool, choose File -> New.
I th N D t di l b th G l t b f thIn the New Document dialog box, on the General tab, for the 
document Type, choose Flash Document, then click OK.
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Using ImageViewer in a Movie (Contd…)
Use File -> Save As to save the Flash document as 
imageViewer.fla in the same folder as the ImageViewer.as file. 
In imageViewer.fla's main timeline, rename Layer 1 to scripts
Follow these steps to instantiate ImageViewer on frame 1 of 
imageViewer fla's main timeline:imageViewer.fla s main timeline:

Use Window -> Development Panels ->Actions (F9) to open 
the Actions panel.
Select frame 1 in imageViewer.fla's main timeline.
Into the Actions panel, enter the following code:

var viewer:ImageViewer = new ImageViewer(this, 1);
viewer.loadImage("picture.jpg");
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Using ImageViewer in a Movie (Contd )Using ImageViewer in a Movie (Contd…)
Let's export our imageViewer.swf file and test it in Flash's Test 
Movie mode as follows:Movie mode, as follows:

Choose Control -> Test Movie. The .swf file should play, 
and your image should load and appear.y g pp
When you're finished marveling at your work, choose File -
> Close to return to the imageViewer.fla file.

T h i Vi fl ' t tti t tTo change imageViewer.fla's export settings to support 
playback in Flash Player 6, follow these steps:

Choose File -> Publish SettingsChoose File > Publish Settings.
On the Flash tab of the Publish Settings dialog box, select 
Flash Player 6 as the Version option.
Click OK.
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Preloading the ImageViewer Classg g
Let's change our imageViewer.fla file so that the classes it 
uses aren't loaded until frame 10:
Choose File -> Publish Settings.
In the Publish Settings dialog box, on the Flash tab, next to 
the ActionScript Version click Settingsthe ActionScript Version, click Settings.
In the ActionScript Settings dialog box, for Export Frame for 
Classes, enter 10.
Click OK to confirm the ActionScript Settings.
Click OK to confirm the Publish Settings.
Now let's add a very basic preloader to our imageViewer.fla 
file so load progress is reported while the ImageViewer class 
loads. When loading is complete, we'll advance the playhead g p , p y
to frame 15 where we'll instantiate ImageViewer (as we 
previously did on frame 1).
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Preloading the ImageViewer Class (Contd..)
First, we'll make the timeline 15 frames long, as follows:

In the main timeline of imageViewer.fla, select frame 15 of the scripts 
layer.y
Choose Insert -> Timeline ->Keyframe (F6).

Next, we'll add a labels layer with two frame labels, loading and main. The 
labels designate the application's loading state and startup pointlabels designate the application s loading state and startup point, 
respectively.
Choose Insert ->Timeline ->Layer.
Double click the new layer's name and change it to labelsDouble-click the new layer s name and change it to labels.
At frames 4 and 15 of the labels layer, add a new keyframe (using Insert -
>Timeline ->Keyframe).
With f 4 f th l b l l l t d i th P ti l dWith frame 4 of the labels layer selected, in the Properties panel, under 
Frame, change <Frame Label> to loading.
With frame 15 of the labels layer selected, in the Properties panel, under 
F h F L b l t iFrame, change <Frame Label> to main.
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Now add the preloader script to the scripts layer:p p p y
At frame 5 of the scripts layer, add a new keyframe (using 
Insert ->timeline ->Keyframe).
With frame 5 of the scripts layer selected, enter the following 
code into the Actions panel:

if ( framesloaded == totalframes) {if (_framesloaded == _totalframes) {
gotoAndStop("main");} 
else {  gotoAndPlay("loading");   }{ g y( g ); }

Next, we'll move the code that creates our ImageViewer
instance from frame 1 to frame 15 of the scripts layer:
Select frame 1 of the scripts layer.
In the Actions panel, cut (delete using Ctrl-X or Cmd-X) the 
following code from frame:following code from frame:
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var viewer:ImageViewer = new ImageViewer(this, 1);
viewer.loadImage("picture.jpg");

With frame 15 of the scripts layer selected, paste (using Ctrl-
V ) the code o deleted in Step 2 into the Actions panelV ) the code you deleted in Step 2 into the Actions panel.
Finally, we'll add a loading message that displays while the 
ImageViewer class loads:g
With frame 1 of the scripts layer selected, enter the following 
code into the Actions panel:

this.createTextField("loadmsg_txt", 0, 200, 200, 0, 0);
loadmsg_txt.autoSize = true;
loadmsg txt text = "Loading Please wait ";loadmsg_txt.text = "Loading...Please wait.";

With frame 15 of the scripts layer selected, enter the 
following code at the end of the Actions panelg p

loadmsg_txt.removeTextField( );
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ImageViewer Implementation (Take 2)
The third and fourth requirements: cropping the image and 
giving it a border. We must apply a mask to it, which hides 

t d f th i f iunwanted areas of the image from view. 
We'll add parameters to the ImageViewer constructor to 
specify the size of the mask and the position of the croppedspecify the size of the mask and the position of the cropped 
image.
To create border, we'll create a movie clip, then draw a square 

tli i itoutline in it. 
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Splitting out the work into separate methods 
has the following benefits:
It makes the code more intelligible.
It simplifies the testing process (testing each 
method individually is easier than testing a large 
block of code that performs many operations).
It allows assets to be created and re-created 
i d d tl ( th b d iindependently (e.g., the border on an image can 
change without reloading the image).
It allo s asset creation operations to be modifiedIt allows asset-creation operations to be modified 
or overridden independently (e.g., a new border-
creation routine can be coded without disturbingcreation routine can be coded without disturbing 
other code).
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Table The ImageViewer class's new 
i t th d th t t i liinstance methods that create movie clips

Method name Method descriptionMethod name Method description

buildViewer( )
Invokes individual methods to create the container, 
image, mask, and border clips

createMainContainer( ) Creates the container_mc clip

createImageClip( ) Creates the image_mc clip

createImageClipMask( ) Creates the mask_mc clip

createBorder( ) Creates the border_mc clip

•A reference to the target clip to which container_mc should be 
attached
•A list of depths indicating the visual stacking order of the container, g g
image, mask, and border clips
•The style (line weight and color) of the border around the image

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Table The ImageViewer class's instance 
and class properties

Property name Type Property description

container_mc Instance
A reference to the main container clip, which contains all movie 
clips used by each ImageViewer instance

target mc Instance
A reference to the clip that will contain the container_mc

target_mc Instance
clip, as specified by the ImageViewer constructor

containerDepth Instance
The depth on which container_mc is created in target_mc, 
as specified by the ImageViewer constructor

imageDepth Class The depth on which image_mc is created in container_mc

maskDepth Class The depth on which mask_mc is created in container_mc

borderDepth Class The depth on which border_mc is created in container_mc

borderThickness Instance The thickness, in pixels, of the border around the image_mc clip

h l f h b d d h lborderColor Instance The integer RGB color of the border around the image_mc clip
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The ImageViewer class, take 2
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The ImageViewer class, take 2g ,
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The ImageViewer class, take 2g
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The ImageViewer class, take 2

•Now that our ImageViewer class can crop an image and add a border to it. 
•When we used the first version of the ImageViewer class we placed the•When we used the first version of the ImageViewer class, we placed the 
following code on frame 15 of imageViewer.fla:
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Unit IV 

Inheritance
Authoring an ActionScript 2.0 Subclass

InterfacesInterfaces
Packages

ExceptionsExceptions

1
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I N H E R I T A N C E
A Primer on Inheritance
Subclasses as Subtypes
An OOP Chat Example
Overriding Methods and 

PropertiesProperties
Constructor Functions in Subclasses
Subclassing Built-in Classes
Augmenting Built-in Classes & Objects
The Theory of Inheritance
Abstract and Final Classes Not SupportedAbstract and Final Classes Not  Supported

2
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A Primer on Inheritance
In OOP, inheritance is a formal relationship between two 
or more classes, wherein one class borrows (or inherits) 
the property and method definitions of another classthe property and method definitions of another class
class A { public var p:Number = 10;

public function x ( ):Void {public function x ( ):Void {
trace("Method x( ) was called.");  }}

We can create an instance of class A, invoke method x( ),
and access property p like this:

var aInstance:A = new A( );
I t ( ) // Di l M th d ( ) ll daInstance.x( );       // Displays: Method x( ) called.

trace(aInstance.p);  // Displays: 10
Now let's add a second class B that inherits method x( )Now let s add a second class, B, that inherits method x( )
and property p from class A. 

3
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A Primer on Inheritance (Contd…)
To set up the inheritance relationship between A and B, we 
use the extends keyword to indicate that class B inherits 
class A's method and property definitions:class A s method and property definitions:

class B extends A {                      }
Because class B extends (inherits from) class A, instances ofBecause class B extends (inherits from) class A, instances of 
B can automatically use the method x( ) and the property p 

var bInstance:B = new B( );
bInstance.x( );          // Displays: Method x( ) was called.
trace(bInstance.p);  // Displays: 10

l B ld d fi it th d d/ ti iclass B would define its own methods and/or properties in 
addition to inheriting A's methods and properties.
class B extends A {{
public function y ( ):Void {trace("Method y( ) was called.");  } }

4
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A Primer on Inheritance (Contd…)
N i t f B ll th th d d ti fNow instances of B can use all the methods and properties of 
both B and its superclass, A:

var bInstance:B = new B( );var bInstance:B  new B( );
// Invoke inherited method, defined by class A.
bInstance.x( );       // Displays: Method x( ) was called.
// Invoke method defined by class B.
bInstance.y( );       // Displays: Method y( ) was called.
// Access inherited property.
trace(bInstance.p);  // Displays: 10

Inheritance relationship bet een t o classes the e tendedInheritance relationship between two classes, the extended 
class (in our case, class A) is called the base class, and the 
class that does the extending (in our case, class B) is called 
the derived class. 

5
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A Primer on Inheritance (Contd )A Primer on Inheritance (Contd…)
However, the terms "base class" and "derived class" have 
several synonyms including superclass and subclass parentseveral synonyms, including superclass and subclass, parent 
and child, and type and subtype.
The following code shows third class,C, that extends class B 
and also defines a new method, z( ).
Class C can use all the methods and properties defined by 
itself its superclass (B) or its superclass's superclass (A)itself, its superclass (B), or its superclass s superclass (A)
Every class in ActionScript (both built-in and custom) 
inherits directly or indirectly from the root of the built-in 
hierarchy: Object. 
The Object class defines some very basic methods that all 
classes can useclasses can use. 

6
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A Primer on Inheritance (Contd…)
class C extends B {

public function z ( ):Void {
trace("Method z( ) was called.");  } }

var cInstance:C = new C( );
cInstance x( ); // Displays: Method x( ) was calledcInstance.x( );  // Displays: Method x( ) was called.
cInstance.y( );  // Displays: Method y( ) was called.
cInstance z( ); // Displays: Method z( ) was calledcInstance.z( );  // Displays: Method z( ) was called.
trace(cInstance.p);  // Displays: 10

class D inherits directly from class A. Class D uses the methods y
and properties defined by itself and by its superclass, A.

class D extends A {
bli f ti ( ) V id {public function w ( ):Void {

trace("Method w( ) was called.");  }} 7
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Subclasses as Subtypesyp
A subclass is considered a subtype of its superclass. An 
instance of the subtype can be used anywhere its 
superclass's type is expected var aInstance:A;superclass s type is expected. var aInstance:A;
we can legally assign that variable an instance of any 
subclass of class A: aInstance = new B( );  
The preceding assignment works because the compiler 
knows that any instance of class B has (through inheritance) 
all the methods and properties defined by class Aall the methods and properties defined by class A. 
However, the reverse is not true. We cannot assign an 
instance of A to a variable whose datatype is B:yp

var bInstance:B = new A( );  //  Type Mismatch Error.
That assignment does not work because the compiler 

t t th t i t f l A ill h thcannot guarantee that an instance of class A will have the 
methods and properties defined by class B. 

8
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An OOP Chat Example
Consider a chat application that defines a class, ChatRoom, 
which handles communication among a group of users. 
Ch tR l d fi th d f di l i & diChatRoom class defines methods for displaying  & sending 
chat messages and for managing a list of users in the room

9
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AvatarChatRoom class's methods & properties

10
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Example An inheritance example using 
ChatRoom and AvatarChatRoom

class ChatRoom {
private var userList:mx controls List;private var userList:mx.controls.List;
public function displayMessage(userID:String, msg:String):Void {

trace("Displaying chat message in chat text field.");
}
public function sendMessage(msg:String):Void {

trace("Sending chat message.");
}
public function onAddUser(userID:String):Void {public function onAddUser(userID:String):Void {

trace("Adding user to userList.");
}
public function onRemoveUser(userID:String):Void {

trace("Removing user from userList.");
}
public function onUserChangeName(userID:String, newName:String):Void {

trace("Changing name in userList.");

11

trace( Changing name in userList. );
}

}
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Example An inheritance example using 
ChatRoom and AvatarChatRoom

12
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Constructor Function in Subclasses
A constructor function initializes the instances of a class by:

Calling methods that perform setup tasks
Setting properties on the object being created

When a class is extended, the subclass can define a 
constructor function of its own A subclass constructor isconstructor function of its own. A subclass constructor is 
expected to:

Perform setup tasks related to the subclassp
Set properties defined by the subclass
Invoke the superclass constructor (superconstructor)

In all inheritance relationships, setup and property 
initialization relating to the superclass occur in the superclass
constructor not in the subclass constructorconstructor, not in the subclass constructor.

13
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Constructor Function in Subclasses (Contd..)( )
A subclass constructor function, if specified, is formally 
required to invoke its superclass constructor, via the keyword 

th fi t t t t i th f tisuper, as the first statement in the function.
class A {  public function A ( ) {  } }
class B extends A { public function B ( ) {class B extends A {   public function B ( ) {

// Invoke superclass's constructor function explicitly
super( );  }}p ( ); }}

public function B ( ) {
// Invoke superclass's constructor function explicitly.
super( );}

bli f i B ( ) {public function B ( ) {
// No constructor call. The compiler provides one implicitly. }14
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The Theory of Inheritance

Inheritance lets us separate a core feature set from 
customized versions of that feature set. Code for the core is 
stored in a superclass while code for the customizations is kept 
neatly in a subclass. 
More than one s bclass can e tend the s perclass allo ingMore than one subclass can extend the superclass, allowing 
multiple customized versions of a particular feature set to exist 
simultaneously. 
Inheritance also lets us express the architecture of an 
application in hierarchical terms that mirror the real world and 
the human psychethe human psyche. 
In addition to code reuse and logical hierarchy, inheritance 
allows instances of different subtypes to be used where a single 
type is expected. Known as polymorphism

15
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Polymorphism and Dynamic Binding
The word polymorphism itself means literally "many 
forms"—each single object can be treated as an instance of 
its own class or as an instance of any of its superclassesits own class or as an instance of any of its superclasses.
Polymorphism's partner is dynamic binding, which 
guarantees that a method invoked on an object will trigger 
the behavior defined by that object's actual class.
Dynamic binding, which occurs at runtime, with static type 
checking which occurs at compile timechecking, which occurs at compile time
Dynamic binding is the runtime process by which each 
invocation of draw( ) is associated with the appropriate ( ) pp p
implementation of that method.  
Dynamic binding is often called late binding: the method call 
is bound to a particular implementation "late" (i e atis bound to a particular implementation late  (i.e., at 
runtime).

16
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Polymorphism and Dynamic Binding(Contd..)
class Shape {   public function draw ( ):Void {

// No implementation.   } }p } }
class Circle extends Shape {
public function draw ( ):Void {
}}

l R t l t d Sh {class Rectangle extends Shape {
public function draw ( ):Void {
}}}}

class Triangle extends Shape {
public function draw ( ):Void {pub c u ct o d a ( ) o d {
}}

17
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Abstract and Final Classes Not Supportedpp

An abstract class is any class that defines one or more 
abstract methods—methods that have a signature and a g
return type but no implementation
A class that wishes to extend an abstract class must 
implement all of the s perclass's abstract methodsimplement all of the superclass's abstract methods; 
otherwise, a compile-time error occurs. 
ActionScript 2.0 does not yet support abstract classes or p y pp
abstract methods. Instead we simply define a method with no 
code in its body
A fi l th d i th d th t t t b i l t d bA final method is a method that must not be implemented by 
a subclass. Final methods are used to prevent programmers 
from creating subclasses that accidentally introduce problems 
into the behavior of a superclass

18
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Extending ImageViewer's Capabilities
Authoring an ActionScript 2.0 Subclass
Extending ImageViewer s Capabilities

The list of possible functional requirements for our 
ImageViewer class:

Load an image , Display an image
Crop an image to a particular rectangular "view region"
Display a border around the imageDisplay a border around the image
Display image load progress
Reposition the view region Resize the view regionReposition the view region, Resize the view region
Pan (reposition) the image within the view region
Zoom (resize) the image within the view region( ) g g

The ImageViewer class already implements the first five 
requirements, but it stops there.
I h I Vi D l l 'll dd h iIn the ImageViewerDeluxe class, we'll add the next two items 
on the list: the abilities to reposition and resize the viewer.

19
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The ImageViewerDeluxe Skeleton
The bare bones of any subclass requires:

A class declaration that defines the inheritance 
relationship
A constructor that invokes the superclass constructor with 
the expected argumentsthe expected arguments

class ImageViewerDeluxe extends ImageViewer {g g {
public function ImageViewerDeluxe (target:MovieClip, 

depth:Number,  x:Number, y:Number, w:Number, h:Number,  
b d Thi k N b b d C l N b ) {borderThickness:Number, borderColor:Number)  { 
super(target, depth, x, y, w, h, borderThickness, 
borderColor);  );

} }
20

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



To create the ImageViewerDeluxe.as class file using 
Flash MX Professional 2004, follow these steps:

1. Choose File → New.
I th N D t di l b th G l t b f2. In the New Document dialog box, on the General tab, for 
Type, choose ActionScript File.

3. Click OK. The script editor launches with an empty file.3. Click OK. The script editor launches with an empty file.
4. Copy the code  into the script editor: in the next slide.
5. Choose File → Save As.
6. In the Save As dialog box, specify ImageViewerDeluxe.as

as the filename (which is case sensitive), and save the file in 
the imageviewer folder that you createdthe imageviewer folder that you created.

7. Instances of the ImageViewerDeluxe class have all the 
ImageViewer class's methods and can be used anywhere 
ImageViewer instances are used.

21
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Adding setPosition( ) and setSize( ) Methodsg ( ) ( )
• setPosition( )

– Changes the location of the viewer by assigning the (x, y) coordinates 
of the ie er's main container mo ie clipof the viewer's main container movie clip

• setSize( )
– Changes the size of the viewer by re-creating the mask and border g y g

over the image movie clip (i.e., by recropping the image)

public function setPosition (x:Number, y:Number):Void { 
container mc x = x; container mc y = y; }container_mc._x = x; container_mc._y = y;              }
The setSize( ) method, which resizes the image viewer by 
recropping the image:pp g g

public function setSize (w:Number, h:Number):Void { 
createImageClipMask(w, h); createBorder(w, h); 

t i i tM k( t i k )container_mc.image_mc.setMask(container_mc.mask_mc); 
}

22
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The ImageViewerDeluxe class, final version
class ImageViewerDeluxe extends ImageViewer {
public function ImageViewerDeluxe (target:MovieClip, 

d th N b N b N b N b h N bdepth:Number,  x:Number, y:Number, w:Number, h:Number,  
borderThickness:Number, borderColor:Number)  { 
super(target, depth, x, y, w, h, borderThickness,super(target, depth, x, y, w, h, borderThickness, 
borderColor);  } }

public function setPosition (x:Number, y:Number):Void { 
t icontainer_mc._x = x; 

container_mc._y = y; } 
public function setSize (w:Number h:Number):Void {public function setSize (w:Number, h:Number):Void     { 

createImageClipMask(w, h); createBorder(w, h); 
container_mc.image_mc.setMask(container_mc.mask_mc); 

}} 
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w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



ImageViewerDeluxe class, final version (Contd..)
bli f ti tI Width ( ) N b {public function getImageWidth ( ):Number { 

return container_mc.image_mc._width;  } 
public function getImageHeight ( ):Number {public function getImageHeight ( ):Number { 

return container_mc.image_mc._height;  } 
public function setShowFullImage(show:Boolean):Void { pub c u ct o setS o u age(s o oo ea ) o d {

showFullImage = show;  } 
public function getShowFullImage( ):Boolean { 

return showFullImage;   } 
public function scaleViewerToImage ( ):Void {  

setSi e(getImageWidth( ) getImageHeight( )) }setSize(getImageWidth( ), getImageHeight( )); } 
public function onLoadInit (target:MovieClip):Void { 

super onLoadInit(target);super.onLoadInit(target); 
if (showFullImage) {   scaleViewerToImage( ); } } }

Unit IV Chap 7: Authoring AS Subclass 24Dept. of MCA, SVECW
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I N T E R F A C E S
The Case for Interfaces

An interface is an ActionScript 2.0 language construct used 
to define a new datatype, much as a class defines a 
datatype. 
A class both defines a datatype and provides theA class both defines a datatype and provides the 
implementation for it, an interface defines a datatype in 
abstract terms only; an interface provides no 
i l i f h dimplementation for the datatype. 
An interface, instead of providing its own implementation, is 
adopted by one or more classes that agree to provide theadopted by one or more classes that agree to provide the 
implementation. 
A class that provides an implementation for an interface 
belongs both to its own datatype and to the datatype defined 
by the interface. 

25
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The Case for Interfaces (Contd..)
class OrderListener {
public function onOrderError ( ):Void {
// Generic implementation of onOrderError( ) not sho n }}// Generic implementation of onOrderError( ), not shown…  }}

class StatsTracker extends OrderListener {
// Override OrderListener.onOrderError( ).
public function onOrderError ( ) {
// Send problem report to database. Code not shown…  }}

class OrderProcessor {class OrderProcessor {
public function addListener (ol:OrderListener):Boolean {
// Code here should register ol to receive OrderProcessor
eventsevents,
// and return a Boolean value indicating whether registration  }}

class OrderUI extends MovieClip {
bli f i O d E ( ) {public function onOrderError ( ) {

// Display problem report on screen, not shown…  }}
26
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Interfaces and Multidatatype Classesyp

An interface is simply a list of methods. 
i t f O d Li t {interface OrderListener {
function onOrderError( );

}}
Classes use the implements keyword to enter into an agreement 
with an interface, promising to define the methods it contains.

class OrderUI extends MovieClip implements OrderListener {
public function onOrderError ( ) {
// Display problem report on screen, not shown...

}}}}
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Interface Syntax and Use
To create an interface in ActionScript 2.0, we use the interface
keyword, using the following syntax:

interface  SomeName  {
function method1  (param1 :datatype ,...paramn :datatype ):returnType ;
function method2  (param1 :datatype ,...paramn :datatype ):returnType ;  

...
function methodn  (param1 :datatype ,...paramn :datatype ):returnType ;u ct o et od (pa a datatype , pa a datatype ) etu ype ;

}
In interfaces, method declarations do not (and must not) 
i l d l binclude curly braces.
All methods declared in an interface must be public; hence, by 
convention, the attribute public (which is the default) is omittedconvention, the attribute public (which is the default) is omitted 
from method definitions in an interface.
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Interface Syntax and Use (Contd..)y ( )
Class files

Contain the method and property definitions for each 
class. They start with the class keyword. 

Intrinsic files
Contain method signatures strictly for the purpose ofContain method signatures strictly for the purpose of 
satisfying the compiler's type checking. They start with the 
intrinsic keyword. 

Interface files
Contain a list of methods to be implemented but not the 
i l t ti th l Th t t ith th i t fimplementations themselves. They start with the interface 
keyword.

A class that wishes to adopt an interface's datatype must p yp
agree to implement that interface's methods. 
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Interface Syntax and Use (Contd..)y ( )
The class uses the implements keyword, which has the 
following syntax:

class SomeName implements SomeInterface { }
The implementing class's method definitions must match the 
interface's method definitions exactly including number ofinterface's method definitions exactly, including number of 
parameters, parameter types, and return type. 
If differs between the interface and the implementing class, p g ,
the compiler generates an error.
A class can legally implement more than one interface by 

ti i t f ith f llseparating interface names with commas, as follows:
class SomeName implements SomeInterface, 

SomeOtherInterface {SomeOtherInterface {
}
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L li ti t d f diff t
P A C K A G E S

Larger applications, creates dozens of different 
classes and  packages grouping them logically 
together. g
To group classes and interfaces together, we 
use packages. 
namespace collision or naming conflictnamespace collision or naming conflict.
A package is a unique place to put a group of 
classes, much as a directory on your hard drive , y y
is a unique place to put a group of files.
Packages allow multiple classes of the same name 
to coexist without namespace collisionsto coexist without namespace collisions, 
because each package constitutes a namespace
within which the class name is unique. 
A i t f th t t iA namespace is a set of names that contains no 
duplicates.
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Package Syntaxg y
The Domain Name System (DNS) defines a namespace in 
which registrants can reserve a domain name, such as 
moock.orgg
Every package has a name that describes the classes it 
contains. 
By convention, package names do not use initial caps butBy convention, package names do not use initial caps but 
might use mixed case, such as greatUtils. 
To refer to a specific class within a package, we use the dot 
operator: p

packagename.ClassName 
game.Player Packages can be nested to form a hierarchy; 
that is, a package can contain another package.that is, a package can contain another package. 

game.vehicles.SpaceShip 
By nesting packages, we can organize our classes into 
discrete subcategories within a larger category which againdiscrete subcategories within a larger category, which again 
prevents naming conflicts. 
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Import statementp
An unqualified reference includes just the class name. 

var ship:SpaceShip = new SpaceShip( ); 

If a class is in a package, we must use a fully qualified 
reference when creating instances of the class and g
specifying the datatypes of variables, parameters, and 
return types. 

var ship:game.vehicles.SpaceShip = new 
hi l S Shi ( ) // F ll lifi dgame.vehicles.SpaceShip( );// Fully qualified  

The import statement lets us use an unqualified class 
f li f f ll lifi d l freference as an alias for a fully qualified class reference. 

The basic syntax of import is:
import packagename.ClassName; 
import game.vehicles.SpaceShip; 
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Importing an Entire PackageImporting an Entire Package
To import all the classes in a package, use the wildcard 
character, *:

import packagename.*; 
This wildcard syntax lets us refer to any class in 
packagename by its unqualified name rather than its fully p g y q y
qualified name.

import geometry.Circle;
import geometry.Triangle;p g y g ;
import geometry.Rectangle;

import geometry *;import geometry. ; 

If we use package wildcards to import two classes with the 
same name but from different packages we again encountersame name but from different packages, we again encounter 
a namespace collision. 
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Package Naming Conventions
import game.vehicles.*;
import ordering.*;

Shi Shi ( ) // hi l Shivar s:Ship = new Ship( );  // new game.vehicles.Ship 
var s:ordering.Ship = new ordering.Ship( ); 

To avoid confusion, we should use fully qualified names for 
all references to Ship.
Just as two class names can conflict, two package names can , p g
conflict. 
To avoid package or class naming conflicts you should use the 
convention of placing all your classes and packages in a p g y p g
package named after your organization's domain name. 
com.acme com precedes acme (the package name is the 
reverse of the domain name).
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Defining Packages
Defining a package for a class requires two general steps:

Create a directory structure whose name identically 
matches the package hierarchymatches the package hierarchy.
Specify the package name when defining the class.

There is no such thing as a package file. A package is a 
concept based on placing a given class's as file in theconcept based on placing a given class s .as file in the 
appropriate folder.
To place the class Player in package com.yourdomain.game
Create a new directory named comCreate a new directory named com.
Create a new directory inside com named yourdomain.
Create a new directory inside yourdomain named game.
Create a text file, Player.as, in the directory 

/com/yourdomain/game/.
In Player.as,  class com.yourdomain.game.Player 

{ // Class body not shown... } 
Dept. of MCA, SVECW 36Unit IV Chap 9: Packages
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Package Access and the Classpath
In order for a .fla file to access a class in a package, the root 
directory of the package must reside within the classpath. 
The classpath is simply the list of directories (paths) onThe classpath is simply the list of directories (paths) on 
your hard drive in which the compiler looks for classes. 
Entries in the classpath can be added globally for all 
documents (the global classpath )documents (the global classpath )
The global classpath includes the following directories:

The current directory, usually represented by a period 
( )—i e the directory in which the fla resides(.) i.e., the directory in which the .fla resides
The Classes directory, $(LocalData)/Classes—

Select Edit -> Preferences -> ActionScript -> Language -
>ActionScript 2 0 Settings>ActionScript 2.0 Settings.
Under Classpath, click the plus sign (+) to add a new 
classpath entry. A blank entry appears.
In the classpath entry type C:\data\actionscript\ (Or useIn the classpath entry, type C:\data\actionscript\. (Or use 
the crosshair button to browse to that directory.)
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E X C E P T I O N S
The Exception-Handling Cycle

we can write code that 
t t d di dgenerates standardized errors 

via the throw statement. 
We handle those errors via theWe handle those errors via the 
try/catch/finally statement.
To generate an exception (i.e., 
i l ) i dsignal an error) in our code, 

throw expression
The Error class introduced asThe Error class, introduced as 
a built-in class in Flash Player 
is a standard class for 
representing error conditions.
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The Exception-Handling Cycle (Contd..)The Exception Handling Cycle (Contd..)
The Error class defines two 
public properties name andpublic properties, name and 
message , used to describe the 
error. 
When the throw statement 
executes, program control is 
immediately transferred to a y
special section of code that 
knows how to deal with the 
problemproblem. 
The code that deals with the 
problem is said to handle the 
exception.
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The Exception-Handling Cycle (Contd..)p g y ( )

The catch block handles exceptions generated by the tryThe catch block handles exceptions generated by the try 
block. 
The code in the catch block executes if, and only if, code in 
the try block generates an exception
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The Exception-Handling Cycle (Contd..)p g y ( )

The try keyword tells the 
interpreter that we're aboutinterpreter that we re about 
to execute some code that 
might generate an 
exception.
The catch block handles 
exceptions generated by theexceptions generated by the 
try block. 
The code in the catch block 
executes if, and only if, code 
in the try block generates an 
exception.exception. 
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The Exception-Handling Cycle (Contd..)
Code in a try clause 
invokes a function that 
might throw an 
exception.
Code in the in okedCode in the invoked 
function throws an 
exception using the 
throw statement if an 
error occurs.
The catch block dealsThe catch block deals 
with any errors that 
occur in the try block.
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The Exception-Handling Cycle (Contd..)p g y ( )
Control returns either to the try block or the catch block
When the catch block is executed it receives the expressionWhen the catch block is executed, it receives the expression 
of the throw statement as a parameter.
Within a try block, if a statement executes, you can safely 
trust that all preceding statements have executed 
successfully. 
If code in a try block (or a method invoked in the try block)If code in a try block (or a method invoked in the try block) 
throws an error, the remaining statements in the try block are 
skipped and the statements in the catch block are executed.
If no exception is thrown, the try block completes and 
execution resumes with the statements immediately following 
the try/catch/finally statement.the try/catch/finally statement.
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Handling Multiple Types of Exceptions
Each try block can have any number of supporting catch 
blocks. 
Wh ti i th i t bl k th t h lti lWhen an exception is thrown in a try block that has multiple 
catch blocks, the interpreter executes the catch block whose 
parameter's datatype matches the datatype of the value 
originally thrown. 
The datatypes of the catch parameter and thrown value are 
considered a match if they are identical or if the catchconsidered a match if they are identical or if the catch
parameter type is a superclass of the thrown value's type.
The syntax of a try statement with multiple catch blocks:y y p
try {  // Code that might generate an exception. } 
catch (e:ErrorType1) {  // Error-handling code for ErrorType1.} 

t h ( E T 2) { // E h dli d f E T 2 }catch (e:ErrorType2) {  // Error-handling code for ErrorType2.} 
catch (e:ErrorTypen) {  // Error-handling code for ErrorTypen.}
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Handling Multiple Types of Exceptions (Contd..)
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Exception Bubbling
The exceptions in a try block can be thrown either directly or 
as the result of a method call. 
An exception can be thrown anywhere in an ActionScript 
program, even on a frame in a timeline.
if no catch block exists? These mysteries are resolvedif no catch block exists? These mysteries are resolved 
through the magic of exception bubbling. 
When a throw statement executes, the interpreter immediately , p y
stops normal program flow and looks for an enclosing try block. 

throw new Error("Something went wrong");
If the throw statement is enclosed in a try block, the interpreter 
next tries to find a catch block whose parameter's datatype 
matches the datatype of the value thrown atc es t e datatype o t e a ue t o

try {  throw new Error("Something went wrong"); }
46
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Exception Bubbling (Contd…)
If t hi t h bl k i f d th i t t t fIf a matching catch block is found, the interpreter transfers 
program control to that block:

try { throw new Error("Something went wrong");try {  throw new Error( Something went wrong );
} catch (e:Error) { //Handle problems… }

But if a matching catch block cannot be found or if the throw
statement did not appear within a try block in the first place, 
then the interpreter checks whether the throw statement 
occurred within a method or functionoccurred within a method or function.

public function doSomething ( ):Void {
throw new Error("Something went wrong");   }( g g ) }

class ErrorDemo {  public function doSomething ( ):Void {
trace("About to throw an exception from doSomething( ) ");
throw new Error("Something went wrong");  }
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Exception Bubbling (Contd…)
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Uncaught Exceptions
If the interpreter never finds a catch block that can handle the 
thrown exception
Sends the value of the thrown Error object's message 
property to the Output panel
Aborts execution of all code currently remaining in the callAborts execution of all code currently remaining in the call 
stack

class ErrorDemo {
public function doSomething ( ):Void {
throw new Error("Something went wrong");  }

public static function startApp ( ):Void {
doSomething( );  }}

ErrorDemo startApp( );ErrorDemo.startApp( );
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The finally Block
A try block contains code that might throw an exception, and a 
catch block executes code in response to a thrown exception. 
Th fi ll bl k b i l t h thThe finally block, by comparison, always executes, whether or 
not code in the try block throws an exception.
The finally block is placed once (and only once) as the lastThe finally block is placed once (and only once) as the last 
block in a try/catch/finally statement. 

try { 
// Statements
} catch (e:ErrorType1) {   // Handle ErrorType1 exceptions.
} t h ( E T ) { // H dl E T ti} catch (e:ErrorTypen) {   // Handle ErrorTypen exceptions.
} finally {// code always executes, how the try block exits.
}}

Misplacing the finally block causes a compile-time error.
50
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The finally block executes in one of the 4 circumstances
Immediately after the try block completes without errors
Immediately after a catch block handles an exception 

t d i th t bl kgenerated in the try block
Immediately before an uncaught exception bubbles up
Immediately before a return continue or break statementImmediately before a return, continue, or break statement 
transfers control out of the try or catch blocks 
The finally block of a try/catch/finally statement typically 
contains cleanup code that must execute whether or not 
an exception occurs in the corresponding try block. 
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Limitations of Exception Handling inLimitations of Exception Handling in 
ActionScript 2.0

No Checked ExceptionsNo Checked Exceptions
In ActionScript 2.0, if a method throws an exception, it's 
up to the programmer to know about it in advance and 
handle it appropriately. 
The compiler will make no complaints if an exception is 
not handlednot handled.

No Built-in Exceptions
Flash doesn't throw an exception when a developer p p
attempts an illegal operation, such as dividing by zero. 
Neither the class library built into the Flash Player nor the 
Flash MX 2004 v2 components throw exceptionsFlash MX 2004 v2 components throw exceptions. 
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Exception Performance Issues
The only exceptions generated in Flash are those thrown by 
custom-written programs. 
Fi t Fl h t l ll i f ti t thFirst, Flash must relay all error information to the programmer 
using unwieldy error codes or return values. 
Second Flash often fails silently when a runtime error occurs.Second  Flash often fails silently when a runtime error occurs. 

Exception Performance Issues
If a method or function encounters an error, it returns a 
message or code describing the problem and expects the caller 
to know how to interpret that code
Both exception handling and error codes are useful and can beBoth exception handling and error codes are useful and can be 
used together in different parts of the same program, 
depending upon the performance needs of different parts of 

dyour code.
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Exception handling benchmark testp g
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Exception handling benchmark test
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Unit IV 

Inheritance
Authoring an ActionScript 2.0 Subclass

InterfacesInterfaces
Packages

ExceptionsExceptions
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I N H E R I T A N C E
A Primer on Inheritance
Subclasses as Subtypes
An OOP Chat Example
Overriding Methods and 

PropertiesProperties
Constructor Functions in Subclasses
Subclassing Built-in Classes
Augmenting Built-in Classes & Objects
The Theory of Inheritance
Abstract and Final Classes Not SupportedAbstract and Final Classes Not  Supported
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A Primer on Inheritance
In OOP, inheritance is a formal relationship between two 
or more classes, wherein one class borrows (or inherits) 
the property and method definitions of another classthe property and method definitions of another class
class A { public var p:Number = 10;

public function x ( ):Void {public function x ( ):Void {
trace("Method x( ) was called.");  }}

We can create an instance of class A, invoke method x( ),
and access property p like this:

var aInstance:A = new A( );
I t ( ) // Di l M th d ( ) ll daInstance.x( );       // Displays: Method x( ) called.

trace(aInstance.p);  // Displays: 10
Now let's add a second class B that inherits method x( )Now let s add a second class, B, that inherits method x( )
and property p from class A. 
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A Primer on Inheritance (Contd…)
To set up the inheritance relationship between A and B, we 
use the extends keyword to indicate that class B inherits 
class A's method and property definitions:class A s method and property definitions:

class B extends A {                      }
Because class B extends (inherits from) class A, instances ofBecause class B extends (inherits from) class A, instances of 
B can automatically use the method x( ) and the property p 

var bInstance:B = new B( );
bInstance.x( );          // Displays: Method x( ) was called.
trace(bInstance.p);  // Displays: 10

l B ld d fi it th d d/ ti iclass B would define its own methods and/or properties in 
addition to inheriting A's methods and properties.
class B extends A {{
public function y ( ):Void {trace("Method y( ) was called.");  } }
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A Primer on Inheritance (Contd…)
N i t f B ll th th d d ti fNow instances of B can use all the methods and properties of 
both B and its superclass, A:

var bInstance:B = new B( );var bInstance:B  new B( );
// Invoke inherited method, defined by class A.
bInstance.x( );       // Displays: Method x( ) was called.
// Invoke method defined by class B.
bInstance.y( );       // Displays: Method y( ) was called.
// Access inherited property.
trace(bInstance.p);  // Displays: 10

Inheritance relationship bet een t o classes the e tendedInheritance relationship between two classes, the extended 
class (in our case, class A) is called the base class, and the 
class that does the extending (in our case, class B) is called 
the derived class. 
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A Primer on Inheritance (Contd )A Primer on Inheritance (Contd…)
However, the terms "base class" and "derived class" have 
several synonyms including superclass and subclass parentseveral synonyms, including superclass and subclass, parent 
and child, and type and subtype.
The following code shows third class,C, that extends class B 
and also defines a new method, z( ).
Class C can use all the methods and properties defined by 
itself its superclass (B) or its superclass's superclass (A)itself, its superclass (B), or its superclass s superclass (A)
Every class in ActionScript (both built-in and custom) 
inherits directly or indirectly from the root of the built-in 
hierarchy: Object. 
The Object class defines some very basic methods that all 
classes can useclasses can use. 
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A Primer on Inheritance (Contd…)
class C extends B {

public function z ( ):Void {
trace("Method z( ) was called.");  } }

var cInstance:C = new C( );
cInstance x( ); // Displays: Method x( ) was calledcInstance.x( );  // Displays: Method x( ) was called.
cInstance.y( );  // Displays: Method y( ) was called.
cInstance z( ); // Displays: Method z( ) was calledcInstance.z( );  // Displays: Method z( ) was called.
trace(cInstance.p);  // Displays: 10

class D inherits directly from class A. Class D uses the methods y
and properties defined by itself and by its superclass, A.

class D extends A {
bli f ti ( ) V id {public function w ( ):Void {

trace("Method w( ) was called.");  }} 7
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Subclasses as Subtypesyp
A subclass is considered a subtype of its superclass. An 
instance of the subtype can be used anywhere its 
superclass's type is expected var aInstance:A;superclass s type is expected. var aInstance:A;
we can legally assign that variable an instance of any 
subclass of class A: aInstance = new B( );  
The preceding assignment works because the compiler 
knows that any instance of class B has (through inheritance) 
all the methods and properties defined by class Aall the methods and properties defined by class A. 
However, the reverse is not true. We cannot assign an 
instance of A to a variable whose datatype is B:yp

var bInstance:B = new A( );  //  Type Mismatch Error.
That assignment does not work because the compiler 

t t th t i t f l A ill h thcannot guarantee that an instance of class A will have the 
methods and properties defined by class B. 
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An OOP Chat Example
Consider a chat application that defines a class, ChatRoom, 
which handles communication among a group of users. 
Ch tR l d fi th d f di l i & diChatRoom class defines methods for displaying  & sending 
chat messages and for managing a list of users in the room
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AvatarChatRoom class's methods & properties

10

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Example An inheritance example using 
ChatRoom and AvatarChatRoom

class ChatRoom {
private var userList:mx controls List;private var userList:mx.controls.List;
public function displayMessage(userID:String, msg:String):Void {

trace("Displaying chat message in chat text field.");
}
public function sendMessage(msg:String):Void {

trace("Sending chat message.");
}
public function onAddUser(userID:String):Void {public function onAddUser(userID:String):Void {

trace("Adding user to userList.");
}
public function onRemoveUser(userID:String):Void {

trace("Removing user from userList.");
}
public function onUserChangeName(userID:String, newName:String):Void {

trace("Changing name in userList.");

11

trace( Changing name in userList. );
}
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Example An inheritance example using 
ChatRoom and AvatarChatRoom

12
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Constructor Function in Subclasses
A constructor function initializes the instances of a class by:

Calling methods that perform setup tasks
Setting properties on the object being created

When a class is extended, the subclass can define a 
constructor function of its own A subclass constructor isconstructor function of its own. A subclass constructor is 
expected to:

Perform setup tasks related to the subclassp
Set properties defined by the subclass
Invoke the superclass constructor (superconstructor)

In all inheritance relationships, setup and property 
initialization relating to the superclass occur in the superclass
constructor not in the subclass constructorconstructor, not in the subclass constructor.

13
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Constructor Function in Subclasses (Contd..)( )
A subclass constructor function, if specified, is formally 
required to invoke its superclass constructor, via the keyword 

th fi t t t t i th f tisuper, as the first statement in the function.
class A {  public function A ( ) {  } }
class B extends A { public function B ( ) {class B extends A {   public function B ( ) {

// Invoke superclass's constructor function explicitly
super( );  }}p ( ); }}

public function B ( ) {
// Invoke superclass's constructor function explicitly.
super( );}

bli f i B ( ) {public function B ( ) {
// No constructor call. The compiler provides one implicitly. }14
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The Theory of Inheritance

Inheritance lets us separate a core feature set from 
customized versions of that feature set. Code for the core is 
stored in a superclass while code for the customizations is kept 
neatly in a subclass. 
More than one s bclass can e tend the s perclass allo ingMore than one subclass can extend the superclass, allowing 
multiple customized versions of a particular feature set to exist 
simultaneously. 
Inheritance also lets us express the architecture of an 
application in hierarchical terms that mirror the real world and 
the human psychethe human psyche. 
In addition to code reuse and logical hierarchy, inheritance 
allows instances of different subtypes to be used where a single 
type is expected. Known as polymorphism

15

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Polymorphism and Dynamic Binding
The word polymorphism itself means literally "many 
forms"—each single object can be treated as an instance of 
its own class or as an instance of any of its superclassesits own class or as an instance of any of its superclasses.
Polymorphism's partner is dynamic binding, which 
guarantees that a method invoked on an object will trigger 
the behavior defined by that object's actual class.
Dynamic binding, which occurs at runtime, with static type 
checking which occurs at compile timechecking, which occurs at compile time
Dynamic binding is the runtime process by which each 
invocation of draw( ) is associated with the appropriate ( ) pp p
implementation of that method.  
Dynamic binding is often called late binding: the method call 
is bound to a particular implementation "late" (i e atis bound to a particular implementation late  (i.e., at 
runtime).

16
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Polymorphism and Dynamic Binding(Contd..)
class Shape {   public function draw ( ):Void {

// No implementation.   } }p } }
class Circle extends Shape {
public function draw ( ):Void {
}}

l R t l t d Sh {class Rectangle extends Shape {
public function draw ( ):Void {
}}}}

class Triangle extends Shape {
public function draw ( ):Void {pub c u ct o d a ( ) o d {
}}

17
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Abstract and Final Classes Not Supportedpp

An abstract class is any class that defines one or more 
abstract methods—methods that have a signature and a g
return type but no implementation
A class that wishes to extend an abstract class must 
implement all of the s perclass's abstract methodsimplement all of the superclass's abstract methods; 
otherwise, a compile-time error occurs. 
ActionScript 2.0 does not yet support abstract classes or p y pp
abstract methods. Instead we simply define a method with no 
code in its body
A fi l th d i th d th t t t b i l t d bA final method is a method that must not be implemented by 
a subclass. Final methods are used to prevent programmers 
from creating subclasses that accidentally introduce problems 
into the behavior of a superclass

18
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Extending ImageViewer's Capabilities
Authoring an ActionScript 2.0 Subclass
Extending ImageViewer s Capabilities

The list of possible functional requirements for our 
ImageViewer class:

Load an image , Display an image
Crop an image to a particular rectangular "view region"
Display a border around the imageDisplay a border around the image
Display image load progress
Reposition the view region Resize the view regionReposition the view region, Resize the view region
Pan (reposition) the image within the view region
Zoom (resize) the image within the view region( ) g g

The ImageViewer class already implements the first five 
requirements, but it stops there.
I h I Vi D l l 'll dd h iIn the ImageViewerDeluxe class, we'll add the next two items 
on the list: the abilities to reposition and resize the viewer.

19
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The ImageViewerDeluxe Skeleton
The bare bones of any subclass requires:

A class declaration that defines the inheritance 
relationship
A constructor that invokes the superclass constructor with 
the expected argumentsthe expected arguments

class ImageViewerDeluxe extends ImageViewer {g g {
public function ImageViewerDeluxe (target:MovieClip, 

depth:Number,  x:Number, y:Number, w:Number, h:Number,  
b d Thi k N b b d C l N b ) {borderThickness:Number, borderColor:Number)  { 
super(target, depth, x, y, w, h, borderThickness, 
borderColor);  );

} }
20
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To create the ImageViewerDeluxe.as class file using 
Flash MX Professional 2004, follow these steps:

1. Choose File → New.
I th N D t di l b th G l t b f2. In the New Document dialog box, on the General tab, for 
Type, choose ActionScript File.

3. Click OK. The script editor launches with an empty file.3. Click OK. The script editor launches with an empty file.
4. Copy the code  into the script editor: in the next slide.
5. Choose File → Save As.
6. In the Save As dialog box, specify ImageViewerDeluxe.as

as the filename (which is case sensitive), and save the file in 
the imageviewer folder that you createdthe imageviewer folder that you created.

7. Instances of the ImageViewerDeluxe class have all the 
ImageViewer class's methods and can be used anywhere 
ImageViewer instances are used.

21
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Adding setPosition( ) and setSize( ) Methodsg ( ) ( )
• setPosition( )

– Changes the location of the viewer by assigning the (x, y) coordinates 
of the ie er's main container mo ie clipof the viewer's main container movie clip

• setSize( )
– Changes the size of the viewer by re-creating the mask and border g y g

over the image movie clip (i.e., by recropping the image)

public function setPosition (x:Number, y:Number):Void { 
container mc x = x; container mc y = y; }container_mc._x = x; container_mc._y = y;              }
The setSize( ) method, which resizes the image viewer by 
recropping the image:pp g g

public function setSize (w:Number, h:Number):Void { 
createImageClipMask(w, h); createBorder(w, h); 

t i i tM k( t i k )container_mc.image_mc.setMask(container_mc.mask_mc); 
}

22
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The ImageViewerDeluxe class, final version
class ImageViewerDeluxe extends ImageViewer {
public function ImageViewerDeluxe (target:MovieClip, 

d th N b N b N b N b h N bdepth:Number,  x:Number, y:Number, w:Number, h:Number,  
borderThickness:Number, borderColor:Number)  { 
super(target, depth, x, y, w, h, borderThickness,super(target, depth, x, y, w, h, borderThickness, 
borderColor);  } }

public function setPosition (x:Number, y:Number):Void { 
t icontainer_mc._x = x; 

container_mc._y = y; } 
public function setSize (w:Number h:Number):Void {public function setSize (w:Number, h:Number):Void     { 

createImageClipMask(w, h); createBorder(w, h); 
container_mc.image_mc.setMask(container_mc.mask_mc); 

}} 

Unit IV Chap 7: Authoring AS Subclass 23Dept. of MCA, SVECW
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ImageViewerDeluxe class, final version (Contd..)
bli f ti tI Width ( ) N b {public function getImageWidth ( ):Number { 

return container_mc.image_mc._width;  } 
public function getImageHeight ( ):Number {public function getImageHeight ( ):Number { 

return container_mc.image_mc._height;  } 
public function setShowFullImage(show:Boolean):Void { pub c u ct o setS o u age(s o oo ea ) o d {

showFullImage = show;  } 
public function getShowFullImage( ):Boolean { 

return showFullImage;   } 
public function scaleViewerToImage ( ):Void {  

setSi e(getImageWidth( ) getImageHeight( )) }setSize(getImageWidth( ), getImageHeight( )); } 
public function onLoadInit (target:MovieClip):Void { 

super onLoadInit(target);super.onLoadInit(target); 
if (showFullImage) {   scaleViewerToImage( ); } } }

Unit IV Chap 7: Authoring AS Subclass 24Dept. of MCA, SVECW
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I N T E R F A C E S
The Case for Interfaces

An interface is an ActionScript 2.0 language construct used 
to define a new datatype, much as a class defines a 
datatype. 
A class both defines a datatype and provides theA class both defines a datatype and provides the 
implementation for it, an interface defines a datatype in 
abstract terms only; an interface provides no 
i l i f h dimplementation for the datatype. 
An interface, instead of providing its own implementation, is 
adopted by one or more classes that agree to provide theadopted by one or more classes that agree to provide the 
implementation. 
A class that provides an implementation for an interface 
belongs both to its own datatype and to the datatype defined 
by the interface. 

25
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The Case for Interfaces (Contd..)
class OrderListener {
public function onOrderError ( ):Void {
// Generic implementation of onOrderError( ) not sho n }}// Generic implementation of onOrderError( ), not shown…  }}

class StatsTracker extends OrderListener {
// Override OrderListener.onOrderError( ).
public function onOrderError ( ) {
// Send problem report to database. Code not shown…  }}

class OrderProcessor {class OrderProcessor {
public function addListener (ol:OrderListener):Boolean {
// Code here should register ol to receive OrderProcessor
eventsevents,
// and return a Boolean value indicating whether registration  }}

class OrderUI extends MovieClip {
bli f i O d E ( ) {public function onOrderError ( ) {

// Display problem report on screen, not shown…  }}
26
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Interfaces and Multidatatype Classesyp

An interface is simply a list of methods. 
i t f O d Li t {interface OrderListener {
function onOrderError( );

}}
Classes use the implements keyword to enter into an agreement 
with an interface, promising to define the methods it contains.

class OrderUI extends MovieClip implements OrderListener {
public function onOrderError ( ) {
// Display problem report on screen, not shown...

}}}}

27
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Interface Syntax and Use
To create an interface in ActionScript 2.0, we use the interface
keyword, using the following syntax:

interface  SomeName  {
function method1  (param1 :datatype ,...paramn :datatype ):returnType ;
function method2  (param1 :datatype ,...paramn :datatype ):returnType ;  

...
function methodn  (param1 :datatype ,...paramn :datatype ):returnType ;u ct o et od (pa a datatype , pa a datatype ) etu ype ;

}
In interfaces, method declarations do not (and must not) 
i l d l binclude curly braces.
All methods declared in an interface must be public; hence, by 
convention, the attribute public (which is the default) is omittedconvention, the attribute public (which is the default) is omitted 
from method definitions in an interface.

28
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Interface Syntax and Use (Contd..)y ( )
Class files

Contain the method and property definitions for each 
class. They start with the class keyword. 

Intrinsic files
Contain method signatures strictly for the purpose ofContain method signatures strictly for the purpose of 
satisfying the compiler's type checking. They start with the 
intrinsic keyword. 

Interface files
Contain a list of methods to be implemented but not the 
i l t ti th l Th t t ith th i t fimplementations themselves. They start with the interface 
keyword.

A class that wishes to adopt an interface's datatype must p yp
agree to implement that interface's methods. 

29
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Interface Syntax and Use (Contd..)y ( )
The class uses the implements keyword, which has the 
following syntax:

class SomeName implements SomeInterface { }
The implementing class's method definitions must match the 
interface's method definitions exactly including number ofinterface's method definitions exactly, including number of 
parameters, parameter types, and return type. 
If differs between the interface and the implementing class, p g ,
the compiler generates an error.
A class can legally implement more than one interface by 

ti i t f ith f llseparating interface names with commas, as follows:
class SomeName implements SomeInterface, 

SomeOtherInterface {SomeOtherInterface {
}

30
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L li ti t d f diff t
P A C K A G E S

Larger applications, creates dozens of different 
classes and  packages grouping them logically 
together. g
To group classes and interfaces together, we 
use packages. 
namespace collision or naming conflictnamespace collision or naming conflict.
A package is a unique place to put a group of 
classes, much as a directory on your hard drive , y y
is a unique place to put a group of files.
Packages allow multiple classes of the same name 
to coexist without namespace collisionsto coexist without namespace collisions, 
because each package constitutes a namespace
within which the class name is unique. 
A i t f th t t iA namespace is a set of names that contains no 
duplicates.

31
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Package Syntaxg y
The Domain Name System (DNS) defines a namespace in 
which registrants can reserve a domain name, such as 
moock.orgg
Every package has a name that describes the classes it 
contains. 
By convention, package names do not use initial caps butBy convention, package names do not use initial caps but 
might use mixed case, such as greatUtils. 
To refer to a specific class within a package, we use the dot 
operator: p

packagename.ClassName 
game.Player Packages can be nested to form a hierarchy; 
that is, a package can contain another package.that is, a package can contain another package. 

game.vehicles.SpaceShip 
By nesting packages, we can organize our classes into 
discrete subcategories within a larger category which againdiscrete subcategories within a larger category, which again 
prevents naming conflicts. 
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Import statementp
An unqualified reference includes just the class name. 

var ship:SpaceShip = new SpaceShip( ); 

If a class is in a package, we must use a fully qualified 
reference when creating instances of the class and g
specifying the datatypes of variables, parameters, and 
return types. 

var ship:game.vehicles.SpaceShip = new 
hi l S Shi ( ) // F ll lifi dgame.vehicles.SpaceShip( );// Fully qualified  

The import statement lets us use an unqualified class 
f li f f ll lifi d l freference as an alias for a fully qualified class reference. 

The basic syntax of import is:
import packagename.ClassName; 
import game.vehicles.SpaceShip; 

33
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Importing an Entire PackageImporting an Entire Package
To import all the classes in a package, use the wildcard 
character, *:

import packagename.*; 
This wildcard syntax lets us refer to any class in 
packagename by its unqualified name rather than its fully p g y q y
qualified name.

import geometry.Circle;
import geometry.Triangle;p g y g ;
import geometry.Rectangle;

import geometry *;import geometry. ; 

If we use package wildcards to import two classes with the 
same name but from different packages we again encountersame name but from different packages, we again encounter 
a namespace collision. 
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Package Naming Conventions
import game.vehicles.*;
import ordering.*;

Shi Shi ( ) // hi l Shivar s:Ship = new Ship( );  // new game.vehicles.Ship 
var s:ordering.Ship = new ordering.Ship( ); 

To avoid confusion, we should use fully qualified names for 
all references to Ship.
Just as two class names can conflict, two package names can , p g
conflict. 
To avoid package or class naming conflicts you should use the 
convention of placing all your classes and packages in a p g y p g
package named after your organization's domain name. 
com.acme com precedes acme (the package name is the 
reverse of the domain name).

35
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Defining Packages
Defining a package for a class requires two general steps:

Create a directory structure whose name identically 
matches the package hierarchymatches the package hierarchy.
Specify the package name when defining the class.

There is no such thing as a package file. A package is a 
concept based on placing a given class's as file in theconcept based on placing a given class s .as file in the 
appropriate folder.
To place the class Player in package com.yourdomain.game
Create a new directory named comCreate a new directory named com.
Create a new directory inside com named yourdomain.
Create a new directory inside yourdomain named game.
Create a text file, Player.as, in the directory 

/com/yourdomain/game/.
In Player.as,  class com.yourdomain.game.Player 

{ // Class body not shown... } 
Dept. of MCA, SVECW 36Unit IV Chap 9: Packages
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Package Access and the Classpath
In order for a .fla file to access a class in a package, the root 
directory of the package must reside within the classpath. 
The classpath is simply the list of directories (paths) onThe classpath is simply the list of directories (paths) on 
your hard drive in which the compiler looks for classes. 
Entries in the classpath can be added globally for all 
documents (the global classpath )documents (the global classpath )
The global classpath includes the following directories:

The current directory, usually represented by a period 
( )—i e the directory in which the fla resides(.) i.e., the directory in which the .fla resides
The Classes directory, $(LocalData)/Classes—

Select Edit -> Preferences -> ActionScript -> Language -
>ActionScript 2 0 Settings>ActionScript 2.0 Settings.
Under Classpath, click the plus sign (+) to add a new 
classpath entry. A blank entry appears.
In the classpath entry type C:\data\actionscript\ (Or useIn the classpath entry, type C:\data\actionscript\. (Or use 
the crosshair button to browse to that directory.)
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E X C E P T I O N S
The Exception-Handling Cycle

we can write code that 
t t d di dgenerates standardized errors 

via the throw statement. 
We handle those errors via theWe handle those errors via the 
try/catch/finally statement.
To generate an exception (i.e., 
i l ) i dsignal an error) in our code, 

throw expression
The Error class introduced asThe Error class, introduced as 
a built-in class in Flash Player 
is a standard class for 
representing error conditions.
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The Exception-Handling Cycle (Contd..)The Exception Handling Cycle (Contd..)
The Error class defines two 
public properties name andpublic properties, name and 
message , used to describe the 
error. 
When the throw statement 
executes, program control is 
immediately transferred to a y
special section of code that 
knows how to deal with the 
problemproblem. 
The code that deals with the 
problem is said to handle the 
exception.
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The Exception-Handling Cycle (Contd..)p g y ( )

The catch block handles exceptions generated by the tryThe catch block handles exceptions generated by the try 
block. 
The code in the catch block executes if, and only if, code in 
the try block generates an exception
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The Exception-Handling Cycle (Contd..)p g y ( )

The try keyword tells the 
interpreter that we're aboutinterpreter that we re about 
to execute some code that 
might generate an 
exception.
The catch block handles 
exceptions generated by theexceptions generated by the 
try block. 
The code in the catch block 
executes if, and only if, code 
in the try block generates an 
exception.exception. 
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The Exception-Handling Cycle (Contd..)
Code in a try clause 
invokes a function that 
might throw an 
exception.
Code in the in okedCode in the invoked 
function throws an 
exception using the 
throw statement if an 
error occurs.
The catch block dealsThe catch block deals 
with any errors that 
occur in the try block.

42

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



The Exception-Handling Cycle (Contd..)p g y ( )
Control returns either to the try block or the catch block
When the catch block is executed it receives the expressionWhen the catch block is executed, it receives the expression 
of the throw statement as a parameter.
Within a try block, if a statement executes, you can safely 
trust that all preceding statements have executed 
successfully. 
If code in a try block (or a method invoked in the try block)If code in a try block (or a method invoked in the try block) 
throws an error, the remaining statements in the try block are 
skipped and the statements in the catch block are executed.
If no exception is thrown, the try block completes and 
execution resumes with the statements immediately following 
the try/catch/finally statement.the try/catch/finally statement.
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Handling Multiple Types of Exceptions
Each try block can have any number of supporting catch 
blocks. 
Wh ti i th i t bl k th t h lti lWhen an exception is thrown in a try block that has multiple 
catch blocks, the interpreter executes the catch block whose 
parameter's datatype matches the datatype of the value 
originally thrown. 
The datatypes of the catch parameter and thrown value are 
considered a match if they are identical or if the catchconsidered a match if they are identical or if the catch
parameter type is a superclass of the thrown value's type.
The syntax of a try statement with multiple catch blocks:y y p
try {  // Code that might generate an exception. } 
catch (e:ErrorType1) {  // Error-handling code for ErrorType1.} 

t h ( E T 2) { // E h dli d f E T 2 }catch (e:ErrorType2) {  // Error-handling code for ErrorType2.} 
catch (e:ErrorTypen) {  // Error-handling code for ErrorTypen.}
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Handling Multiple Types of Exceptions (Contd..)

45
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Exception Bubbling
The exceptions in a try block can be thrown either directly or 
as the result of a method call. 
An exception can be thrown anywhere in an ActionScript 
program, even on a frame in a timeline.
if no catch block exists? These mysteries are resolvedif no catch block exists? These mysteries are resolved 
through the magic of exception bubbling. 
When a throw statement executes, the interpreter immediately , p y
stops normal program flow and looks for an enclosing try block. 

throw new Error("Something went wrong");
If the throw statement is enclosed in a try block, the interpreter 
next tries to find a catch block whose parameter's datatype 
matches the datatype of the value thrown atc es t e datatype o t e a ue t o

try {  throw new Error("Something went wrong"); }
46
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Exception Bubbling (Contd…)
If t hi t h bl k i f d th i t t t fIf a matching catch block is found, the interpreter transfers 
program control to that block:

try { throw new Error("Something went wrong");try {  throw new Error( Something went wrong );
} catch (e:Error) { //Handle problems… }

But if a matching catch block cannot be found or if the throw
statement did not appear within a try block in the first place, 
then the interpreter checks whether the throw statement 
occurred within a method or functionoccurred within a method or function.

public function doSomething ( ):Void {
throw new Error("Something went wrong");   }( g g ) }

class ErrorDemo {  public function doSomething ( ):Void {
trace("About to throw an exception from doSomething( ) ");
throw new Error("Something went wrong");  }
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Exception Bubbling (Contd…)
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Uncaught Exceptions
If the interpreter never finds a catch block that can handle the 
thrown exception
Sends the value of the thrown Error object's message 
property to the Output panel
Aborts execution of all code currently remaining in the callAborts execution of all code currently remaining in the call 
stack

class ErrorDemo {
public function doSomething ( ):Void {
throw new Error("Something went wrong");  }

public static function startApp ( ):Void {
doSomething( );  }}

ErrorDemo startApp( );ErrorDemo.startApp( );
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The finally Block
A try block contains code that might throw an exception, and a 
catch block executes code in response to a thrown exception. 
Th fi ll bl k b i l t h thThe finally block, by comparison, always executes, whether or 
not code in the try block throws an exception.
The finally block is placed once (and only once) as the lastThe finally block is placed once (and only once) as the last 
block in a try/catch/finally statement. 

try { 
// Statements
} catch (e:ErrorType1) {   // Handle ErrorType1 exceptions.
} t h ( E T ) { // H dl E T ti} catch (e:ErrorTypen) {   // Handle ErrorTypen exceptions.
} finally {// code always executes, how the try block exits.
}}

Misplacing the finally block causes a compile-time error.
50
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The finally block executes in one of the 4 circumstances
Immediately after the try block completes without errors
Immediately after a catch block handles an exception 

t d i th t bl kgenerated in the try block
Immediately before an uncaught exception bubbles up
Immediately before a return continue or break statementImmediately before a return, continue, or break statement 
transfers control out of the try or catch blocks 
The finally block of a try/catch/finally statement typically 
contains cleanup code that must execute whether or not 
an exception occurs in the corresponding try block. 
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Limitations of Exception Handling inLimitations of Exception Handling in 
ActionScript 2.0

No Checked ExceptionsNo Checked Exceptions
In ActionScript 2.0, if a method throws an exception, it's 
up to the programmer to know about it in advance and 
handle it appropriately. 
The compiler will make no complaints if an exception is 
not handlednot handled.

No Built-in Exceptions
Flash doesn't throw an exception when a developer p p
attempts an illegal operation, such as dividing by zero. 
Neither the class library built into the Flash Player nor the 
Flash MX 2004 v2 components throw exceptionsFlash MX 2004 v2 components throw exceptions. 
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Exception Performance Issues
The only exceptions generated in Flash are those thrown by 
custom-written programs. 
Fi t Fl h t l ll i f ti t thFirst, Flash must relay all error information to the programmer 
using unwieldy error codes or return values. 
Second Flash often fails silently when a runtime error occurs.Second  Flash often fails silently when a runtime error occurs. 

Exception Performance Issues
If a method or function encounters an error, it returns a 
message or code describing the problem and expects the caller 
to know how to interpret that code
Both exception handling and error codes are useful and can beBoth exception handling and error codes are useful and can be 
used together in different parts of the same program, 
depending upon the performance needs of different parts of 

dyour code.
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Exception handling benchmark testp g
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Exception handling benchmark test
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Unit V 
A OOP A li ti F kAn OOP Application Framework

Using Components with ActionScript 2.0
M i Cli S b lMovieClip Subclasses

1
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The Basic Directory Structure
Create a directory named AppName on your hard drive. 
The AppName directory will contain everything in our project, 
i l di d d fi l t tincluding source code and final output
In the AppName directory, create a subdirectory named 
deploy. The deploy directory will contain the final, compileddeploy. The deploy directory will contain the final, compiled 
application, ready for posting to a web site or other 
distribution medium.
I th A N di t t bdi t dIn the AppName directory, create a subdirectory named 
source. The source directory will contain all source code for 
the application, including classes (.as files) and Flash pp g ( )
documents (.fla files).

AppName/
d l /deploy/
source/ 2
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The Flash Document (.fla file)( )
Every Flash application must include at least one Flash 
document (.fla file). 
The Flash document is the source file from which a Flash 
movie (.swf file) is exported.
The Flash movie is what's actually displayed in the FlashThe Flash movie is what's actually displayed in the Flash 
Player (i.e., the Flash runtime environment). 
In the Flash authoring tool, choose File ->New.g ,
In the New Document dialog box, on the General tab, for 
Type, choose Flash Document, then click OK.
Use File ->Save As to save the Flash document as 
AppName.fla in the AppName/source directory.
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The Classes
In Flash, most applications are visual and include graphical 
user interfaces. Hence, the classes of an OOP Flash 

li ti t i ll t d i t fapplication typically create and manage user interface 
components. 
An OOP application can have any number of classes, butAn OOP application can have any number of classes, but 
only one of them is used to start the application in motion.
We'll store our classes in the package com.somedomain.
To create the directories for the com.somedomain package, 
follow these steps:

In the AppName/source directory create a subdirectoryIn the AppName/source directory, create a subdirectory 
named com.
In the AppName/source/com directory, create a 
subdirectory named somedomain.

4
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The Classes (Contd..)
To create class A, follow these steps if you're using Flash 
MX Professional 2004:
In Flash MX Professional 2004, choose File ->New.
In the New Document dialog box, on the General tab, for 
Type choose ActionScript FileType, choose ActionScript File.
Click OK. The script editor launches with an empty file.
Enter the following code into the script editor:g p

import com.somedomain.B;
class com.somedomain.A {
private static var bInstance:B;
public function A ( ) {
// I hi l l A' i d// In this example, class A's constructor is not used.

} 5
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The Classes (Contd..)
public static function main ( ):Void {

trace("Starting application.");
bInstance = new B( );   } }

Choose File -> Save As.
In the Save As dialog box specify A as B as as theIn the Save As dialog box, specify A.as, B.as as the 
filename, and save the file in the directory:

class com.somedomain.B { {
public function B ( ) { 
trace("An instance of class B was constructed."); } }

AppName/source/com/somedomain.
As long as the directory in which they reside is added to the 
global or document classpath the classes will be accessibleglobal or document classpath, the classes will be accessible 
to timeline code and other ActionScript classes.

6
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The Document Timeline
The fundamental metaphor of a Flash document is the timeline, 
which can be used to create animations like a filmstrip. 
When used for animation, the frames in the timeline are 
displayed in rapid linear succession by the Flash Player. 
The timeline can also be used to create a series of applicationThe timeline can also be used to create a series of application 
states, in which specific frames correspond to specific states 
and frames are displayed according to the application's logic
To load our A and B classes, we'll follow these steps:

Specify the export frame for classes in the movie.
Add th l b l d t t f l di d i tAdd the labeled state frames loading and main to 
AppName.fla's timeline.
Add code that displays a loading message while the movie p y g g
loads.

7
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To specify the export frame for classes in the movie, 
follow these steps:
Open AppName.fla in the Flash authoring tool.
Choose File >Publish SettingsChoose File ->Publish Settings.
In the Publish Settings dialog box, on the Flash tab, next to the 
ActionScript Version, click Settings.p g
In the ActionScript Settings dialog box, for the Export Frame 
for Classes option, enter 10. 
Cli k OK t fi th A ti S i t ttiClick OK to confirm the ActionScript settings.
Click OK to confirm the publish settings.

To add the labeled state frames loading and main toTo add the labeled state frames loading and main to 
AppName.fla's timeline, follow these steps:
In AppName.fla's main timeline, double-click Layer 1 and 
rename it to scripts. We'll place all our code on the scripts
layer. 8
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The Document Timeline (Contd..)( )
In the main timeline of AppName.fla, select frame 15 of the 
scripts layer.
Choose Insert ->Timeline ->Keyframe (F6).
Choose Insert ->Timeline ->Layer.
Double-click the new layer's name and change it to labels.
At frames 4 and 15 of the labels layer, add a new keyframe 
(Insert Timeline Keyframe or F6) Just as the scripts layer(Insert Timeline Keyframe or F6). Just as the scripts layer 
holds all our scripts, the labels layer is used exclusively to hold 
frame labels. 
With frame 4 of the labels layer selected, in the Properties 
panel, under Frame, change <Frame Label> to loading.
With frame 15 of the labels layer selected in the PropertiesWith frame 15 of the labels layer selected, in the Properties 
panel, under Frame, change <Frame Label> to main.

9
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steps to add code that displays a loading 
message while the movie loads:
At frame 5 of the scripts layer, add a new keyframe
(Insert >Timeline >Keyframe or F6)(Insert ->Timeline ->Keyframe or F6).
With frame 5 of the scripts layer selected, enter the following 
code into the Actions panel (F9):p ( )

if (_framesloaded == _totalframes) {
gotoAndStop("main");

} else {   gotoAndPlay("loading");  }
With frame 1 of the scripts layer selected, enter the following 
code into the Actions panel:code into the Actions panel:

this.createTextField("loadmsg_txt", 0, 200, 200, 0, 0);
loadmsg txt.autoSize = true;loadmsg_txt.autoSize  true;
loadmsg_txt.text = "Loading...Please wait.";

10

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



The Document Timeline (Contd..)( )
With frame 15 of the scripts layer selected, enter the 
following code into the Actions panel:

loadmsg_txt.removeTextField( );
We've now provided the basic timeline structure that loads 
our application's classesour application's classes. 
All that's left is to start the application by invoking A.main( ). 
We do that on the frame labeled main in AppName flaWe do that on the frame labeled main in AppName.fla. 
Add the following code to the end of the script on frame 15 
(i.e., just below loadmsg_txt.removeTextField( );):

import com.somedomain.A;
A.main( );

f fTo test, we need to export a .swf file and run it in the Flash 
Player

11
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The Exported Flash Movie (.swf file)
Our application is now ready for testing and—assuming all 
goes well—deployment. 
T if th di t i hi h t t A N fTo specify the directory in which to create AppName.swf, 
follow these steps:

With AppName.fla open, choose File ->Publish Settings->With AppName.fla open, choose File Publish Settings  
Formats.
Under the File heading, for Flash (.swf), enter 
/d l /A N f../deploy/AppName.swf.

Click OK.
To test our application in the Flash authoring tool's Test MovieTo test our application in the Flash authoring tool s Test Movie 
mode, select Control Test Movie. 
Testing a movie actually creates AppName.swf in the 
AppName/deploy directory and immediately loads it into a 
debugging version of the Flash Player. 12
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publish an HTML page that includes the movie, 
f fready for posting to a web site as follows:

With AppName.fla open, choose File Publish Settings 
Formats.

Under the File heading, for HTML (.html), enter 
/deploy/AppName html../deploy/AppName.html.

Click Publish. Click OK.
Test locally by opening AppName.html in your web browser.es oca y by ope g pp a e t you eb b o se
When the local testing proves successful, upload the .html 
and .swf files to your web server.
Packages and classpaths matter only at compile time. 
We you can upload the .html and .swf wherever you like on 
your server but in our example the two files must reside inyour server, but in our example, the two files must reside in 
the same web server folder.

13
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Projects in Flash MX Professional 2004j
To help manage the files in a large application, Flash MX 
Professional 2004 supports the concept of projects. pp p p j
A project is a group of related files that can be managed via 
the Project panel in the Flash MX Professional 2004 
a thoring toolauthoring tool. 
The Project panel resembles a file explorer and offers the 
following features:g

Authoring tool integration with source control applications 
such as Microsoft Visual SourceSafe
Easy access to related source files
One-click application publishing, even while editing class 
filesfiles
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Using Components with ActionScript 2.0

15
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Currency Converter Application Overview

Our example GUI application is a simple currency converter. 
The components used in our currency converter interface 
(B tt C b B L b l T tA d T tI t)(Button, ComboBox, Label, TextArea, and TextInput). 
The user must specify an amount in Canadian dollars, select 
a currency type from the drop-down list, and click thea currency type from the drop down list, and click the 
Convert button to determine the equivalent amount in the 
selected currency. The result is displayed on screen.
O li ti ' i Fl h d t i dOur application's main Flash document is named 
CurrencyConverter.fla. 
It resides in CurrencyConverter/source.It resides in CurrencyConverter/source. 
Our application's only class is CurrencyConverter. 
It is stored in an external .as class file named 
CurrencyConverter.as

16
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The currency converter applicationThe currency converter application
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Preparing the Flash Document
Adding Components to the Document

With CurrencyConverter.fla open in the Flash authoring 
tool select Window Development Panels > Componentstool, select Window Development Panels > Components.
In the Components panel, in the folder named UI 
Components, click and drag the Button component to the 
Stage. The Button component appears in the Library.
Select and delete the Button instance from the Stage.

S l t I t Ti li LSelect Insert ->Timeline ->Layer.
Double-click the new layer and rename it load components.
Select frame 12 in the load components layerSelect frame 12 in the load components layer.
Select Insert ->Timeline ->Keyframe.
Select frame 13 in the load components layer.p y
Select Insert ->Timeline ->Keyframe. 
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CurrencyConverter.fla's timeline and Stage
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Starting the Application 
The CurrencyConverter Class

The main( ) call comes on frame 15 of the scripts
layer in CurrencyConverter.fla's timeline, after our 
classes and components have been preloaded. 
import org.moock.tools.CurrencyConverter; 
CurrencyConverter.main(this, 0, 150, 100);
Th C C t l ' th i d tiThe CurrencyConverter class's three main duties 
are to:

Provide a method that starts the application (main( ))Provide a method that starts the application (main( ))
Create the application interface
Respond to user inputRespond to user input
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The currency converter application (Contd..)
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The currency converter application (contd..)
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The currency converter application (Contd..)
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The currency converter application (Contd..)
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The currency converter application (Contd..)
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The currency converter application (Contd..)
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The currency converter application (Contd )The currency converter application (Contd..)

Importing the Components' Package
CurrencyConverter Properties
The main( ) method
The Class Constructor
Creating the User Interface
The interface container
The title Label componentp
The instructions Label component
The input TextInput componentp p p
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The currency converter application (Contd..)

The currencyPicker ComboBox component
The convertButton Button componentp
The result TextArea component
Converting Currency Based on User Input
Exporting the Final Application

With CurrencyConverter.fla open, choose File Publish 
Settings FormatsSettings Formats.
Under the File heading, for Flash (.swf), enter 
../deploy/CurrencyConverter.swf.p y y
Click OK.
To test our application in the Flash authoring tool's Test 

CMovie mode, select Control Test Movie.
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Handling Component Events
We handled component events in two different ways:
With a generic listener object (in the case of the TextInputWith a generic listener object (in the case of the TextInput
component):
var enterHandler:Object = new Object( );
enterHandler.enter = function (e:Object):Void {
thisConverter.convert( );}

i t ddE tLi t (" t " t H dl )input.addEventListener("enter", enterHandler);
With an event handler function (in the case of the Button 
component):component):
convertButton.clickHandler = function (e:Object):Void {
thisConverter.convert( );}
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Component-event-handling techniques
Technique Example Notes

Generic 
listener

var convertClickHandler:Object = new Object( );
convertClickHandler click = function

Generally, the 
preferred means oflistener 

object
convertClickHandler.click = function 
(e:Object):Void {   thisConverter.convert( );}
convertButton.addEventListener("click", 
convertClickHandler);

preferred means of 
handling 
component events

Typed 
listener 

bj t
convertButton.addEventListener("click", new 
C tB tt H dl (thi ))

Same as generic 
but exposes event-
h dli dobject ConvertButtonHandler(this)); handling code more 
explicitly

Event Functionally theEvent
Proxy 
class

convertButton.addEventListener("click", new 
EventProxy(this, "convert"));
or

Functionally the 
same as generic 
listener object, but 
more convenient 

convertButton.addEventListener("click", new 
EventProxy(this, convert));

and easier to read

30
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Component-event-handling techniquesp g q
Technique Example Notes

Listener 
function

convertButton.addEventListener("click", function 
(e:Object):Void { thisConverter.convert( ); });

The lesser evil of 
the two function-

l t h dlionly event-handling 
mechanisms

Event 
handler

convertButton.clickHandler = function 
(e:Object):Void { thisConverter convert( ); }

The least-desirable 
means of handlinghandler 

function
(e:Object):Void { thisConverter.convert( ); } means of handling 

component events; 
discouraged by 
Macromedia

31

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



MovieClip Subclasses
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The Duality of MovieClip Subclasses
A movie clip is a self-contained multimedia object with a 
timeline for changing state. Movie clips can contain graphics, 
video and audio They are perfect for creating the audio/visualvideo, and audio. They are perfect for creating the audio/visual 
elements of an application
Every MovieClip subclass has two parts: a movie clip symbol 
and a corresponding ActionScript 2.0 class. A MovieClip
subclass uses the extends keyword to inherit from MovieClip:

class SomeClass extends MovieClip { }class SomeClass extends MovieClip {             }
A MovieClip subclass must also be represented physically in a 
Flash document Library by a movie clip symbol. y y p y
The movie clip symbol in the Library specifies the class that 
represents it, thus coupling the symbol and MovieClip 
subclass togethersubclass together. 
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Avatar: A MovieClip Subclass Example
To create instances of a MovieClip subclass, we do not use 
the new operator as we would with a typical class.
I t f th i li b l ' b l t dInstances of the movie clip subclass's symbol are created 
either manually in the authoring tool or programmatically via 
attachMovie( ) or duplicateMovieClip( ). 
Our example MovieClip subclass, named Avatar, is an on-
screen representation of a user in a chat room or a game.
Th A t l ld it i t l b i l t dThe Avatar class could quite appropriately be implemented 
using composition.

The AvatarSymbol Movie ClipThe AvatarSymbol Movie Clip
Every MovieClip subclass has a corresponding movie clip 
symbol
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The AvatarSymbol Movie Clip
O A t l ' i li b l i ll d A t S b lOur Avatar class's movie clip symbol is called AvatarSymbol. 
It contains a graphical depiction of the user in three different 
states: Idle, Sad, and Happy.states: Idle, Sad, and Happy. 
The three states correspond to three labeled frames in 
AvatarSymbol's timeline. 
To change the state of the avatar, we position AvatarSymbol's 
at the appropriate frame in its timeline. 
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Creation of AvatarSymbol Movie Clip 
1. Create a new Flash document named AvatarDemo.fla.
2. Select Insert ->New Symbol.y
3. For the symbol Name, enter AvatarSymbol. The name is 

arbitrary, but by convention, you should name the symbol 
ClassSymbol where Class is the name of the class with whichClassSymbol where Class is the name of the class with which 
you expect to associate the symbol.

4. For the symbol's Behavior type, select Movie Clip.y yp , p
5. Click OK. Flash automatically enters Edit mode for the 

AvatarSymbol symbol.
Steps to build AvatarSymbol's timeline and contents:
1. Double-click Layer 1 and rename it to graphics.
2 Select frame 30 of the graphics layer2. Select frame 30 of the graphics layer.
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Steps to build AvatarSymbol's timeline and contents:
3. Choose Insert ->Timeline ->Frame (F5).
4. Using Insert ->Timeline ->Layer, create two new layers, and name them 

labels and scripts.p
5. With frame 1 of the scripts layer selected, enter the following code into the 

Actions panel (F9):                  stop( );
6 Using Insert Timeline Blank Keyframe (F7) create blank keyframes on the6. Using Insert Timeline Blank Keyframe (F7), create blank keyframes on the 

labels and graphics layers at keyframes 10 and 20.
7. With frame 1 of the labels layer selected, in the Properties panel, under 

Frame change <Frame Label> to IDLEFrame, change <Frame Label> to IDLE.
8. With frame 10 of the labels layer selected, in the Properties panel, under 

Frame, change <Frame Label> to SAD.
9 With frame 20 of the labels layer selected in the Properties panel under9. With frame 20 of the labels layer selected, in the Properties panel, under 

Frame, change <Frame Label> to HAPPY.
10. On the graphics layer, use Flash's drawing tools to draw an idle face on 

frame 1 a sad face on frame 10 and a happy face on frame 20frame 1, a sad face on frame 10, and a happy face on frame 20.
Notice that we add a stop( ) statement on frame 1 but not on frames 10 &20.

37

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



The Avatar Class
To subclass the MovieClip class, we merely use the extends 
keyword, as we would for any other class. The basic code is:

l A t t d M i Cli { }class Avatar extends MovieClip { }
The Avatar class defines two instance methods:
init( ) : Initializes each Avatar instanceinit( ) : Initializes each Avatar instance
setState( ) : Sets the avatar's state using one of three 
constants (class properties)—IDLE, SAD, and HAPPY.
The class has no constructor function. Instances of MovieClip
subclasses are not created using the standard constructor 
call syntax (using the new operator)call syntax (using the new operator).
init( ) method fulfills the traditional role of the constructor and 
should be called on each Avatar instance directly after it's 
created. 
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Avatar, a MovieClip subclass
class Avatar extends MovieClip {
public static var HAPPY:Number = 0;
public static var SAD:Number = 1;public static var SAD:Number = 1;
public static var IDLE:Number = 2;
public function init ( ):Void {

tSt t (A t HAPPY) }setState(Avatar.HAPPY);   }
public function setState(newState:Number):Void {
switch (newState) {
case Avatar.HAPPY:
this.gotoAndStop("HAPPY");         break;

case Avatar SAD:case Avatar.SAD:
this.gotoAndStop("SAD");             break;

case Avatar.IDLE:
thi t A dSt ("IDLE") b kthis.gotoAndStop("IDLE");             break;

}  }}
39
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Linking AvatarSymbol to the Avatar Class
To associate the AvatarSymbol movie clip with the Avatar
class, we must set the AvatarSymbol's so-called "AS 2.0 
Class" in the Flash authoring tool as follows:Class  in the Flash authoring tool, as follows:

Select the AvatarSymbol movie clip in AvatarDemo.fla's 
Library.
Select the pop-up Options menu in the top-right corner of 
the Library panel, and choose the Linkage option.
I th Li k P ti di l b f Li k l tIn the Linkage Properties dialog box, for Linkage, select 
Export for ActionScript.
In the Linkage Properties dialog box, for Identifier, enterIn the Linkage Properties dialog box, for Identifier, enter 
AvatarSymbol.
In the Linkage Properties dialog box, for AS 2.0 Class, 

t A tenter Avatar.
Click OK. 40

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Creating Avatar Instances
var av:Avatar = Avatar(someMovieClip.attachMovie("AvatarSymbol", 

"avatar", 0));
The instance of the library symbol (AvatarSymbol) is physically y y ( y ) p y y
added to the Stage and also reflected back to ActionScript in 
the form of the object returned by attachMovie( )

I iti li i A t I tInitializing Avatar Instances
To initialize our new Avatar instance, we invoke init( ) on it, as 
follows:o o s
av.init( );
public static function createAvatar (name:String, 

target:MovieClip, depth:Number):Avatar { 
var av:Avatar = Avatar(target.attachMovie("AvatarSymbol", 
name depth))name, depth)); 
av.init( );     return av; }
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Avatar class, showing the new createAvatar( ) method and updated 
init( ) method in context with the rest of the class:( )

42
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Avatar class, showing the new createAvatar( ) method 
and updated init( ) method in context with the rest of 
the class: (Contd..)
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Avatar: The Composition Version
The composition version of the Avatar class is cleaner and 
more flexible than its MovieClip subclass 
Wh A t i t d t b l t th M i CliWhen Avatar instances need to belong to the MovieClip
datatype (e.g., for the sake of polymorphism)
When the Avatar class and the AvatarSymbol movie clipWhen the Avatar class and the AvatarSymbol movie clip 
symbol need to be packaged together as a component
When Avatar instances need most of the methods of the 
M i Cli l ("I A" l ti hi i l iti t )MovieClip class ("Is-A" relationship is legitimate) 

class Avatar {
public static var HAPPY:Number = 0;public static var HAPPY:Number = 0;
public static var SAD:Number = 1;
public static var IDLE:Number = 2;p ;
private var av_mc:MovieClip;
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public function Avatar (name:String, target:MovieClip, depth:Number, pub c u ct o ata ( a e St g, ta get o eC p, dept u be ,
x:Number, y:Number) {
av_mc = target.attachMovie("AvatarSymbol", name, depth);
setState(Avatar HAPPY); setPosition(x y); }setState(Avatar.HAPPY);     setPosition(x, y);  }

public function setState(newState:Number):Void {
it h ( St t ) {switch (newState) {

case Avatar.HAPPY:
av_mc.gotoAndStop("HAPPY");        break;

case Avatar.SAD:
av_mc.gotoAndStop("SAD");            break;

case Avatar IDLE:case Avatar.IDLE:
av_mc.gotoAndStop("IDLE");           break;    }  }

bli f ti tP iti ( N b N b ) V id {public function setPosition (x:Number, y:Number):Void {
av_mc._x = x;     av_mc._y = y;  }}
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Issues with Nested Assets:: Properties and 
M th d f N t d A t I iti ll U d fi dMethods of Nested Assets Initially Undefined
When initializing a movie clip hierarchy in a movie, the Flash 
Player starts with the outermost clip in the hierarchy definesPlayer starts with the outermost clip in the hierarchy, defines 
its custom properties and methods, then moves on to its child 
clips, defines their custom properties and methods, and so on. 
A movie clip symbol, ChatRoomSymbol, that represents a 
chat room. It contains the following component instances:
outgoing :outgoing : 

A TextInput component for outgoing messages
incoming :incoming : 

A TextArea component for incoming messages
userList : 

A List component for the list of users in the room
46
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ChatRoomSymbol instance via composition 
in a class, ChatRoom

class ChatRoom {
private static var chatroomID:Number = 0;
private var chat_mc:MovieClip;
public function ChatRoom (target:MovieClip, depth:Number) {
// Create clip instance.
chat mc = target attachMovie("ChatRoomSymbol"chat_mc = target.attachMovie("ChatRoomSymbol", 
"chatroom" + ChatRoom.chatroomID++,depth);
chat mc.userList.dataProvider = _

[{label:"Colin", data:"User1"},
{label:"Derek", data:"User2"},
{label:"James", data:"User3"}];  }}
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Nested Assets Not Automatically Recognized by 
CompilerCompiler
Assets nested in a movie clip symbol are not automatically 
available to a corresponding MovieClip subclass as instanceavailable to a corresponding MovieClip subclass as instance 
properties. 
A MovieClip subclass cannot refer to assets nested inside its p
associated movie clip symbol unless the subclass explicitly 
declares those assets as instance properties.
class Login extends MovieClip {class Login extends MovieClip { 
public var userName:TextField; // Declare userName 
public var password:TextField; // Declare passwordpublic var password:TextField; // Declare password 
public function Login ( ) { 
userName.text = "Enter your name."; 
password.text = "Enter your password."; } }
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A Note on MovieClip Sub-subclasses
Nothing officially prevents a MovieClip subclass from being 
subclassed. 
If t d t t A t h d h dIf we wanted to create an Avatar whose mood changed 
randomly, we could create a RandomAvatar class that 
inherits from Avatar. 
However, the RandomAvatar class would need to be 
associated with its own library movie clip symbol. 
Th R d A t l ld i h it th b h i f thThe RandomAvatar class would inherit the behavior of the 
Avatar class, it would not inherit Avatar's physical movie clip 
symbol. y
To create the RandomAvatar class, we'd have to create a 
completely separate symbol, RandomAvatarSymbol, that is a 
duplicate of AvatarSymbolduplicate of AvatarSymbol.
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A Note on MovieClip Sub-subclasses (Contd..)
class RandomAvatar extends Avatar {
private var randomInt:Number;

bli f ti R d A t ( St i t t M i Clipublic function RandomAvatar (name:String, target:MovieClip, 
depth:Number, x:Number, y:Number) {
super(name, target, depth, x, y);super(name, target, depth, x, y);
startRandom( );  }

public function startRandom ( ):Void {
randomInt = setInterval (function (av:RandomAvatar):Void {
var r:Number = Math.floor(Math.random( ) * 3);
av.setState(r);     } , 500, this); }

public function stopRandom ( ):Void {public function stopRandom ( ):Void {
clearInterval(randomInt);  }}
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Content in AvatarDemo.fla file

var av:Avatar =  new Avatar("avatar", this, 0, 
300, 200);
var rav:RandomAvatar = new 
RandomAvatar("randomavatar", this, 1, 100, 
100)100);
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Unit V 
A OOP A li ti F kAn OOP Application Framework

Using Components with ActionScript 2.0
M i Cli S b lMovieClip Subclasses

1
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The Basic Directory Structure
Create a directory named AppName on your hard drive. 
The AppName directory will contain everything in our project, 
i l di d d fi l t tincluding source code and final output
In the AppName directory, create a subdirectory named 
deploy. The deploy directory will contain the final, compileddeploy. The deploy directory will contain the final, compiled 
application, ready for posting to a web site or other 
distribution medium.
I th A N di t t bdi t dIn the AppName directory, create a subdirectory named 
source. The source directory will contain all source code for 
the application, including classes (.as files) and Flash pp g ( )
documents (.fla files).

AppName/
d l /deploy/
source/ 2
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The Flash Document (.fla file)( )
Every Flash application must include at least one Flash 
document (.fla file). 
The Flash document is the source file from which a Flash 
movie (.swf file) is exported.
The Flash movie is what's actually displayed in the FlashThe Flash movie is what's actually displayed in the Flash 
Player (i.e., the Flash runtime environment). 
In the Flash authoring tool, choose File ->New.g ,
In the New Document dialog box, on the General tab, for 
Type, choose Flash Document, then click OK.
Use File ->Save As to save the Flash document as 
AppName.fla in the AppName/source directory.

3
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The Classes
In Flash, most applications are visual and include graphical 
user interfaces. Hence, the classes of an OOP Flash 

li ti t i ll t d i t fapplication typically create and manage user interface 
components. 
An OOP application can have any number of classes, butAn OOP application can have any number of classes, but 
only one of them is used to start the application in motion.
We'll store our classes in the package com.somedomain.
To create the directories for the com.somedomain package, 
follow these steps:

In the AppName/source directory create a subdirectoryIn the AppName/source directory, create a subdirectory 
named com.
In the AppName/source/com directory, create a 
subdirectory named somedomain.

4
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The Classes (Contd..)
To create class A, follow these steps if you're using Flash 
MX Professional 2004:
In Flash MX Professional 2004, choose File ->New.
In the New Document dialog box, on the General tab, for 
Type choose ActionScript FileType, choose ActionScript File.
Click OK. The script editor launches with an empty file.
Enter the following code into the script editor:g p

import com.somedomain.B;
class com.somedomain.A {
private static var bInstance:B;
public function A ( ) {
// I hi l l A' i d// In this example, class A's constructor is not used.

} 5
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The Classes (Contd..)
public static function main ( ):Void {

trace("Starting application.");
bInstance = new B( );   } }

Choose File -> Save As.
In the Save As dialog box specify A as B as as theIn the Save As dialog box, specify A.as, B.as as the 
filename, and save the file in the directory:

class com.somedomain.B { {
public function B ( ) { 
trace("An instance of class B was constructed."); } }

AppName/source/com/somedomain.
As long as the directory in which they reside is added to the 
global or document classpath the classes will be accessibleglobal or document classpath, the classes will be accessible 
to timeline code and other ActionScript classes.

6
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The Document Timeline
The fundamental metaphor of a Flash document is the timeline, 
which can be used to create animations like a filmstrip. 
When used for animation, the frames in the timeline are 
displayed in rapid linear succession by the Flash Player. 
The timeline can also be used to create a series of applicationThe timeline can also be used to create a series of application 
states, in which specific frames correspond to specific states 
and frames are displayed according to the application's logic
To load our A and B classes, we'll follow these steps:

Specify the export frame for classes in the movie.
Add th l b l d t t f l di d i tAdd the labeled state frames loading and main to 
AppName.fla's timeline.
Add code that displays a loading message while the movie p y g g
loads.
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To specify the export frame for classes in the movie, 
follow these steps:
Open AppName.fla in the Flash authoring tool.
Choose File >Publish SettingsChoose File ->Publish Settings.
In the Publish Settings dialog box, on the Flash tab, next to the 
ActionScript Version, click Settings.p g
In the ActionScript Settings dialog box, for the Export Frame 
for Classes option, enter 10. 
Cli k OK t fi th A ti S i t ttiClick OK to confirm the ActionScript settings.
Click OK to confirm the publish settings.

To add the labeled state frames loading and main toTo add the labeled state frames loading and main to 
AppName.fla's timeline, follow these steps:
In AppName.fla's main timeline, double-click Layer 1 and 
rename it to scripts. We'll place all our code on the scripts
layer. 8
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The Document Timeline (Contd..)( )
In the main timeline of AppName.fla, select frame 15 of the 
scripts layer.
Choose Insert ->Timeline ->Keyframe (F6).
Choose Insert ->Timeline ->Layer.
Double-click the new layer's name and change it to labels.
At frames 4 and 15 of the labels layer, add a new keyframe 
(Insert Timeline Keyframe or F6) Just as the scripts layer(Insert Timeline Keyframe or F6). Just as the scripts layer 
holds all our scripts, the labels layer is used exclusively to hold 
frame labels. 
With frame 4 of the labels layer selected, in the Properties 
panel, under Frame, change <Frame Label> to loading.
With frame 15 of the labels layer selected in the PropertiesWith frame 15 of the labels layer selected, in the Properties 
panel, under Frame, change <Frame Label> to main.

9
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steps to add code that displays a loading 
message while the movie loads:
At frame 5 of the scripts layer, add a new keyframe
(Insert >Timeline >Keyframe or F6)(Insert ->Timeline ->Keyframe or F6).
With frame 5 of the scripts layer selected, enter the following 
code into the Actions panel (F9):p ( )

if (_framesloaded == _totalframes) {
gotoAndStop("main");

} else {   gotoAndPlay("loading");  }
With frame 1 of the scripts layer selected, enter the following 
code into the Actions panel:code into the Actions panel:

this.createTextField("loadmsg_txt", 0, 200, 200, 0, 0);
loadmsg txt.autoSize = true;loadmsg_txt.autoSize  true;
loadmsg_txt.text = "Loading...Please wait.";

10
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The Document Timeline (Contd..)( )
With frame 15 of the scripts layer selected, enter the 
following code into the Actions panel:

loadmsg_txt.removeTextField( );
We've now provided the basic timeline structure that loads 
our application's classesour application's classes. 
All that's left is to start the application by invoking A.main( ). 
We do that on the frame labeled main in AppName flaWe do that on the frame labeled main in AppName.fla. 
Add the following code to the end of the script on frame 15 
(i.e., just below loadmsg_txt.removeTextField( );):

import com.somedomain.A;
A.main( );

f fTo test, we need to export a .swf file and run it in the Flash 
Player

11
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The Exported Flash Movie (.swf file)
Our application is now ready for testing and—assuming all 
goes well—deployment. 
T if th di t i hi h t t A N fTo specify the directory in which to create AppName.swf, 
follow these steps:

With AppName.fla open, choose File ->Publish Settings->With AppName.fla open, choose File Publish Settings  
Formats.
Under the File heading, for Flash (.swf), enter 
/d l /A N f../deploy/AppName.swf.

Click OK.
To test our application in the Flash authoring tool's Test MovieTo test our application in the Flash authoring tool s Test Movie 
mode, select Control Test Movie. 
Testing a movie actually creates AppName.swf in the 
AppName/deploy directory and immediately loads it into a 
debugging version of the Flash Player. 12
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publish an HTML page that includes the movie, 
f fready for posting to a web site as follows:

With AppName.fla open, choose File Publish Settings 
Formats.

Under the File heading, for HTML (.html), enter 
/deploy/AppName html../deploy/AppName.html.

Click Publish. Click OK.
Test locally by opening AppName.html in your web browser.es oca y by ope g pp a e t you eb b o se
When the local testing proves successful, upload the .html 
and .swf files to your web server.
Packages and classpaths matter only at compile time. 
We you can upload the .html and .swf wherever you like on 
your server but in our example the two files must reside inyour server, but in our example, the two files must reside in 
the same web server folder.

13
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Projects in Flash MX Professional 2004j
To help manage the files in a large application, Flash MX 
Professional 2004 supports the concept of projects. pp p p j
A project is a group of related files that can be managed via 
the Project panel in the Flash MX Professional 2004 
a thoring toolauthoring tool. 
The Project panel resembles a file explorer and offers the 
following features:g

Authoring tool integration with source control applications 
such as Microsoft Visual SourceSafe
Easy access to related source files
One-click application publishing, even while editing class 
filesfiles

14
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Using Components with ActionScript 2.0

15
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Currency Converter Application Overview

Our example GUI application is a simple currency converter. 
The components used in our currency converter interface 
(B tt C b B L b l T tA d T tI t)(Button, ComboBox, Label, TextArea, and TextInput). 
The user must specify an amount in Canadian dollars, select 
a currency type from the drop-down list, and click thea currency type from the drop down list, and click the 
Convert button to determine the equivalent amount in the 
selected currency. The result is displayed on screen.
O li ti ' i Fl h d t i dOur application's main Flash document is named 
CurrencyConverter.fla. 
It resides in CurrencyConverter/source.It resides in CurrencyConverter/source. 
Our application's only class is CurrencyConverter. 
It is stored in an external .as class file named 
CurrencyConverter.as

16
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The currency converter applicationThe currency converter application
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Preparing the Flash Document
Adding Components to the Document

With CurrencyConverter.fla open in the Flash authoring 
tool select Window Development Panels > Componentstool, select Window Development Panels > Components.
In the Components panel, in the folder named UI 
Components, click and drag the Button component to the 
Stage. The Button component appears in the Library.
Select and delete the Button instance from the Stage.

S l t I t Ti li LSelect Insert ->Timeline ->Layer.
Double-click the new layer and rename it load components.
Select frame 12 in the load components layerSelect frame 12 in the load components layer.
Select Insert ->Timeline ->Keyframe.
Select frame 13 in the load components layer.p y
Select Insert ->Timeline ->Keyframe. 
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CurrencyConverter.fla's timeline and Stage
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Starting the Application 
The CurrencyConverter Class

The main( ) call comes on frame 15 of the scripts
layer in CurrencyConverter.fla's timeline, after our 
classes and components have been preloaded. 
import org.moock.tools.CurrencyConverter; 
CurrencyConverter.main(this, 0, 150, 100);
Th C C t l ' th i d tiThe CurrencyConverter class's three main duties 
are to:

Provide a method that starts the application (main( ))Provide a method that starts the application (main( ))
Create the application interface
Respond to user inputRespond to user input
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The currency converter application (Contd..)
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The currency converter application (contd..)
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The currency converter application (Contd..)
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The currency converter application (Contd..)
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The currency converter application (Contd..)
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The currency converter application (Contd..)
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The currency converter application (Contd )The currency converter application (Contd..)

Importing the Components' Package
CurrencyConverter Properties
The main( ) method
The Class Constructor
Creating the User Interface
The interface container
The title Label componentp
The instructions Label component
The input TextInput componentp p p
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The currency converter application (Contd..)

The currencyPicker ComboBox component
The convertButton Button componentp
The result TextArea component
Converting Currency Based on User Input
Exporting the Final Application

With CurrencyConverter.fla open, choose File Publish 
Settings FormatsSettings Formats.
Under the File heading, for Flash (.swf), enter 
../deploy/CurrencyConverter.swf.p y y
Click OK.
To test our application in the Flash authoring tool's Test 

CMovie mode, select Control Test Movie.
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Handling Component Events
We handled component events in two different ways:
With a generic listener object (in the case of the TextInputWith a generic listener object (in the case of the TextInput
component):
var enterHandler:Object = new Object( );
enterHandler.enter = function (e:Object):Void {
thisConverter.convert( );}

i t ddE tLi t (" t " t H dl )input.addEventListener("enter", enterHandler);
With an event handler function (in the case of the Button 
component):component):
convertButton.clickHandler = function (e:Object):Void {
thisConverter.convert( );}
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Component-event-handling techniques
Technique Example Notes

Generic 
listener

var convertClickHandler:Object = new Object( );
convertClickHandler click = function

Generally, the 
preferred means oflistener 

object
convertClickHandler.click = function 
(e:Object):Void {   thisConverter.convert( );}
convertButton.addEventListener("click", 
convertClickHandler);

preferred means of 
handling 
component events

Typed 
listener 

bj t
convertButton.addEventListener("click", new 
C tB tt H dl (thi ))

Same as generic 
but exposes event-
h dli dobject ConvertButtonHandler(this)); handling code more 
explicitly

Event Functionally theEvent
Proxy 
class

convertButton.addEventListener("click", new 
EventProxy(this, "convert"));
or

Functionally the 
same as generic 
listener object, but 
more convenient 

convertButton.addEventListener("click", new 
EventProxy(this, convert));

and easier to read
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Component-event-handling techniquesp g q
Technique Example Notes

Listener 
function

convertButton.addEventListener("click", function 
(e:Object):Void { thisConverter.convert( ); });

The lesser evil of 
the two function-

l t h dlionly event-handling 
mechanisms

Event 
handler

convertButton.clickHandler = function 
(e:Object):Void { thisConverter convert( ); }

The least-desirable 
means of handlinghandler 

function
(e:Object):Void { thisConverter.convert( ); } means of handling 

component events; 
discouraged by 
Macromedia
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MovieClip Subclasses
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The Duality of MovieClip Subclasses
A movie clip is a self-contained multimedia object with a 
timeline for changing state. Movie clips can contain graphics, 
video and audio They are perfect for creating the audio/visualvideo, and audio. They are perfect for creating the audio/visual 
elements of an application
Every MovieClip subclass has two parts: a movie clip symbol 
and a corresponding ActionScript 2.0 class. A MovieClip
subclass uses the extends keyword to inherit from MovieClip:

class SomeClass extends MovieClip { }class SomeClass extends MovieClip {             }
A MovieClip subclass must also be represented physically in a 
Flash document Library by a movie clip symbol. y y p y
The movie clip symbol in the Library specifies the class that 
represents it, thus coupling the symbol and MovieClip 
subclass togethersubclass together. 
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Avatar: A MovieClip Subclass Example
To create instances of a MovieClip subclass, we do not use 
the new operator as we would with a typical class.
I t f th i li b l ' b l t dInstances of the movie clip subclass's symbol are created 
either manually in the authoring tool or programmatically via 
attachMovie( ) or duplicateMovieClip( ). 
Our example MovieClip subclass, named Avatar, is an on-
screen representation of a user in a chat room or a game.
Th A t l ld it i t l b i l t dThe Avatar class could quite appropriately be implemented 
using composition.

The AvatarSymbol Movie ClipThe AvatarSymbol Movie Clip
Every MovieClip subclass has a corresponding movie clip 
symbol
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The AvatarSymbol Movie Clip
O A t l ' i li b l i ll d A t S b lOur Avatar class's movie clip symbol is called AvatarSymbol. 
It contains a graphical depiction of the user in three different 
states: Idle, Sad, and Happy.states: Idle, Sad, and Happy. 
The three states correspond to three labeled frames in 
AvatarSymbol's timeline. 
To change the state of the avatar, we position AvatarSymbol's 
at the appropriate frame in its timeline. 

35

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



Creation of AvatarSymbol Movie Clip 
1. Create a new Flash document named AvatarDemo.fla.
2. Select Insert ->New Symbol.y
3. For the symbol Name, enter AvatarSymbol. The name is 

arbitrary, but by convention, you should name the symbol 
ClassSymbol where Class is the name of the class with whichClassSymbol where Class is the name of the class with which 
you expect to associate the symbol.

4. For the symbol's Behavior type, select Movie Clip.y yp , p
5. Click OK. Flash automatically enters Edit mode for the 

AvatarSymbol symbol.
Steps to build AvatarSymbol's timeline and contents:
1. Double-click Layer 1 and rename it to graphics.
2 Select frame 30 of the graphics layer2. Select frame 30 of the graphics layer.
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Steps to build AvatarSymbol's timeline and contents:
3. Choose Insert ->Timeline ->Frame (F5).
4. Using Insert ->Timeline ->Layer, create two new layers, and name them 

labels and scripts.p
5. With frame 1 of the scripts layer selected, enter the following code into the 

Actions panel (F9):                  stop( );
6 Using Insert Timeline Blank Keyframe (F7) create blank keyframes on the6. Using Insert Timeline Blank Keyframe (F7), create blank keyframes on the 

labels and graphics layers at keyframes 10 and 20.
7. With frame 1 of the labels layer selected, in the Properties panel, under 

Frame change <Frame Label> to IDLEFrame, change <Frame Label> to IDLE.
8. With frame 10 of the labels layer selected, in the Properties panel, under 

Frame, change <Frame Label> to SAD.
9 With frame 20 of the labels layer selected in the Properties panel under9. With frame 20 of the labels layer selected, in the Properties panel, under 

Frame, change <Frame Label> to HAPPY.
10. On the graphics layer, use Flash's drawing tools to draw an idle face on 

frame 1 a sad face on frame 10 and a happy face on frame 20frame 1, a sad face on frame 10, and a happy face on frame 20.
Notice that we add a stop( ) statement on frame 1 but not on frames 10 &20.
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The Avatar Class
To subclass the MovieClip class, we merely use the extends 
keyword, as we would for any other class. The basic code is:

l A t t d M i Cli { }class Avatar extends MovieClip { }
The Avatar class defines two instance methods:
init( ) : Initializes each Avatar instanceinit( ) : Initializes each Avatar instance
setState( ) : Sets the avatar's state using one of three 
constants (class properties)—IDLE, SAD, and HAPPY.
The class has no constructor function. Instances of MovieClip
subclasses are not created using the standard constructor 
call syntax (using the new operator)call syntax (using the new operator).
init( ) method fulfills the traditional role of the constructor and 
should be called on each Avatar instance directly after it's 
created. 
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Avatar, a MovieClip subclass
class Avatar extends MovieClip {
public static var HAPPY:Number = 0;
public static var SAD:Number = 1;public static var SAD:Number = 1;
public static var IDLE:Number = 2;
public function init ( ):Void {

tSt t (A t HAPPY) }setState(Avatar.HAPPY);   }
public function setState(newState:Number):Void {
switch (newState) {
case Avatar.HAPPY:
this.gotoAndStop("HAPPY");         break;

case Avatar SAD:case Avatar.SAD:
this.gotoAndStop("SAD");             break;

case Avatar.IDLE:
thi t A dSt ("IDLE") b kthis.gotoAndStop("IDLE");             break;

}  }}
39
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Linking AvatarSymbol to the Avatar Class
To associate the AvatarSymbol movie clip with the Avatar
class, we must set the AvatarSymbol's so-called "AS 2.0 
Class" in the Flash authoring tool as follows:Class  in the Flash authoring tool, as follows:

Select the AvatarSymbol movie clip in AvatarDemo.fla's 
Library.
Select the pop-up Options menu in the top-right corner of 
the Library panel, and choose the Linkage option.
I th Li k P ti di l b f Li k l tIn the Linkage Properties dialog box, for Linkage, select 
Export for ActionScript.
In the Linkage Properties dialog box, for Identifier, enterIn the Linkage Properties dialog box, for Identifier, enter 
AvatarSymbol.
In the Linkage Properties dialog box, for AS 2.0 Class, 

t A tenter Avatar.
Click OK. 40
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Creating Avatar Instances
var av:Avatar = Avatar(someMovieClip.attachMovie("AvatarSymbol", 

"avatar", 0));
The instance of the library symbol (AvatarSymbol) is physically y y ( y ) p y y
added to the Stage and also reflected back to ActionScript in 
the form of the object returned by attachMovie( )

I iti li i A t I tInitializing Avatar Instances
To initialize our new Avatar instance, we invoke init( ) on it, as 
follows:o o s
av.init( );
public static function createAvatar (name:String, 

target:MovieClip, depth:Number):Avatar { 
var av:Avatar = Avatar(target.attachMovie("AvatarSymbol", 
name depth))name, depth)); 
av.init( );     return av; }
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Avatar class, showing the new createAvatar( ) method and updated 
init( ) method in context with the rest of the class:( )
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Avatar class, showing the new createAvatar( ) method 
and updated init( ) method in context with the rest of 
the class: (Contd..)
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Avatar: The Composition Version
The composition version of the Avatar class is cleaner and 
more flexible than its MovieClip subclass 
Wh A t i t d t b l t th M i CliWhen Avatar instances need to belong to the MovieClip
datatype (e.g., for the sake of polymorphism)
When the Avatar class and the AvatarSymbol movie clipWhen the Avatar class and the AvatarSymbol movie clip 
symbol need to be packaged together as a component
When Avatar instances need most of the methods of the 
M i Cli l ("I A" l ti hi i l iti t )MovieClip class ("Is-A" relationship is legitimate) 

class Avatar {
public static var HAPPY:Number = 0;public static var HAPPY:Number = 0;
public static var SAD:Number = 1;
public static var IDLE:Number = 2;p ;
private var av_mc:MovieClip;
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public function Avatar (name:String, target:MovieClip, depth:Number, pub c u ct o ata ( a e St g, ta get o eC p, dept u be ,
x:Number, y:Number) {
av_mc = target.attachMovie("AvatarSymbol", name, depth);
setState(Avatar HAPPY); setPosition(x y); }setState(Avatar.HAPPY);     setPosition(x, y);  }

public function setState(newState:Number):Void {
it h ( St t ) {switch (newState) {

case Avatar.HAPPY:
av_mc.gotoAndStop("HAPPY");        break;

case Avatar.SAD:
av_mc.gotoAndStop("SAD");            break;

case Avatar IDLE:case Avatar.IDLE:
av_mc.gotoAndStop("IDLE");           break;    }  }

bli f ti tP iti ( N b N b ) V id {public function setPosition (x:Number, y:Number):Void {
av_mc._x = x;     av_mc._y = y;  }}
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Issues with Nested Assets:: Properties and 
M th d f N t d A t I iti ll U d fi dMethods of Nested Assets Initially Undefined
When initializing a movie clip hierarchy in a movie, the Flash 
Player starts with the outermost clip in the hierarchy definesPlayer starts with the outermost clip in the hierarchy, defines 
its custom properties and methods, then moves on to its child 
clips, defines their custom properties and methods, and so on. 
A movie clip symbol, ChatRoomSymbol, that represents a 
chat room. It contains the following component instances:
outgoing :outgoing : 

A TextInput component for outgoing messages
incoming :incoming : 

A TextArea component for incoming messages
userList : 

A List component for the list of users in the room
46
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ChatRoomSymbol instance via composition 
in a class, ChatRoom

class ChatRoom {
private static var chatroomID:Number = 0;
private var chat_mc:MovieClip;
public function ChatRoom (target:MovieClip, depth:Number) {
// Create clip instance.
chat mc = target attachMovie("ChatRoomSymbol"chat_mc = target.attachMovie("ChatRoomSymbol", 
"chatroom" + ChatRoom.chatroomID++,depth);
chat mc.userList.dataProvider = _

[{label:"Colin", data:"User1"},
{label:"Derek", data:"User2"},
{label:"James", data:"User3"}];  }}
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Nested Assets Not Automatically Recognized by 
CompilerCompiler
Assets nested in a movie clip symbol are not automatically 
available to a corresponding MovieClip subclass as instanceavailable to a corresponding MovieClip subclass as instance 
properties. 
A MovieClip subclass cannot refer to assets nested inside its p
associated movie clip symbol unless the subclass explicitly 
declares those assets as instance properties.
class Login extends MovieClip {class Login extends MovieClip { 
public var userName:TextField; // Declare userName 
public var password:TextField; // Declare passwordpublic var password:TextField; // Declare password 
public function Login ( ) { 
userName.text = "Enter your name."; 
password.text = "Enter your password."; } }
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A Note on MovieClip Sub-subclasses
Nothing officially prevents a MovieClip subclass from being 
subclassed. 
If t d t t A t h d h dIf we wanted to create an Avatar whose mood changed 
randomly, we could create a RandomAvatar class that 
inherits from Avatar. 
However, the RandomAvatar class would need to be 
associated with its own library movie clip symbol. 
Th R d A t l ld i h it th b h i f thThe RandomAvatar class would inherit the behavior of the 
Avatar class, it would not inherit Avatar's physical movie clip 
symbol. y
To create the RandomAvatar class, we'd have to create a 
completely separate symbol, RandomAvatarSymbol, that is a 
duplicate of AvatarSymbolduplicate of AvatarSymbol.

49

w
w

w
.jntuw

orld.com

w
w

w
.jntuw

orld.com

w
w

w
.jw

jobs.net



A Note on MovieClip Sub-subclasses (Contd..)
class RandomAvatar extends Avatar {
private var randomInt:Number;

bli f ti R d A t ( St i t t M i Clipublic function RandomAvatar (name:String, target:MovieClip, 
depth:Number, x:Number, y:Number) {
super(name, target, depth, x, y);super(name, target, depth, x, y);
startRandom( );  }

public function startRandom ( ):Void {
randomInt = setInterval (function (av:RandomAvatar):Void {
var r:Number = Math.floor(Math.random( ) * 3);
av.setState(r);     } , 500, this); }

public function stopRandom ( ):Void {public function stopRandom ( ):Void {
clearInterval(randomInt);  }}
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Content in AvatarDemo.fla file

var av:Avatar =  new Avatar("avatar", this, 0, 
300, 200);
var rav:RandomAvatar = new 
RandomAvatar("randomavatar", this, 1, 100, 
100)100);
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Chapter 7

Lossless Compression Algorithms

7.1 Introduction
7.2 Basics of Information Theory
7.3 Run-Length Coding

1

7.3 Run-Length Coding
7.4 Variable-Length Coding (VLC)
7.5 Dictionary-based Coding
7.6 Arithmetic Coding
7.7 Lossless Image Compression



7.1 Introduction

2



• Compression: the process of coding that will  effectively 
reduce the total number of bits needed to represent certain 
information.

A General Data Compression Scheme.

3



• If the compression and decompression processes induce 
no information loss, then the compression scheme is 
lossless;

• Otherwise, it is lossy.

Compression ratio:

compression ratio = B0 / B1

4

compression ratio = B0 / B1

B0 : number of bits before compression
B1 : number of bits after compression



7.2 Basics of Information Theory
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The entropy η (eta) of an information source with alphabet 
S = {s1, s2,….sn} is:

i

n

i
i p

p
1

log
1

2




6

pi : probability that symbol si will occur in S.

• It can be interpreted as the average shortest message length, in bits, that 
can be sent to communicate the true value of the random variable to a 
recipient. 

• This represents a fundamental mathematical limit on the best possible 
lossless data compression of any communication.



Distribution of Gray-Level Intensities

7

Histograms for a Gray-level Image.

Figure shows the histogram of an image with uniform 
distribution of gray-level intensities, 

i.e., For all i,  pi = 1/256.

Hence, the entropy of this image is:    log2 256 = 8



Entropy and Code Length

The entropy η is a weighted-sum of terms log2 1/pi; 

Hence it represents the average amount of information 
contained per symbol in the source S.

The entropy η specifies the lower bound for the average 

8

The entropy η specifies the lower bound for the average 
number of bits to code each symbol in S, 

i.e., η  í

Í - the average length (measured in bits) of the code-words
produced by the encoder.



Entropy and Code Length

 Alphabet={a,Alphabet={a, b,b, c,c, d} with probability {4/8, 2/8, 1/8, 1/8}d} with probability {4/8, 2/8, 1/8, 1/8}

 η= 4/8*logη= 4/8*log222 + 2/8*log2 + 2/8*log224 + 1/8*log4 + 1/8*log228 + 1/8*log8 + 1/8*log2288

η= 1/2 + 1/2 + 3/8 + 3/8 = 1.75    average lengthη= 1/2 + 1/2 + 3/8 + 3/8 = 1.75    average length

9

 η= 1/2 + 1/2 + 3/8 + 3/8 = 1.75    average lengthη= 1/2 + 1/2 + 3/8 + 3/8 = 1.75    average length

 a => 0      b => 10      c => 110     d => 111a => 0      b => 10      c => 110     d => 111

 Message: {abcdabaa} => {0 10 110 111 0 10 0 0}Message: {abcdabaa} => {0 10 110 111 0 10 0 0}

 14 bits / 8 chars = 1.75  average length14 bits / 8 chars = 1.75  average length



7.3 Run-Length Coding
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Run-Length Coding

• Rationale for RLC: if the information source has the 
property that symbols tend to form continuous groups, then 
such symbol and the length of the group can be coded.

• Memoryless Source: Namely, the value of the current 
symbol does not depend on the values of the previously 

11

symbol does not depend on the values of the previously 
appeared symbols.

• Instead of assuming memoryless source, Run-Length 
Coding (RLC) exploits memory present in the information 
source.



• Run-length encoding (RLE) is a very simple form of 
data compression in which runs of data (that is, 
sequences in which the same data value occurs in many 
consecutive data elements) are stored as a single data 
value and count, rather than as the original run.

WWWWWWBWWWWWWWWWWWWBBBWWWWWWWWWWWWWW

12

If we apply the run-length encoding (RLE) data compression 
algorithm to the above hypothetical scan line, we get the 
following:

6WB12W3B14W 



7.4 Variable-Length Coding (VLC)
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Variable-Length Coding (VLC)

Shannon-Fano Algorithm - a top-down approach

1. Sort the symbols according to the frequency count of their
occurrences.
2. Recursively divide the symbols into two parts, each with 
approximately the same number of counts, until all parts 

14

approximately the same number of counts, until all parts 
contain only one symbol.

An Example: coding of “HELLO”

SymbolSymbol HH EE LL OO

CountCount 11 11 22 11

Frequency count of the symbols in "HELLO"



Coding Tree for HELLO by Shannon-Fano.
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Result of Performing Shannon-Fano on HELLO

SymbolSymbol CountCount LogLog22 1/p1/pii CodeCode # of bits# of bits

LL 22 1.321.32 00 22

HH 11 2.322.32 1010 22

16

HH 11 2.322.32 1010 22

EE 11 2.322.32 110110 33

OO 11 2.322.32 111111 33

Total number of bits Total number of bits 1010



Another coding tree for HELLO by Shannon-Fano.
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SymbolSymbol CountCount LogLog22 1/p1/pii CodeCode # of bits# of bits

LL 22 1.321.32 0000 44

HH 11 2.322.32 0101 22

EE 11 2.322.32 1010 22

OO 11 2.322.32 1111 22

Total number of bits Total number of bits 1010



Huffman Coding
Huffman Coding Algorithm | a bottom-up approach

1. Initialization: Put all symbols on a list sorted according to
their frequency counts.
2. Repeat until the list has only one symbol left:

(1) From the list pick two symbols with the lowest 
frequency counts. Form a Huffman sub-tree that has 
these two symbols as child nodes and create a parent 

18

these two symbols as child nodes and create a parent 
node.
(2) Assign the sum of the children's frequency counts to 
the parent and insert it into the list such that the order is 
maintained.
(3) Delete the children from the list.

3. Assign a codeword for each leaf based on the path from 
the root.



Huffman Coding 

• New symbols P1, P2, P3 are created to refer to the parent 
nodes in the Huffman coding tree. The contents in the list 
are illustrated below:

19

After initialization: L H E O
After iteration (a): L H P1
After iteration (b): L P2
After iteration (c): P3



Coding Tree for “HELLO” using the Huffman Algorithm.
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Properties of Huffman Coding

1. Unique Prefix Property: No Huffman code is a prefix of 
any other Huffman code - prevents any ambiguity in 
decoding.

2. Optimality: minimum redundancy code.
• The two least frequent symbols will have the same 

length for their Huffman codes, differing only at the last 

21

bit.
• Symbols that occur more frequently will have shorter 

Huffman codes than symbols that occur less frequently.
• The average code length for an information source S is 

strictly less than η + 1. We have:

í < η +1



Shannon-Fano vs. Huffman Coding

 Example:Example: In a message, the codes and In a message, the codes and 
their frequencies are A(15), B(7), C(6), their frequencies are A(15), B(7), C(6), 
D(6), E(5). Encode this message with D(6), E(5). Encode this message with 
ShannonShannon--fano and Huffman coding.fano and Huffman coding.
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 Try yourself!Try yourself!

 ShannonShannon--fano:  89 bitsfano:  89 bits
Huffman         :  87 bitsHuffman         :  87 bits



Adaptive Huffman Coding

• Statistics are gathered and updated dynamically as the data 
stream arrives. 

• Symbols are assigned with some initially agreed upon codes, 
without any prior knowledge of the frequency counts. 
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• Then, tree construct is updated dynamically. Update 
basically does two things: 
• increments the frequency counts for the symbols 

(including any new ones). 
• updates the configuration of the tree.

• The encoder and decoder must use exactly the same initial 
code and update tree routines.



Notes on Adaptive Huffman Tree Updating

• Nodes are numbered in order from left to right, bottom to 
top. The numbers in parentheses indicates the count.

• The tree must always maintain its sibling property, i.e., all 
nodes (internal and leaf) are arranged in the order of  
increasing counts.
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increasing counts.

• If the sibling property is about to be violated, a swap
procedure is invoked to update the tree by rearranging the 
nodes.

• When a swap is necessary, the farthest node with count N
is swapped with the node whose count has just been 
increased to N +1.



Node Swapping for Updating an Adaptive Huffman Tree
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Another Example: Adaptive Huffman Coding

• This is to clearly illustrate more implementation details. 
We show exactly what bits are sent, as opposed to 
simply stating how the tree is updated.

• An additional rule: if any character/symbol is to be sent 
the first time, it must be preceded by a special symbol, 
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NEW. The initial code for NEW is 0. The count for NEW 
is always kept as 0 (the count is never increased); hence 
it is always denoted as NEW:(0)



Initial code assignment for AADCCDD using adaptive 
Huffman coding.

Initial Code
NEW: 0
A: 00001
B: 00010
C: 00011
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C: 00011
D: 00100
. .
. .
. .



Adaptive Huffman tree for AADCCDD
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Adaptive Huffman tree for AADCCDD
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Sequence of symbols and codes sent to the decoder

• It is important to emphasize that the code for a particular 
symbol changes during the adaptive Huffman coding 
process.

• For example, after AADCCDD, when the character D over-
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• For example, after AADCCDD, when the character D over-
takes A as the most frequent symbol, its code changes 
from 101 to 0.



Example :
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7.5 Dictionary-based Coding
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7.5 Dictionary-based Coding

• LZW uses fixed-length codewords to represent 
variable-length strings of symbols/characters that 
commonly occur together, e.g., words in English text.

• The LZW encoder and decoder build up the same 
dictionary dynamically while receiving the data.
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• LZW places longer and longer repeated entries into a 
dictionary, and then emits the code for an element, 
rather than the string itself, if the element has already 
been placed in the dictionary.



LZW compression for string “ABABBABCABABBA”

• Let's start with a very simple dictionary (also referred to 
as a “string table”), initially containing only 3 characters, 
with codes as follows:

code string
------- --------
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------- --------
1 A
2 B
3 C

• Now if the input string is “ABABBABCABABBA”, the 
LZW compression algorithm works as follows:



BEGIN
s = next input character;
while not EOF

{ c = next input character;
if s + c exists in the dictionary

s = s + c;
else
{ output the code for s;

LZW Compression Algorithm
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{ output the code for s;
add string s + c to the dictionary with a new code;

s = c;
}

}
output the code for s;
END



s c output code string
1 A
2 B
3 C

---------------------------------------------------------------------------------
A B 1 4 AB
B A 2 5 BA
A B
AB B 4 6 ABB
B A

“ABABBABCABABBA”
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B A
BA B 5 7 BAB
B C 2 8 BC
C A 3 9 CA
A B
AB A 4 10 ABA
A B
AB B
ABB A 6 11 ABBA
A  EOF 1
The output codes are: 1 2 4 5 2 3 4 6 1. Instead of sending 14 characters,
only 9 codes need to be sent (compression ratio = 14/9 = 1.56).



BEGIN
s = NIL;
while not EOF

{
k = next input code;
entry = dictionary entry for k;
output entry;
if (s != NIL)

LZW Decompression (simple version)
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if (s != NIL)
add string s + entry[0] to dictionary with a new code;
s = entry;

}
END



The LZW decompression algorithm then works as follows:
S k entry/output code string
----------------------------------------------------------------------

1 A
2 B
3 C

-----------------------------------------------------------------------
NIL 1 A
A 2 B 4 AB

1 2 4 5 2 3 4 6 1

38

A 2 B 4 AB
B 4 AB 5 BA
AB 5 BA 6 ABB
BA 2 B 7 BAB
B 3 C 8 BC
C 4 AB 9 CA
AB 6 ABB 10 ABA
ABB 1 A 11 ABBA
A EOF

Apparently, the output string is “ABABBABCABABBA”, a truly
lossless result!



7.6 Arithmetic Coding
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Arithmetic Coding

• Arithmetic coding is a more modern coding method that
• usually out-performs Huffman coding.

• Huffman coding assigns each symbol a codeword which 
has an integral bit length. Arithmetic coding can treat the 
whole message as one unit.
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whole message as one unit.

• A message is represented by a half-open interval [a; b) 
where a and b are real numbers between 0 and 1. Initially, 
the interval is [0; 1). When the message becomes longer, 
the length of the interval shortens and the number of bits 
needed to represent the interval increases.



Arithmetic Coding Encoder Algorithm

BEGIN
low = 0.0; high = 1.0; range = 1.0;
while (symbol != terminator)

{
get (symbol);
low = low + range * Range_low(symbol);
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low = low + range * Range_low(symbol);
high = low + range * Range_high(symbol);
range = high - low;

}
output a code so that low <= code < high;
END



Example: Encoding in Arithmetic Coding
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Encode Symbols “CAEE$”



Graphical display of shrinking ranges
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New low, high, and range generated.
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Arithmetic coding: decode symbols “CAEE$”

The algorithm for extracting the ranges is:
Loop. For all the symbols. 

Range = high_range of the symbol - low_range of the symbol 
Number = number - low_range of the symbol 
Number = number / range 
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Arithmetic coding: decode symbols “CAEE$”



6.7 Lossless Image Compression
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Lossless Image Compression

• Approaches of Differential Coding of Images:
- Given an original image I(x, y), using a simple difference 

operator we can define a difference image d(x, y) as follows:

d(x, y) = I(x, y) − I(x − 1, y)

47

or use the discrete version of the 2-D Laplacian operator to 
define a difference image d(x; y) as

d(x, y) = 4I(x, y) − I(x, y − 1) − I(x, y +1)−I(x+1, y)−I(x−1, y)

• Due to spatial redundancy existed in normal images I, the 
difference image d will have a narrower histogram and hence 
a smaller entropy.
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Distributions for Original versus Derivative Images. 
(a,b): Original gray-level image and its partial derivative image; 
(c,d): Histograms for original and derivative images.



Lossless JPEG

• Lossless JPEG: A special case of the JPEG image 
compression.

• The Predictive method
1. Forming a differential prediction: A predictor 

combines the values of up to three neighboring pixels 
as the predicted value for the current pixel. The 
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as the predicted value for the current pixel. The 
predictor can use any one of the seven schemes.

2. Encoding: The encoder compares the prediction with 
the actual pixel value at the position `X' and encodes 
the difference using one of the lossless compression 
techniques we have discussed, e.g., the Huffman 
coding scheme.



Neighboring Pixels for Predictors in Lossless JPEG.
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Note: Any of A, B, or C has already been decoded 
before it is used in the predictor, on the decoder side of 
an encode-decode cycle.



Predictors for Lossless JPEG
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Comparison with other lossless compression programs

52



Lossless compression tools

 Entropy coding

• Huffman, Arithmetic, LZW, run-length

 Predictive coding

• reduce the dynamic range to code
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• reduce the dynamic range to code

 Transform

• enhance energy compaction
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 MPEG-4: a newer standard. Besides compression, pays
great attention to issues about user interactivities.

 MPEG-4 departs from its predecessors in adopting a 
new object-based coding:
 Offering higher compression ratio, also beneficial 

12.1 Overview of MPEG-4
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 Offering higher compression ratio, also beneficial 
for digital video composition, manipulation, 
indexing, and retrieval.

 Figure 12.1 illustrates how MPEG-4 videos can be 
composed and manipulated by simple operations on 
the visual objects.
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Fig. 12.1: Composition and Manipulation of MPEG-4 Videos.



 MPEG-4 (Fig. 12.2(b)) is an entirely new standard for:
(a) Composing media objects to create desirable 
audiovisual scenes.
(b) Multiplexing and synchronizing the bitstreams for 
these media data entities so that they can be 

Overview of MPEG-4

Chap 12  MPEG Video Coding II 5

transmitted with guaranteed Quality of Service 
(QoS).
(c) Interacting with the audiovisual scene at the 
receiving end - provides a toolbox of advanced coding 
modules and algorithms for audio and video 
compressions.
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Fig. 12.2: Comparison of interactivities in MPEG standards: (a) 
reference models in MPEG-1 and 2 (b) MPEG-4 reference model.
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Fig. 12.3: Video Object Oriented Hierarchical Description
of a Scene in MPEG-4 Visual Bitstreams.



 The H.264 video compression standard, formerly 
known as H.26L, is being developed by the Joint 
Video Team (JVT) of ISO/IEC MPEG and ITU-T 
VCEG.

 Preliminary studies using software based on this new 

12.5 MPEG-4 Part10/H.264
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 Preliminary studies using software based on this new 
standard suggests that H.264 offers up to 30-50% 
better compression than MPEG-2, and up to 30% over 
H.263+ and MPEG-4 advanced simple profile.



 The outcome of this work is actually two identical 
standards:
ISO MPEG-4 Part10 and ITU-T H.264.

 H.264 is currently one of the leading candidates to 
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 H.264 is currently one of the leading candidates to 
carry High Definition TV (HDTV) video content on 
many potential applications.



 VLC-Based Entropy Decoding:
Two entropy methods are used in the variable-length 
entropy decoder: Unified-VLC (UVLC) and Context 
Adaptive VLC (CAVLC).

 Motion Compensation (P-Prediction):

H.264 Core Features
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 Motion Compensation (P-Prediction):
• Uses a tree-structured motion segmentation down to 

4×4 block size 
(16×16, 16×8, 8×16, 8×8, 8×4, 4×8, 4×4).

• This allows much more accurate motion compensation 
of moving objects. Motion vectors can be up to half-
pixel or quarter-pixel accuracy.



 Intra-Prediction (I-Prediction):
• H.264 exploits much more spatial prediction than in 

previous video standards such as H.263+.

 Uses a simple integer-precision 4×4 DCT, and a 
quantization scheme with nonlinear step-sizes.

H.264 Core Features
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quantization scheme with nonlinear step-sizes.

 In-Loop Deblocking Filters.



 The Baseline profile of H.264 is intended for real-
time conversational applications, such as video 
conferencing.

 It contains all the core coding tools of H.264 
discussed above and the following additional error-
resilience tools, to allow for error-prone carriers such 

Baseline Profile Features
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resilience tools, to allow for error-prone carriers such 
as IP and wireless networks:

 Arbitrary slice order (ASO).
 Flexible macroblock order (FMO).
 Redundant slices.



 Represents non-low-delay applications such as 
broadcasting and stored-medium.

 The Main profile contains all Baseline profile features 
(except ASO, FMO, and redundant slices) plus the 
following:

Main Profile Features
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 B slices.
 Context Adaptive Binary Arithmetic Coding (CABAC).
 Weighted Prediction.



 Represents non-low-delay applications such as 
broadcasting and stored-medium.

 The eXtended profile (or profile X) is designed for 
the new video streaming applications. 

 This profile allows non-low-delay features, bitstream 

Extended Profile Features
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 This profile allows non-low-delay features, bitstream 
switching features, and also more error-resilience 
tools.



 The main objective of MPEG-7 is to serve the need of 
audiovisual content-based retrieval (or audiovisual 
object retrieval) in applications such as digital 
libraries.

 Nevertheless, it is also applicable to any multimedia 
applications involving the generation (content creation) 

12.6 MPEG-7

Chap 12  MPEG Video Coding II 15

applications involving the generation (content creation) 
and usage (content consumption) of multimedia data.

 MPEG-7 became an International Standard in 
September 2001 - with the formal name Multimedia 
Content Description Interface.



 MPEG-7 supports a variety of multimedia applications. 
Its data may include still pictures, graphics, 3D 
models, audio, speech, video, and composition 
information.

Applications Supported by MPEG-7
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 These MPEG-7 data elements can be represented in 
textual format, or binary format, or both.

 Fig. 12.17 illustrates some possible applications that 
will benefit from the MPEG-7 standard.


